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Legal information 
Warning notice system 

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent 
damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert 
symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are 
graded according to the degree of danger. 

DANGER  
indicates that death or severe personal injury will result if proper precautions are not taken. 

WARNING  
indicates that death or severe personal injury may result if proper precautions are not taken. 

CAUTION  
indicates that minor personal injury can result if proper precautions are not taken. 

NOTICE  
indicates that property damage can result if proper precautions are not taken. 

If more than one degree of danger is present, the warning notice representing the highest degree of danger will 
be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to 
property damage. 

Qualified Personnel 
The product/system described in this documentation may be operated only by personnel qualified for the specific 
task in accordance with the relevant documentation, in particular its warning notices and safety instructions. 
Qualified personnel are those who, based on their training and experience, are capable of identifying risks and 
avoiding potential hazards when working with these products/systems. 

Proper use of Siemens products 
Note the following: 

WARNING  
Siemens products may only be used for the applications described in the catalog and in the relevant technical 
documentation. If products and components from other manufacturers are used, these must be recommended 
or approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and 
maintenance are required to ensure that the products operate safely and without any problems. The permissible 
ambient conditions must be complied with. The information in the relevant documentation must be observed. 

Trademarks 
All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication 
may be trademarks whose use by third parties for their own purposes could violate the rights of the owner. 

Disclaimer of Liability 
We have reviewed the contents of this publication to ensure consistency with the hardware and software 
described. Since variance cannot be precluded entirely, we cannot guarantee full consistency. However, the 
information in this publication is reviewed regularly and any necessary corrections are included in subsequent 
editions. 
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Preface 

SINAMICS documentation  
The SINAMICS documentation is organized in the following categories: 

● General documentation/catalogs 

● User documentation 

● Manufacturer/service documentation 

More information 
The following link provides information on the topics: 

● Ordering documentation/overview of documentation 

● Additional links to download documents 

● Using documentation online (find and browse through manuals/information) 
http://www.siemens.com/motioncontrol/docu 

Please send any questions about the technical documentation (e.g. suggestions for 
improvement, corrections) to the following e-mail address: 
docu.motioncontrol@siemens.com 

My Documentation Manager 
Under the following link there is information on how to create your own individual 
documentation based on Siemens' content, and adapt it for your own machine 
documentation: 
http://www.siemens.com/mdm 

Training 
Under the following link there is information on SITRAIN - training from Siemens for 
products, systems and automation engineering solutions: 
http://www.siemens.com/sitrain 

FAQs 
You can find Frequently Asked Questions in the Service&Support pages under Product 
Support: 
http://support.automation.siemens.com 

SINAMICS 
You can find information on SINAMICS under: 
http://www.siemens.com/sinamics 

http://www.siemens.com/motioncontrol/docu
mailto:docu.motioncontrol@siemens.com
http://www.siemens.com/mdm
http://www.siemens.com/sitrain
http://support.automation.siemens.com
http://www.siemens.com/sinamics
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Usage phases and their documents/tools (as an example)  

Table 1 Usage phases and the available documents/tools 

Usage phase Document/tool 
Orientation SINAMICS S Sales Documentation 
Planning/configuration • SIZER engineering tool 

• Configuration Manuals, Motors 

Deciding/ordering SINAMICS S120 catalogs 
• SIMOTION, SINAMICS S120 and Motors for Production 

Machines (Catalog PM 21) 
• SINAMICS and motors for single-axis drives (catalog D 31) 
• SINUMERIK & SINAMICS  

Equipment for Machine Tools (Catalog NC 61) 
• SINUMERIK 840D sl Type 1B 

Equipment for Machine Tools (Catalog NC 62) 

Installation/assembly • SINAMICS S120 Equipment Manual for Control Units and 
Additional System Components 

• SINAMICS S120 Equipment Manual for Booksize Power Units 
• SINAMICS S120 Equipment Manual for Chassis Power Units 
• SINAMICS S120 Equipment Manual for AC Drives 
• SINAMICS S120M Equipment Manual Distributed Drive 

Technology 

Commissioning • STARTER commissioning tool 
• SINAMICS S120 Getting Started 
• SINAMICS S120 Commissioning Manual 
• SINAMICS S120 CANopen Commissioning Manual 
• SINAMICS S120 Function Manual 
• SINAMICS S120 Safety Integrated Function Manual 
• SINAMICS S120/S150 List Manual 

Usage/operation • SINAMICS S120 Commissioning Manual 
• SINAMICS S120/S150 List Manual 

Maintenance/servicing • SINAMICS S120 Commissioning Manual 
• SINAMICS S120/S150 List Manual 

References • SINAMICS S120/S150 List Manual 

Target group 
This documentation is intended for machine manufacturers, commissioning engineers, and 
service personnel who use the SINAMICS drive system. 
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Benefits 
This Manual describes all the information, procedures and operational instructions required 
for commissioning and servicing SINAMICS S120. 

Standard scope 
The scope of the functionality described in this document can differ from the scope of the 
functionality of the drive system that is actually supplied. 

● It may be possible for other functions not described in this documentation to be executed 
in the drive system. However, no claim can be made regarding the availability of these 
functions when the equipment is first supplied or in the event of servicing. 

● Functions that are not available in a particular product version of the drive system may be 
described in the documentation. The functionality of the supplied drive system should 
only be taken from the ordering documentation. 

● Extensions or changes made by the machine manufacturer must be documented by the 
machine manufacturer. 

For reasons of clarity, this documentation does not contain all of the detailed information on 
all of the product types. This documentation cannot take into consideration every 
conceivable type of installation, operation and service/maintenance. 

Technical Support 
Country-specific telephone numbers for technical support are provided in the Internet under 
Contact: 

http://www.siemens.com/automation/service&support 

EC Declaration of Conformity 
The EC Declaration of Conformity for the EMC Directive can be found on the Internet at: 

http://support.automation.siemens.com 

There – as a search term – enter the number 15257461 or contact your local Siemens office. 

The EC Declaration of Conformity for the Low Voltage Directive can be found on the Internet 
at: 

http://support.automation.siemens.com 

There – as a search term – enter the number 22383669. 
 

 Note 

When operated in dry areas, SINAMICS S units conform to Low-Voltage Directive 
2006/95/EC. 

 

http://www.siemens.com/automation/service&support
http://support.automation.siemens.com
http://support.automation.siemens.com
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 Note 

SINAMICS S units fulfill EMC Directive 2004/108/EC in the configuration specified in the 
associated EC Declaration of Conformity for EMC and when the EMC installation guideline 
provided in the Configuration Manual with Order No. 6FC5297-0AD30-0⃞P⃞ is 
implemented. 

 

 Note 

The Commissioning Manual describes a desired state, which, if maintained, ensures the 
required level of operational reliability and compliance with EMC limit values. 

Should there be any deviation from the requirements in the Commissioning Manual, 
appropriate actions (e.g. measurements) must be taken to check/prove that the required 
level of operational reliability and compliance with EMC limit values are ensured. 

 

EMC limit values in South Korea 

 
The EMC limit values to be complied with for South Korea correspond to the limit values of 
the EMC product standard for variable-speed electric drives EN 61800-3, Category C2 or 
limit value class A, Group 1 according to EN 55011. By applying suitable supplementary 
measures, the limit values according to Category C2 or according to limit value class A, 
Group 1, are maintained. Further, additional measures may be required, for instance, using 
an additional radio interference suppression filter (EMC filter). 
The measures for EMC-compliant design of the system are described in detail in this manual 
respectively in the Configuration Manual EMC Installation Guideline. 
Please note that the final statement regarding compliance with the standard is given by the 
respective label attached to the individual unit. 

Spare parts 
Spare parts are available on the Internet at: 
http://support.automation.siemens.com/WW/view/de/16612315 

Test certificates 
The Safety Integrated functions of SINAMICS components are generally certified by 
independent institutes. An up-to-date list of already certified components is available on 
request from your local Siemens office. If you have any questions relating to certifications 
that have not yet been completed, please ask your Siemens contact. 

http://support.automation.siemens.com/WW/view/de/16612315
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Explanation of symbols 
 

Symbol Meaning 
 

 

 
Protective earth (PE) 

 

 

 
Ground (e.g. M 24 V) 

 

 

 
Functional ground 

Equipotential bonding 

Notation 
The following notation and abbreviations are used in this documentation: 

Notation for faults and alarms (examples): 

 
• F12345 Fault 12345  

• A67890 Alarm 67890  

Notation for parameters (examples): 

 
• p0918 Adjustable parameter 918 

• r1024 Display parameter 1024 

• p1070[1] Adjustable parameter 1070, index 1 

• p2098[1].3 Adjustable parameter 2098, index 1 bit 3 

• p0099[0...3] Adjustable parameter 99, indices 0 to 3 

• r0945[2](3) Display parameter 945, index 2 of drive object 3 

• p0795.4 Adjustable parameter 795, bit 4 
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ESD Notes 
Electrostatic sensitive devices (ESDs) are individual components, integrated circuits, 
modules or devices that may be damaged by either electrostatic fields or electrostatic 
discharge.  

 

NOTICE 

 
Damage due to electric fields or electrostatic discharge 

Electric fields or electrostatic discharge can result in malfunctions as a result of damaged 
individual components, integrated circuits, modules or devices. 
• Package, store, transport and send the electronic components, modules or devices only 

in the original product packaging or in other suitable materials, e.g. conductive foam 
rubber or aluminum foil. 

• Only touch components, modules and devices, if you are grounded using one of the 
following measures: 
– Wearing an ESD wrist strap 
– Wearing ESD shoes or ESD grounding straps in ESD areas with conductive flooring 

• Only place down electronic components, modules or devices on conductive surfaces 
(table with ESD surface, conductive ESD foam, ESD packaging, ESD transport 
container). 
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Safety notices 
 

DANGER  
Danger of death when live parts are touched 

Touching live parts can result in death or severe injury. 
• Only work on electrical equipment if you are qualified to do so. 
• When carrying out any work, always comply with the country-specific safety rules. 

Generally, six steps apply when establishing safety:  
1. Prepare for shutdown and inform team members who will be affected by the procedure. 
2. Switch off the machine so that it is in a no-voltage state. 

– Switch off the machine. 
– Wait until the discharge time specified on the warning labels has elapsed. 
– Check that it really is in a no-voltage condition, from phase conductor to phase 

conductor and phase conductor to protective conductor. 
– Check that all auxiliary circuits are also in a no-voltage state. 
– Ensure that the motor cannot move. 

3. Identify all other dangerous energy sources, e.g. compressed air, hydraulic systems or 
water. 

4. Isolate or neutralize all hazardous energy sources. For instance, by closing switches, 
grounding or short-circuiting or closing valves. 

5. Lock out all energy sources so that they cannot be switched on again. 
6. Make sure that the machine is completely locked out ... and that you have the right 

machine! 

After you have completed the work, restore the operational readiness in the inverse 
sequence.  
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DANGER  
Risk of electric shock, hazardous axis movements 
• Commissioning is absolutely prohibited until it has been completely ensured that the 

machine, in which the components described here are to be installed, is in full 
compliance with the provisions of the EC Machinery Directive. 

• SINAMICS devices and AC motors may only be commissioned by suitably qualified 
personnel. 

• The personnel must take into account the information provided in the technical customer 
documentation for the product, and be familiar with and observe the specified danger 
and warning notices. 

• When electrical equipment and motors are operated, the electrical circuits automatically 
conduct a dangerous voltage. 

• Dangerous mechanical movements are possible during system operations. 
• All the work carried out on the electrical machine or system must be carried out with it in 

a no-voltage condition. 
• SINAMICS devices with three-phase motors must only be connected to the power 

supply via a universal current-sensitive residual current operated device with selective 
switching once it has been verified that the SINAMICS device is compatible with the 
residual current operated device in accordance with IEC 61800-5-1. 

 

WARNING  
Improper handling of the devices 
• The successful and safe operation of this equipment and motors is dependent on 

professional transport, storage, installation and mounting as well as careful operations , 
service and maintenance. 

• Information and data from the catalogs and quotations also apply to special versions of 
the equipment and motors. 

• In addition to the danger and warning information provided in the technical customer 
documentation, the applicable national, local, and plant-specific regulations and 
requirements must be taken into account. 

• Only protective extra-low voltages (PELV) that comply with EN60204-1 may be 
connected to all connections and terminals between 0 and 48 V. 

• The motors can have surface temperatures of over +100 °C. 
• This is why temperature-sensitive components, e.g. cables or electronic components 

must not be in contact with or attached to the motor. 
• When attaching the connecting cables, you must ensure that 

– they are not damaged 
– they are not stressed 
– they cannot come into contact with any rotating parts 
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WARNING  
Hazardous axis movements for safety functions that have not been parameterized 

The Safe Torque Off (STO) safety function (Safety Integrated basic functions or extended 
functions) must be parameterized in order to use the pulse inhibit terminals at the Motor 
Modules, booksize, booksize compact, chassis and Cabinet Modules and at the Power 
Modules, chassis and blocksize formats. 

The procedure to do this is described in both function manuals (SINAMICS S120 Function 
Manual Drive Functions and SINAMICS S120 Function Manual Safety Integrated). 

 

NOTICE  
Material damage as a result of incorrect voltage tests 
• As part of routine tests, SINAMICS devices with three-phase motors are subject to a 

voltage test in accordance with EN 61800-5-1. Before the voltage test is performed on 
the electrical equipment of industrial machines to EN 60204-1, Section 18.4, all 
connectors of SINAMICS devices must be disconnected/withdrawn to prevent the 
equipment from being damaged. 

• Motors should be connected up according to the circuit diagram provided otherwise they 
may be destroyed. 

 

 Note 
Low-voltage directive 

When operated in dry areas, SINAMICS devices with three-phase motors conform to Low-
Voltage Directive 2006/95/EC. 
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Preparation for commissioning 1
 

Before commissioning observe the conditions described in this chapter. 

● The preconditions for commissioning must be fulfilled (in the next chapter). 

● The relevant checklist must have been worked through. 

● The bus components required for communication must be wired up. 

● DRIVE-CLiQ wiring rules must be complied with. 

● The ON-OFF responses of the drive. 
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1.1 Requirements for commissioning 
The following are necessary for commissioning a SINAMICS S drive system: 

● A programming device (PG/PC) 

● STARTER commissioning tool 

● A communication interface, e.g. PROFIBUS, PROFINET, Ethernet 

● Completely wired-up drive line-up (see the SINAMICS S120 Manual) 

The following diagram shows a configuration example with booksize and chassis 
components, as well as with PROFIBUS and PROFINET communication: 

 
Figure 1-1 Component configuration (example)  
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1.2 Check lists to commission SINAMICS S 

Checklist (1) for commissioning booksize power units 
The following checklist must be carefully observed. Read the safety instructions in the 
Manuals before starting any work.  

Table 1- 1 Checklist for commissioning (booksize)  

Check OK 
Are the environmental conditions in the permissible range?   
Is the component firmly attached to the fixing points provided?  
Is the specified air flow for cooling the devices ensured?  
Have the ventilation clearances for the components been observed?  
Is the memory card correctly inserted in the Control Unit?  
Are all of the necessary components of the configured drive line-up available, installed 
and connected? 

 

Do the temperature monitoring circuits fulfill the specifications of protective 
separation? 

 

Have the DRIVE-CLiQ topology rules been observed?  
Have the line-side and motor-side power cables been dimensioned and routed in 
accordance with the environmental and routing conditions? 

 

Have the maximum permissible cable lengths between the frequency converter and 
the motor (depending on the type of cables used) been observed? 

 

Have the power cables been properly connected to the component terminals with the 
specified torque?  

 

Have all of the remaining screws been tightened to the specified torque?  
Has all wiring work been successfully completed?  
Are all connectors correctly plugged in and screwed in place?  
Have all the covers for the DC link been closed and latched into place?  
Have the shield supports been correctly connected through a large surface area?  
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Checklist (2) for commissioning chassis power units 
The following checklist must be carefully observed. Read the safety instructions in the 
Manuals before starting any work.  

Table 1- 2 Checklist for commissioning (chassis)  

Activity OK 
Are the environmental conditions in the permissible range?  
Are the components correctly installed in the cabinets?  
Is the specified air flow for cooling the devices ensured?  
Is an air short-circuit between the air inlet and outlet for the chassis components 
prevented by the installation arrangements? 

 

Have the ventilation clearances for the components been observed?  
Is the memory card correctly inserted in the Control Unit?  
Are all of the necessary components of the configured drive line-up available, installed 
and connected? 

 

Do the temperature monitoring circuits fulfill the specifications of protective 
separation?  

 

Have the DRIVE-CLiQ topology rules been observed?  
Have the line-side and motor-side power cables been dimensioned and routed in 
accordance with the environmental and routing conditions? 

 

Have the maximum permissible cable lengths between the frequency converter and 
the motor (depending on the type of cables used) been observed? 

 

Is the ground for the motors directly connected to the ground for the Motor Modules 
(shortest distance)? 

 

Are the motors connected with shielded power cables?  
Are the power cable shields connected as closely as possible to the terminal box 
across a wide area? 

 

Have the power cables been properly connected to the component terminals with the 
specified torque?  

 

Have all of the remaining screws been tightened to the specified torque?  
Has the total power of the DC busbar been dimensioned sufficiently?  
Has the busbar/wiring for the DC connection between the infeed and the Motor 
Modules been dimensioned sufficiently with regard to the load and installation 
conditions? 

 

Are the cables between the low-voltage switchgear and the power unit protected with 
line fuses? Line protection(1) should be taken into account.  

 

Have measures been taken to relieve strain on the cables?  
For external auxiliary infeed: Have the cables for the auxiliary infeed been connected 
according to the Equipment Manual? 

 

Have the control cables been connected in accordance with the required interface 
configuration and the shield applied? 

 

Have the digital and analog signals been routed with separate cables?   
Has the distance from power cables been observed?  
Has the cabinet been properly grounded at the points provided?  
Has the connection voltage for the fans in the chassis components been adapted 
accordingly to the supply voltages? 
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Activity OK 
For operation on non-grounded supply systems: Has the connection bracket for the 
interference suppression at the Infeed Module or the Power Module been removed? 

 

Is the period from the date of manufacture to initial commissioning or the downtime of 
the power components less than two years(2)? 

 

Is the drive operated from a higher-level controller/control room?  

 
(1) Combined fuses are recommended for conductor and semi-conductor protection 
(VDE 636, Part 10 and Part 40 / EN 60269-4). For information about the relevant fuses, see 
the catalog. 
(2)If the downtime period is longer than two years, the DC link capacitors must be reformed 
(see the "Maintenance and Servicing" chapter in the Equipment Manual). The cabinet rating 
plate can be used to ascertain the date of manufacture.  

Checklist (3) for commissioning blocksize Power Modules 
The following checklist must be carefully observed. Read the safety instructions in the 
Manuals before starting any work.  

Table 1- 3 Check list for commissioning blocksize  

Check OK 
Are the environmental conditions in the permissible range?   
Is the component firmly attached to the fixing points provided?  
Is the specified air flow for cooling the devices ensured?  
Have the ventilation clearances for the components been observed?  
Is the memory card correctly inserted in the Control Unit?  
Are all of the necessary components of the configured drive line-up available, installed 
and connected? 

 

Do the temperature monitoring circuits fulfill the specifications of protective 
separation? 

 

Have the line-side and motor-side power cables been dimensioned and routed in 
accordance with the environmental and routing conditions? 

 

Have the maximum permissible cable lengths between the frequency converter and 
the motor (depending on the type of cables used) been observed? 

 

Have the power cables been properly connected to the component terminals with the 
specified torque?  

 

Have all of the remaining screws been tightened to the specified torque?  
Has all wiring work been successfully completed?  
Are all connectors correctly plugged in and screwed in place?  
Have the shield supports been correctly connected through a large surface area?  
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1.3 PROFIBUS components 
For communication via PROFIBUS, the following components are necessary.  

● A communication module for PG/PC connection via the PROFIBUS interface. 

– PROFIBUS connection to a PG/PC via USB port (USB V2.0). 
Structure: USB port (USB V2.0) + adapter with 9-pin SUB-D socket connector to 
connect to PROFIBUS.  
Used with driver SIMATIC Net PC Software Edition 2008 + SP2 
Order No.: 6GK1571-1AA00 

Connecting cable 

Connecting cable between PROFIBUS adapter and programming device/PC, such as 

● CP 5xxx cable, Order No.: 6ES7901-4BD00-0XA0 

● MPI cable (SIMATIC S7), Order No.: 6ES7901-0BF00-0AA0 

Cable lengths 

Table 1- 4 Permissible PROFIBUS cable lengths 

Baud rate [bit/s] Max. cable length [m] 
9.6 k to 187.5 k 1000 
500 k 400 
1.5 M 200 
3 to 12 M 100 
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1.4 PROFINET components 
For communication via PROFINET, the following components are necessary: 

● A communication module for programming device/PC connection via the PROFINET 
interface. 

  Note 
Cables that can be used for commissioning 

For commissioning using the STARTER commissioning tool, the onboard Ethernet 
interface of the Control Unit can be used with a crossover cable from CAT5 and higher.  

The PROFINET module CBE20 supports all standard Ethernet cables and crossover 
cables from CAT5/5e and higher.  

● Connecting cable  
Connecting cable between PROFINET adapter and programming device/PC, such as 

– Industrial Ethernet FC TP Standard Cable GP 2 x 2 (up to max. 100 m) 

Standard bus cable with rigid conductors and a special design for fast installation 

Order No.: 6XV1840-2AH10 

– Industrial Ethernet FC TP Flexible Cable GP 2 x 2 (up to max. 85 m) 

Order No.: 6XV1870-2B 

– Industrial Ethernet FC Trailing Cable GP 2 x 2 (up to max. 85 m) 

Order No.: 6XV1870-2D 

– Industrial Ethernet FC Trailing Cable 2 x 2 (up to max. 85 m) 

Order No.: 6XV1840-3AH10 

– Industrial Ethernet FC Marine Cable 2 x 2 (up to max. 85 m) 

Order No.: 6XV1840-4AH10 

● Connector 
Connector between the PROFINET adapter and the PG/PC, for example 

– Industrial Ethernet FC RJ45 Plug 145 for Control Unit 

Order No.: 6GK1901-1BB30-0Ax0 
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1.5 Rules for wiring with DRIVE-CLiQ 
Rules apply for wiring components with DRIVE-CLiQ. A distinction is made between binding 
DRIVE-CLiQ rules, which must be unconditionally observed and recommended rules, which 
should then be maintained so that the topology, generated offline in the STARTER 
commissioning tool, no longer has to be changed.  

The maximum number of DRIVE-CLiQ components and the possible wiring type depend on 
the following factors: 

● The binding DRIVE-CLiQ wiring rules 

● The number and type of activated drives and functions on the Control Unit in question 

● The computing power of the Control Unit in question 

● The set processing and communication cycles 

Below you will find the binding wiring rules and some other recommendations as well as a 
few sample topologies for DRIVE-CLiQ wiring. 

The components used in these examples can be removed, replaced with others or 
supplemented. If components are replaced by another type or additional components are 
added, then the SIZER configuring tool should be used to check this topology. 

If the actual topology does not match the topology created offline using the STARTER 
commissioning tool, the offline topology must be changed accordingly before it is 
downloaded.  

1.5.1 DRIVE-CLiQ diagnostics 

DRIVE-CLiQ diagnostics 
Using the DRIVE-CLiQ diagnostics, you can check the connections and cables of DRIVE-
CLiQ connections. For data transfer errors, to localize the faulted connection, the error 
counter in the PHY blocks involved can be evaluated.  

In addition to the error counter showing all errors, detailed diagnostics can be carried out for 
the individual connections. For selected connections, the number of errors is determined for 
a time interval that can be specified and made traceable using a parameter. As a result of 
the interconnectability, you can record when data transfer errors occur and correlate them 
with other events in the drive. 
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Overview of important parameters 
 
• r9936[0...199] DRIVE-CLiQ diagnostics, error counter connection 

• p9937 DRIVE-CLiQ diagnostics configuration 

• p9938 DRIVE-CLiQ detailed diagnostics configuration 

• p9939 DRIVE-CLiQ detailed diagnostics time interval 

• p9942 DRIVE-CLiQ detailed diagnostics individual connection selection 

• r9943 DRIVE-CLiQ detailed diagnostics individual connection error counter 

Detailed information on the parameters for DRIVE-CLiQ diagnostics is provided in the 
SINAMICS S120/S150 List Manual.  

1.5.2 Binding DRIVE-CLiQ rules 
The wiring rules below apply to standard cycle times (servo control 125 µs, vector control 
250 µs). For cycle times that are shorter than the corresponding standard cycle times, 
additional restrictions apply due to the computing power of the Control Unit (configured using 
the SIZER engineering tool). 

 

 Note 

A Double Motor Module, one DMC20, one DME20, one TM54F and one CUA32 each 
correspond to two DRIVE-CLiQ participants. This also applies to Double Motor Modules, at 
which just one drive is configured. 

 

The following generally binding DRIVE-CLiQ rules must be observed to ensure safe 
operation of the drive. 

● A maximum of 14 DRIVE-CLiQ nodes can be connected to one DRIVE-CLiQ line at a 
Control Unit, e.g. 12 U/f axes + 1 Infeed Module + 1 additional module. In the example 
below, the DRIVE-CLiQ line includes drive objects 1 to 14. 

● A maximum of 8 Motor Modules may be connected to one Control Unit. For multi-axis 
modules, each axis counts individually (1 Double Motor Module = 2 Motor Modules). 
Exception: For U/f control it is permissible to connect a maximum of 12 Motor Modules. 

● With vector U/f control, it is only permissible to connect more than 4 participants to one 
DRIVE-CLiQ line of the Control Unit. 

● Ring wiring of components is not permitted. 
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● Double wiring of components is not permitted. 

 
Figure 1-2 Example: DRIVE-CLiQ line connected to the X103 DRIVE-CLiQ connection of a 

Control Unit  

● DRIVE-CLiQ components of unknown type within a topology are functionally not 
supported. The DRIVE-CLiQ signals are looped through.  
The following criteria denote the unknown type: 

– Characteristics of the component are not available. 

– A deputy drive object is not defined. 

– An assignment of the component to a known drive object (DO) is not defined. 

● In a DRIVE-CLiQ topology with a CU link and DRIVE-CLiQ connections, precisely one 
Control Unit is permissible as a CU Link master/DRIVE-CLiQ master. 

● If a CU link connection is detected, the DRIVE-CLiQ basic clock cycle 0 (r0110[0]) is set 
to 125 μs and assigned to this DRIVE-CLiQ socket. 

● The following applies for booksize format: 

– In the servo control, vector control and U/f control operating modes, only one Line 
Module may be connected to the Control Unit. 

– It is permissible that one Line Module and Motor Modules are connected together to 
one DRIVE-CLiQ line in servo control. 

– One Line Module and Motor Modules must be connected to separate DRIVE-CLiQ 
lines in vector control. 

– For booksize format, a parallel connection of Line Modules or Motor Modules is not 
possible. 

● The following applies for chassis format: 

– Line Modules (Active Line, Basic Line, Smart Line) and Motor Modules must be 
connected to separate DRIVE-CLiQ lines. 
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● Parallel operation of power units in chassis format: 

– A parallel connection of Infeed Modules as well as Motor Modules is only permitted for 
vector control or for V/f control. 

– A maximum of 4 Infeed Modules are permissible within a parallel connection. 

– A maximum of 4 Motor Modules are permissible within a parallel connection. 

– Precisely one parallel connection of Motor Modules is permitted. For a parallel 
connection, precisely one drive object is created in the topology. 

● For a parallel connection of Motor Modules, only one motor with integrated DRIVE-CLiQ 
interface (SINAMICS Sensor Module Integrated) is permitted for each Motor Module. 

● Switchover between different motors is not permitted for a parallel connection. 

● Mixed operation of Infeed Modules or Motor Modules: 

– The operation of Infeed Modules or Motor Modules with different performance values 
is not permitted within a parallel connection. 

– For Line Modules in chassis format, two parallel connections are permissible for mixed 
operation of Smart Line Modules and Basic Line Modules. 

– The following combinations of Line Modules are not permissible: 
Active Line Module (ALM) with Basic Line Module (BLM) 
Active Line Module (ALM) with Smart Line Module (SLM) 

● Mixed operation of formats: 

– Combining small power units (400V; >250kW) and large power units (500 - 690V) to a 
DriveCLiQ line results in current derating as a result of the pulse frequency adaptation. 
Chassis Motor Modules and booksize Motor Modules must therefore be connected to 
separate DRIVE-CLiQ lines. 

● Mixed operation of control types: 

– Mixed operation of servo control and vector control is not permissible. 

– Mixed operation of servo control and U/f control is permissible. 

– Mixed operation of vector control and U/f control is permissible. 

● Mixed operation of control cycles: 
The following combinations are permissible: 

– Servo control with 62.5 µs and servo control with 125 µs 

– Servo control with 125 µs and servo control with 250 µs 

– Vector control with 250 µs and vector control with 500 µs 

● Operation with Voltage Sensing Module (VSM): 

– If the function module for line infeed is activated, then a second or third Voltage 
Sensing Module (VSM) can be connected to a Line Module. 

– The VSM must be connected to a free DRIVE-CLiQ socket of the associated Line 
Modules or Motor Modules (to support automatic assignment of the VSM). 
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● At a drive object "SERVO" or "VECTOR", up to three encoder data sets can be created 
for each drive data set. The maximum number of encoder data sets depends on the 
quantity structure and the current controller clock cycle: 

– For a quantity structure of 6 axes in servo control with a controller cycle of 125 μs and 
one Line Module, it is permissible to connect a maximum of 12 encoders. 

– For 5 axes in servo control with a current controller cycle of 125 µs, a maximum of 15 
encoders can be connected. 

● A maximum of 24 drive objects (DOs) can be connected. 

● At the CU320-2 Control Unit, a maximum of 16 Terminal Modules can be connected. 
Note: If a TM15 Base, TM31, TM54F or a TM41 is connected, it is necessary to reduce 
the number of connected standard axes. 

● At the CU310-2 Control unit a maximum of 8 Terminal Modules, type TM15 Base and 
TM31 can be connected. 

● At the CU310-2 Control Unit, a maximum of 3 Terminal Modules, type TM15, TM17 or 
TM41 can be connected. 

● Cycle times with TM31 
A maximum of 3 Terminal Modules 31 (TM31) can be connected for a 2 ms time slice. 

● The communication basic clock cycles (p0115[0] and p4099) of all components that are 
connected to a DRIVE-CLiQ line must be divisible by one another with an integer result. 

– The smallest communication basic clock cycle is 125 µs. 

– The exception are a maximum of 3 servo-controlled axes with 62.5 µs communication 
basic clock cycle or a servo-controlled axis with 31.25 µs communication basic clock 
cycle. 

● For current controller clock cycles Ti < 125 μs, the Motor Modules – also with the same 
controller clock cycle – must be symmetrically connected to two DRIVE-CLiQ ports. 

● The fastest sampling time of a drive object in the servo control mode is obtained as 
follows: 

– Ti = 31.25 µs: Exactly 1 drive object in servo control (only CU320-2) 

– Ti = 62.5 µs: Max. 3 drive objects in servo control with CU320-2 
Exactly 1 drive object in servo control with CU310-2 

– Ti = 125 µs: Max. 6 drive objects in servo control 

● The fastest sampling time of a drive object in vector control mode is obtained as follows: 

– Ti = 250 µs: Max. 3 drive objects in vector control 

– Ti = 400 µs: Max. 5 drive objects in vector control 

– Ti = 500 µs: Max. 6 drive objects in vector control 

● The fastest sampling time of a drive object in vector U/f vector control mode is given as: 

– Ti = 500 µs: Max. 12 drive objects in U/f control mode 
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● The maximum number of DRIVE-CLiQ nodes on a DRIVE-CLiQ line of the Control Unit 
320-2 depends on the basic clock cycle of the DRIVE-CLiQ line: 

– For a current controller cycle of 31.25 µs, a maximum of 3 DRIVE-CLiQ nodes are 
permissible 

– For a current controller cycle of 62.5 µs, a maximum of 5 DRIVE-CLiQ nodes are 
permissible 

– For a current controller cycle of 125 µs, a maximum of 14 DRIVE-CLiQ nodes are 
permissible 

– For a current controller cycle of 250 µs, a maximum of 20 DRIVE-CLiQ nodes are 
permissible 

– For a current controller cycle of 500 µs, a maximum of 30 DRIVE-CLiQ nodes are 
permissible 

● The maximum number of DRIVE-CLiQ nodes on a DRIVE-CLiQ line of the Control Unit 
310-2 depends on the basic clock cycle of the DRIVE-CLiQ line: 

– From a current controller cycle of 125 µs, a maximum of 8 DRIVE-CLiQ nodes are 
permissible 

● Examples, CU320-2 with 62.5 µs sampling time: 

– Topology 1: 1 x ALM (250 µs) + 2 x servo (62.5 µs) + 2 x servo (125 µs) + 3 x TM15 + 
TM54F + 4 x Safety Integrated Extended Functions with encoder SI Motion monitoring 
clock cycle (p9500) = 12 ms + SI Motion actual value sensing clock cycle (p9511) = 4 
ms + 4 x dir. measuring systems 

– Topology 2: 1 x ALM (250 µs) + 2 x servo (62.5 µs) + 2 x U/f (500 µs) + 3 x TM15 
Base 2 ms +2 x Safety Integrated Extended Functions with encoder SI Motion 
monitoring clock cycle (p9500) = 12 ms + SI Motion actual value sensing clock cycle 
(p9511) = 4 ms + 2 x Safety Integrated Extended Functions sensorless + 2 x dir. 
measuring systems 

– Topology 3: 1 x servo (62.5 μs) + 4 x U/f is not possible in connection with Safety 
Integrated. 

● Example, CU320-2 with 31.25 µs sampling time: 

– Topology 1: 1 ALM (250 µs) on a line, 1 x servo (31.25 µs) on a line, 3 Terminal 
Modules on a line and in series 

– Topology 2: 1 ALM (250 µs) on a line, 1 x servo (31.25 µs) on a line, 1 direct 
measuring system on a line 

● If the current controller sampling time Ti at one drive object has to be changed in a 
sampling time that does not match the other drive objects in the DRIVE-CLiQ line, the 
following solutions are available: 

– Insert the modified drive object into a separate DRIVE-CLiQ line. 

– Modify the current controller sampling times and/or the sampling times of the 
inputs/outputs of the other drive objects in the same way, so that they match the 
modified sampling time again. 
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● Only components that have the same sampling time may be connected to DRIVE-CLiQ 
connections with a sampling time of Ti  = 31.25 μs.  
The following components are permissible: 

– Sensor Modules 

– High-frequency damping modules (HF damping modules) 

– Active Line Modules Booksize in the line of the HF filter module 

– Smart Line Modules Booksize in the line of the HF filter module 

– Additional DRIVE-CLiQ lines must be used for additional components: 
Additional Motor Modules in servo control, in vector control, in U/f control or Terminal 
Modules. 

● Connection of the following components is not permissible for a sampling time of 
Ti = 31.25 μs: 

– Additional Motor Modules in servo control 

– Additional Motor Modules in U/f control 

– When using a 310-2 Control Unit 

● Rules for using a TM54F: 

– A TM54F must be connected directly to a Control Unit via DRIVE-CLiQ. 

– Only one TM54F Terminal Module can be assigned to each Control Unit. 

– Additional DRIVE-CLiQ nodes can be operated at the TM54F, such as Sensor 
Modules and Terminal Modules (excluding an additional TM54F). It is not permissible 
that Motor Modules and Line Modules are connected to a TM54F. 

– In the case of a CU310-2 Control Unit, it is not possible to connect the TM54F to the 
DRIVE-CLiQ line of a Power Module. The TM54F can only be connected to the sole 
DRIVE-CLiQ X100 socket of the Control Unit. 

● A maximum of 4 Motor Modules with Safety Extended Functions may be operated on one 
DRIVE-CLiQ line (only for TI = 125 μs). Additional DRIVE-CLiQ components may not be 
connected to this DRIVE-CLiQ line. 

● If an axis has only one encoder, and if Safety functions are activated for this axis, then 
this encoder may be connected to the Motor Module or to the Hub Module DMC20 only. 

● The following applies to the DRIVE-CLiQ connection of CX/NX components to a Control 
Unit: 

The connection to the Control Unit is obtained from the PROFIBUS address of the CX/NX  
(10 → X100, 11 → X101, 12 → X102, 13 → X103, 14 → X104, 15 → X105). 

● It is not permissible to combine SIMOTION Master Control Units and SINUMERIK Slave 
Control Units. 

● It is not permissible to combine SINUMERIK Master Control Units and SIMOTION Slave 
Control Units. 
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For the CU310-2 Control Unit the following applies: 

● The CU310-2 is a 1-axis control module that is plugged on to a PM340 Power Module 

● The connection to Power Modules in the chassis format is established via the DRIVE-
CLiQ connection X100. 

● The minimum current controller clock cycle that can be selected both for plug-on 
operation as well as via the DRIVE-CLiQ connection X100, is 62.5 µs. 

● A current controller clock cycle of 31.25 µs is not possible. 

1.5.3 Recommended DRIVE-CLiQ rules 
To enable the function "Automatic configuration" to assign the encoders to the drives, the 
recommended rules below must also be observed: 

● The following applies to all DRIVE-CLiQ components with the exception of the Control 
Unit: The DRIVE-CLiQ sockets Xx00 are DRIVE-CLiQ inputs, the other DRIVE-CLiQ 
sockets are outputs. 

● A single Line Module should be connected directly to the X100 DRIVE-CLiQ socket of the 
Control Unit. 

– Several Line Modules should be connected in a line. 

– If the X100 DRIVE-CLiQ socket is not available, the next higher DRIVE-CLiQ socket 
should be used. 

● For a current controller cycle of 31.25 μs, a filter module should be directly connected to a 
DRIVE-CLiQ socket of the Control Unit. 

● For the chassis format, Motor Modules with a current controller cycle of 250 μs should be 
connected to DRIVE-CLiQ socket X101 of the Control Unit. If required, they should be 
connected in a line. 

– If the DRIVE-CLiQ socket X101 is not available, the next higher DRIVE-CLiQ socket 
should be used for these Motor Modules. 

● For the chassis format, Motor Modules with a current controller cycle of 400 μs should be 
connected to DRIVE-CLiQ socket X102 of the Control Unit. If required, they should be 
connected in a line. 

– If the DRIVE-CLiQ socket X102 is not available, the next higher DRIVE-CLiQ socket 
should be used for these Motor Modules. 

● Motor Modules in the chassis format with different pulse frequencies (frame sizes FX, GX, 
HX, JX) should be connected to separate DRIVE-CLiQ lines. 

● Line Modules and Motor Modules in the chassis format should be connected to separate 
DRIVE-CLiQ lines. 

● Peripheral components (e.g. Terminal Module, TM) should be connected to DRIVE-CLiQ 
socket X103 of the Control Unit in a line. 

– If the DRIVE-CLiQ socket X103 is not available, any free DRIVE-CLiQ socket can be 
selected for the peripheral components. 
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● In the servo control mode, Motor Modules in the booksize format should be connected to 
DRIVE-CLiQ socket X100 on the Control Unit in the line. 

– If the DRIVE-CLiQ socket X100 is not available, the next higher DRIVE-CLiQ socket 
should be used for these Motor Modules. 

● The motor encoders for the first drive of a Double Motor Module should be connected to 
the associated DRIVE-CLiQ socket X202. 

● The motor encoders for the second drive of a Double Motor Module should be connected 
to the associated DRIVE-CLiQ socket X203. 

● The motor encoder should be connected to the associated Motor Module: 
Connecting the motor encoder via DRIVE-CLiQ: 

– Single Motor Module Booksize to terminal X202 

– Double Motor Module Booksize motor X1 to terminal X202 and motor X2 to terminal 
X203 

– Single Motor Module Chassis to terminal X402 

– Power Module Blocksize with CUA31: Encoder to terminal X202 

– Power Module blocksize with CU310-2: Encoder to terminal X100 or via TM31 to X501 

– Power Module Chassis to terminal X402 

  Note 
Automatically assigning an additional encoder 

If an additional encoder is connected to a Motor Module, it is assigned to this drive as 
encoder 2 in the automatic configuration. 

● DRIVE-CLiQ sockets should, as far as possible, be symmetrically wired.  
Example: Do not connect 8 DRIVE-CLiQ nodes in series at one DRIVE-CLiQ socket of 
the CU - but instead, connect 2 nodes at each of the 4 DRIVE-CLiQ sockets. 

● The DRIVE-CLiQ cable from the Control Unit should be connected to DRIVE-CLiQ socket 
X200 on the first booksize power unit or X400 on the first chassis power unit. 

● The DRIVE-CLiQ connections between the power units should each be connected from 
the DRIVE-CLiQ sockets X201 to X200 and/or X401 to X400 on the follow-on component. 
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● A Power Module with the CUA31 should be connected to the end of the DRIVE-CLiQ line. 

 
Figure 1-3 Example: DRIVE-CLiQ line 

● Only one final node should be connected to free DRIVE-CLiQ sockets of components 
within a DRIVE-CLiQ line (e.g. Motor Modules wired in series), for example, one Sensor 
Module or one Terminal Module, without routing to additional components. 

● If possible, Terminal Modules and Sensor Modules of direct measuring systems should 
not be connected to the DRIVE-CLiQ line of Motor Modules, but rather, to free DRIVE-
CLiQ sockets of the Control Unit. 
Note: This restriction does not apply to star-type connections. 

● The TM54F should not be operated on the same DRIVE-CLiQ line as Motor Modules. 

● The Terminal Modules TM15, TM17 and TM41 have faster sample cycles than the TM31 
and TM54F. For this reason, the two Terminal Module groups should be connected to 
separate DRIVE-CLiQ lines. 

● For mixed operation of the servo control and vector U/f control operating modes, separate 
DRIVE-CLiQ lines should be used for the Motor Modules. 

– A combination of operating modes is not possible on a Double Motor Module. 

● The Voltage Sensing Module (VSM) should be connected to the DRIVE-CLiQ socket 
X202 (booksize format) or X402 (chassis format) of the Line Module. 

– If the X202/X402 DRIVE-CLiQ sockets are not available, a free DRIVE-CLiQ socket of 
the Line Module should be used. 

 
Figure 1-4 Example of a topology with VSM for booksize and chassis components 
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1.5.4 Notes on the number of controllable drives 
The number and type of controlled axes and the additionally activated functions can be 
scaled by configuring the firmware. Especially for demanding configurations, drives with high 
dynamics or a large number of axes with additional utilization of special functions for 
example, a check using the SIZER engineering tool is recommended. The SIZER 
engineering tool calculates the feasibility of the project.  

The maximum possible functionality depends on the performance of the Control Unit used 
and the components configured.  

1.5.4.1 System sampling times and number of controllable drives 
This chapter lists the number of axes that can be operated with a Control Unit. The number 
of axes depends on the cycle times and the control mode. The other available remaining 
computation times are available for options (e.g. DCC).  

Cycle times for servo control 
This following table lists the number of axes that can be operated with a Control Unit in the 
servo control mode. The number of axes is also dependent on the cycle times of the 
controller: 

Table 1- 5 Sampling time setting for servo control 

Cycle times [µs] Number 

Current 
controller 

Speed controller Axes Infeed 

Motor / dir. 
measuring 
systems 

TM1)/TB 

125 125 6 1 [250 μs] 6 / 6 3 [2000 μs] 
62,5 62,5 3 1 [250 μs] 3 / 3 3 [2000 μs] 

31,252) 31,252) 1 1 [250 μs] 1 / 1 3 [2000 μs] 
1) Valid for TM31 or TM15IO; for TM54F, TM41, TM15, TM17, TM120, TM150 - restrictions are possible dependent on the 
set sampling time. 
2) At the 31.25 µs cycle level you can additionally setup the following objects: 
• Sensor Module External (SME) and the SMC20 supported with the current firmware and hardware. These can be 

identified by the final digit of the order number ... 3. 
• No additional axis can be operated at this cycle level. 
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The following combinations are permissible for current controller cycle mixed operation: 

● Servo control with 125 µs and servo control with 250 µs (max. 2 clock cycle levels can be 
mixed) 

● Servo control with 62.5 µs and servo control with 125 µs (max. 2 clock cycle levels can be 
mixed) 

Note the following: 1 axis with 31.25 µs corresponds to 

● 2 servo control axes with 62.5 µs 

● 4 servo control axes with 125 µs 

● 8 U/f control axes with 500 µs 

Cycle times for vector control  
This following table lists the number of axes that can be operated with a Control Unit in the 
vector control mode. The number of axes is also dependent on the cycle times of the 
controller:  

Table 1- 6 Sampling time setting for vector control 

Cycle times [µs] Number 

Current 
controller 

Speed controller Axes Infeed2) 

Motor / dir. 
measuring 
systems 

TM1)/TB 

500 µs 2000 µs 6 1 [250 μs] 6 / 6 3 [2000 μs] 
4003) µs 1600 µs 5 1 [250 μs] 5 / 5 3 [2000 μs] 
250 µs 1000 µs 3 1 [250 μs] 3 / 3 3 [2000 μs] 

1) Valid for TM31 or TM15IO; for TM54F, TM41, TM15, TM17, TM120, TM150 - restrictions are possible dependent on the 
set sampling time. 
2) For power units in chassis format, the infeed cycle depends on the power rating of the module and can be 400 μs, 375 
μs or 250 μs. 
3) This setting results in lower remaining computation times. 

In closed-loop vector control, current controller cycles can be mixed with 250 µs and 500 µs. 
 

 Note 
Restriction for the chassis format 

If edge modulation and wobbling are activated simultaneously with p1802 ≥ 7 and p1810.2 = 
1 respectively, the quantity structure for vector control is halved. Then a maximum of 3 axes 
at a current control cycle of 500 µs, 2 axes at 400 µs or 1 axis at 250 µs are permissible. 
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Cycle times for U/f control  
This following table lists the number of axes that can be operated with a Control Unit in the 
U/f control mode. The number of axes is dependent on the current controller clock cycle: 

Table 1- 7 Sampling time setting for U/f control 

Cycle times [µs] Number 

Current 
controller 

Speed controller Drives / Infeed 

Motor / dir. 
measuring 
systems 

TM/TB 

500 2000 12 1 [250 μs] - / - 3 [2000 μs] 

Mixed operation of servo control and U/f open-loop control  
In mixed operation with servo control and U/f control, one axis in servo control at 125 µs 
uses exactly as much computing performance as two axes in U/f control at 500 µs. In 
conjunction with servo control, a maximum of 11 axes are permitted (1 servo control plus 10 
vector control U/f). 

Table 1- 8 Number of axes for mixed servo control operation 

Number of axes in servo control Number of axes in U/f control 
6 125 µs 3 62.5 µs 0  
5 125 µs   2 500 µs 
4 125 µs 2 62.5 µs 4 500 µs 
3 125 µs   6 500 µs 
2 125 µs 1 62.5 µs 8 500 µs 
1 125 µs   10 500 µs 
0  0  12 500 µs 

Mixed operation of vector control and U/f open-loop control 
In mixed operation with vector control and U/f control, one axis in vector control at 250 µs 
uses exactly as much computing performance as two axes in U/f control at 500 µs. In 
conjunction with vector control, a maximum of 11 axes are permitted (1 vector control plus 
10 U/f control). 

Table 1- 9 Number of axes for mixed vector control operation 

Number of axes in vector control Number of axes in U/f control 
6 500 µs 3 250 µs 0  
5 500 µs   2 500 µs 
4 500 µs 2 250 µs 4 500 µs 
3 500 µs   6 500 µs 
2 500 µs 1 250 µs 8 500 µs 
1 500 µs   10 500 µs 
0  0  12 500 µs 
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Cycle times of the CU310-2 in the servo control mode 

Table 1- 10 Sampling time setting for servo control 

Cycle times [µs] Number Via DQ2) Snapped-on 

Current 
controller 

Speed controller Axes Infeed Motor Module Power Module 

TM1)/TB 

125 125 1 - - 1 3 [2000 μs] 
62,5 62,5 1 - - 1 3 [2000 μs] 

1) Valid for TM15, TM17 or TM41; for TM54F, TM31, TM120, TM150 - restrictions are possible dependent on the set 
sampling time. 
2) DQ = DRIVE-CLiQ  

If the 310-2 Control Unit is snapped on to a PM340 Power Module, a minimum current 
controller clock cycle of 62.5 µs is possible. 

Using DCC  
The available remaining computation time can be used for DCC. In this case, the following 
supplementary conditions apply: 

● For a 2 ms time slice, a max. of 75 DCC blocks can be configured for each servo control 
axis with 125 μs that can be omitted/eliminated (≙ 2 U/f axes with 500 μs). 

● 50 DCC blocks for 2 ms time slice correspond to 1.5 U/f axes with 500 μs. 

Detailed information about handling and using DCC standard blocks is provided in the 
"SINAMICS/SIMOTION Editor description DCC" manual.  

Using EPOS  
The following table lists the number of axes that can be operated with a SINAMICS S120 
when using a basic positioning system (EPOS). The number of axes is dependent on the 
current controller clock cycle. 

Table 1- 11 Sampling times when using EPOS 

Cycle times [µs] Cycle times [ms] Number 
Current controller Speed controller Position controller Positioner Axes Infeed 

250 250 2 8 6 1 [250 μs] 
250 250 1 4 5 1 [250 μs] 
125 125 1 4 4 1 [250 μs] 

The CPU processing time required for the function module EPOS (with 1 ms position 
controller/4 ms positioner) corresponds to the same CPU processing time of 0.5 U/f axes 
with 500 μs.  
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Using CUA31/CUA32  
Information on using the Control Unit Adapter CUA31 or CUA32: 

● CUA31/32 is the first component in the CUA31/32 topology: 5 axes 

● CUA31/32 is not the first component in the CUA31/32 topology: 6 axes 

● For a current controller cycle of 62.5 µs, only 1 axis is possible with one CUA31/32. 

1.5.4.2 Optimizing DRIVE-CLiQ 

Symmetrical distribution for the controller clock cycles 62.5 µs and 31.25 µs 
For optimum computation times of the Control Unit, the axes must be distributed across the 
DRIVE-CLiQ connections as follows: 

● DRIVE-CLiQ socket X100: Infeed, axes 2, 4, 6, ... 

● DRIVE-CLiQ socket X101: Axes 1, 3, 5, ... 

The advantage of this arrangement is that the Control Unit always receives 2 measured 
values simultaneously. 

1.5.4.3 Default settings for the sampling times 
When commissioning for the first time, the current controller sampling times (p0115[0]) are 
automatically pre-set with factory setting values:  

Table 1- 12 Factory settings 

Construction type Number p0112 p0115[0] p1800 
Active Infeed 
Booksize 1 2 (Low) 250 µs - 
Chassis 
400 V / ≤ 300 kW 
690 V / ≤ 330 kW 

 
1 
1 

 
2 (Low) 
2 (Low) 

 
250 µs 
250 µs 

 
- 
- 

Chassis 
400 V / > 300 kW 
690 V / > 330 kW 

 
1 
1 

 
0 (Expert) 
1 (xLow) 

 
375 µs (p0092 = 1) 
400 µs (p0092 = 0) 

 
- 
- 

Smart Infeed 
Booksize 1 2 (Low) 250 µs - 
Chassis 
400 V / ≤ 355 kW 
690 V / ≤ 450 kW 

 
1 
1 

 
2 (Low) 
2 (Low) 

 
250 µs 
250 µs 

 
- 
- 

Chassis 
400 V / > 355 kW 
690 V / > 450 kW 

 
1 
1 

 
0 (Expert) 
1 (xLow) 

 
375 µs (p0092 = 1) 
400 µs (p0092 = 0) 

 
- 
- 

Basic Infeed 
Booksize 1 4 (High) 250 µs - 
Chassis 1 2 (Low) 2000 µs - 
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Construction type Number p0112 p0115[0] p1800 
SERVO 
Booksize 1 to 6 3 (Standard) 125 µs 4 kHz 
Chassis 1 to 6 1 (xLow) 250 µs 2 kHz 
Blocksize 1 to 5 3 (Standard) 125 µs 4 kHz 
VECTOR 
Booksize 4 kHz 
Chassis 
400 V / ≤ 250 kW 

1 to 3 only n_ctrl 
1 to 6 only U/f 

3 (Standard) 250 µs 
2 kHz 

Booksize 4 kHz 
Chassis 
400 V / ≤ 250 kW 

4 to 12  0 (Expert) 500 µs 
2 kHz 

Chassis 
> 250 kW 
690 V 

1 to 4 only n_ctrl 
1 to 5 only U/f 
1 to 6 only n_ctrl 

0 (Expert) 
1 (xLow) 
0 (Expert) 

375 µs (p0092 = 1) 
400 µs (p0092 = 0) 
500 µs (p0092 = 1) 

1.333 kHz 
1.25 kHz 
2 kHz 

 

 

 Note 

If a Power Module in blocksize format is connected to a Control Unit, the sampling times of 
all vector drives are set according to the rules for Power Modules in blocksize format (only 
250 µs or 500 µs possible). 

 



 Preparation for commissioning 
 1.5 Rules for wiring with DRIVE-CLiQ 

Commissioning Manual 
Commissioning Manual, (IH1), 01/2013, 6SL3097-4AF00-0BP3 41 

1.5.5 Changing the offline topology in the STARTER commissioning tool 
The device topology can be changed in the STARTER commissioning tool by shifting the 
components in the topology tree. 

 

Example: Changing the DRIVE-CLiQ topology 

1. Select the DRIVE-CLiQ component. 

 
2. While holding down the mouse button, drag the component to the required DRIVE-CLiQ 

interface and release the mouse button. 

 
You have changed the topology in the STARTER commissioning tool.  
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1.5.6 Modular machine concept: Offline correction of the reference topology 
The topology is based on a modular machine concept. The machine concept is created 
offline in the STARTER commissioning tool in the maximum version as reference topology. 

The maximum version is the maximum expansion of a particular machine type. In the 
maximum version, all the machine components that can be used are pre-configured in the 
reference topology.  

Deactivating components / handling non-existent components 
In a lower expansion stage of the machine, you must mark drive objects and encoders that 
are not used in the STARTER topology. To do this, for the corresponding drive objects and 
encoder, set parameter p0105 or p0145 = 2 (deactivate component and does not exist). 
Components set to the value "2" in a project generated offline must never be inserted in the 
actual topology at all. 

If a component fails, the sub-topology can also be used to allow a machine to continue to 
operate until the spare part is available. In this case, however, no BICO source must be 
interconnected from this drive object to other drive objects. 

Example of a sub-topology 
The starting point is a machine created offline in the STARTER commissioning tool. "Drive 1" 
was not implemented for this machine. 

1. You can remove drive object "Drive 1" "offline" from the reference topology using  
p0105 = 2. 

2. Change over the DRIVE-CLiQ cable from the Control Unit directly to "Drive 2". 

3. Transfer the project with "Download to drive unit". 
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4. Then execute a "Copy RAM to ROM". 

 
Figure 1-5 Example of a sub-topology 
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CAUTION  
 

Incorrect SI status 

If a drive in a Safety Integrated drive line-up is deactivated using p0105, then r9774 is 
not correctly output because the signals of the deactivated drive are no longer updated. 

Therefore, withdraw the associated drive from the group before deactivating it.  
See also: SINAMICS S120 Safety Integrated Function Manual 

Activating/deactivating components 
Drive objects can be activated/deactivated using parameter p0105 and encoders with 
p0145[0...n] in the Expert list in the same way. If a component is not required at certain 
times, then for the component, change parameter p0105 or p0145 from "1" to "0". The 
deactivated components remain inserted, however, they are deactivated. Errors are not 
displayed from deactivated components. 

Overview of important parameters (see SINAMICS S120/S150 List Manual) 
 
• p0105 Activating/deactivating drive object 

• r0106 Drive object active/inactive 

• p0125 Activate/deactivate power unit component 

• r0126 Power unit components active/inactive 

• p0145[0...n] Enable/disable sensor interface 

• r0146 Sensor interface active/inactive 

• p9495 BICO behavior to de-activated drive objects 

• p9496 BICO behavior when activating drive objects 

• r9498[0...29] BICO BI/CI parameters to de-activated drive objects 

• r9499[0...29] BICO BO/CO parameters to de-activated drive objects 

• r9774.0...31 CO/BO: SI Status (group STO) 
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1.5.7 Topology example: Drives in vector control 

Example 1 
A drive line-up with three Motor Modules in chassis format with identical pulse frequencies or 
three Motor Modules in booksize format in vector control mode. 

The Motor Modules chassis format with identical pulse frequencies or the Motor Modules 
booksize format in vector control mode can be connected to one DRIVE-CLiQ interface on 
the Control Unit. 

In the following diagram, three Motor Modules are connected to the DRIVE-CLiQ socket 
X101. 

 

 Note 

The offline topology automatically generated in the STARTER commissioning tool must be 
manually modified, if this topology was wired.  

 

 
Figure 1-6 Drive line-up (chassis) with identical pulse frequencies 
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Drive line-up comprising four Motor Modules in the chassis format with different pulse frequencies 
It is advantageous to connect Motor Modules with different pulse frequencies to different 
DRIVE-CLiQ sockets of the Control Unit. They may also be connected at the same DRIVE-
CLiQ line. 

In the following diagram, two Motor Modules (400 V, output ≤ 250 kW, pulse frequency 
2 kHz) are connected to interface X101 and two Motor Modules (400 V, output > 250 kW, 
pulse frequency 1.25 kHz) are connected to interface X102. 

 

 Note 

The offline topology automatically generated in the STARTER commissioning tool must be 
manually modified, if this topology was wired.  

 

 
Figure 1-7 Drive line-up in chassis format with different pulse frequencies 
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1.5.8 Topology example: Parallel Motor Modules in vector control 

Drive line-up with two parallel-connected Line Modules and Motor Modules in the chassis format of 
the same type 

Parallel-connected Line Modules in the chassis format and Motor Modules in the chassis 
format of the same type can be connected to a DRIVE-CLiQ socket of the Control Unit. 

In the following diagram, two Active Line Modules and two Motor Modules are connected to 
the X100 or X101 socket. 

You can find additional notes in the chapter "Parallel connection of power units" in the 
SINAMICS S120 Function Manual. 

 

 Note 

The offline topology automatically generated in the STARTER commissioning tool must be 
manually modified, if this topology was wired.  

 

 

 
Figure 1-8 Drive line-up with parallel-connected power units in the chassis format 
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1.5.9 Topology example: Drives in U/f control (vector control) 
The following diagram shows the maximum number of controllable vector V/f drives with 
additional components. The sampling times of individual system components are: 

● Active Line Module: p0115[0] = 250 µs 

● Motor Modules: p0115[0] = 500 µs 

● Terminal Module/Terminal Board p4099 = 2 ms 

 
Figure 1-9 Topology example of a vector drive line-up in U/f control  
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1.5.10 Topology example: Drives in servo control 
The following diagram shows the maximum number of controllable SERVO drives and extra 
components. The sampling times of individual system components are: 

● Active Line Module: p0115[0] = 250 µs 

● Motor Modules: p0115[0] = 125 µs 

● Terminal Module/Terminal Board p4099 = 1 ms 

 
Figure 1-10 Topology example of a SERVO drive line-up  

Legend for topology example: 
ALM = Active Line Module 
SMM = Single Motor Module 
DMM = Double Motor Module 
SMx = Motor encoder 
SMy = Direct measuring system 
TMx = TM31, TM15DI/DO, TB30 
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1.5.11 Topology example: Power Modules 

Blocksize 

 
Figure 1-11 Drive line-ups with Power Modules blocksize 



 Preparation for commissioning 
 1.5 Rules for wiring with DRIVE-CLiQ 

Commissioning Manual 
Commissioning Manual, (IH1), 01/2013, 6SL3097-4AF00-0BP3 51 

Chassis 

 
Figure 1-12 Drive line-up of a Power Module chassis 
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1.6 Powering-up/powering-down the drive system 

Powering up the infeed  

 
Figure 1-13 Powering up the infeed 
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Powering up the drive 

 
Figure 1-14 Powering up the drive 
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Off responses 
● OFF1 

– n_set = 0 is input immediately to brake the drive along the deceleration ramp (p1121). 

– When zero speed is detected, the motor holding brake (if parameterized) is closed 
(p1215). The pulses are suppressed when the brake application time (p1217) expires. 
Zero speed is detected if the actual speed drops below the threshold (p1226) or if the 
monitoring time (p1227) started when the speed setpoint ≤ speed threshold (p1226) 
has expired. 

● OFF2 

– Instantaneous pulse suppression, the drive "coasts" to a standstill. 

– The motor holding brake (if parameterized) is closed immediately. 

– Switching on inhibited is activated. 

● OFF3 

– n_set=0 is input immediately to brake the drive along the OFF3 deceleration ramp 
(p1135). 

– When zero speed is detected, the motor holding brake (if parameterized) is closed. 
The pulses are suppressed when the brake application time (p1217) expires. Zero 
speed is detected if the actual speed drops below the threshold (p1226) or if the 
monitoring time (p1227) started when the speed setpoint ≤ speed threshold (p1226) 
has expired. 

– Switching on inhibited is activated. 

Control and status messages 

Table 1- 13 Power-on/power-off control 

Signal name Internal control word Binector input PROFIdrive/Siemens 
telegram 1 ... 352 

0 = OFF1 STWA.00 
STWAE.00 

p0840 ON/OFF1 STW1.0 

0 = OFF2 STWA.01 
STWAE.01 

p0844 1. OFF2 
p0845 2. OFF2 

STW1.1 

0 = OFF3 STWA.02 p0848 1. OFF3 
p0849 2. OFF3 

STW1.2 

Enable operation STWA.03 
STWAE.03 

p0852 Enable operation STW1.3 

 



 Preparation for commissioning 
 1.6 Powering-up/powering-down the drive system 

Commissioning Manual 
Commissioning Manual, (IH1), 01/2013, 6SL3097-4AF00-0BP3 55 

Table 1- 14 Switch-in/switch-out status signal 

Signal name Internal status word Parameter PROFIdrive/Siemens 
telegram 1 ... 352 

Ready for switching on ZSWA.00  
ZSWAE.00 

r0899.0 ZSW1.0 

Ready for operation ZSWA.01  
ZSWAE.01 

r0899.1 ZSW1.1 

Operation enabled ZSWA.02  
ZSWAE.02 

r0899.2 ZSW1.2 

Pulse inhibit ZSWA.06  
ZSWAE.06 

r0899.6 ZSW1.6 

Pulses enabled ZSWA.11 r0899.11 ZSW2.10 1) 

1) only available in Interface Mode p2038 = 0 

Function diagrams (see SINAMICS S120/S150 List Manual)  
 
• 2610 Sequence control - control unit 

• 2634 Sequence control - missing enable signals, line contactor control, logic operation

• 8732 Basic Infeed - control unit 

• 8832 Smart Infeed - control unit 

• 8932 Active Infeed - control unit 
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Commissioning 2
2.1 Procedure when commissioning 

The following steps are required when commissioning a drive: 

1. Create project with STARTER. 

2. Configure the drive unit in STARTER. 

3. Save the project in STARTER. 

4. Establish online operation with the target device in STARTER. 

5. Load project to target device. 

6. The result: the motor turns. 

 

 Note 
Save motor and encoder data in the non-volatile memory 

If motors with integrated DRIVE-CLiQ interface are used, when the Sensor Module is 
replaced at the motor, all motor and encoder data should be saved in a non-volatile manner 
by setting parameter p4692 = 1. 

 

 

DANGER  
Dangerous voltage after switch-off 

A hazardous voltage will be present in all components for a further five minutes after the 
system has been shutdown.  

Therefore, please note the information on the component!  
 

 Note 
Acceptance test required 

A project with Safety Integrated can be created offline. However, for commissioning an 
acceptance test must be performed, which is only possible online. 

 

 Note 
Updating units only after the project upload 

In the STARTER commissioning tool, after the changeover of the axis type via p9302/p9502 
and subsequent POWER ON, the units that depend on the axis type are only updated after a 
project upload. 
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 Note 

The installation guidelines and safety instructions in the manuals must be carefully taken into 
consideration (see SINAMICS S120 Manual Control Units and 
Supplementary System Components and SINAMICS S120 Manual, Booksize Power Units). 

 

 

WARNING  
Inadvertent acceleration of individual drives  

If several Motor Modules are supplied from a non-regenerative infeed unit (e.g. a Basic Line 
Module), or for power failure or overload (for SLM/ALM), the Vdc_max control may only be 
activated for a Motor Module whose drive should have a high moment of inertia.  
For the other Motor Modules this function must be disabled or monitoring must be set.  
If the Vdc_max control is active for several Motor Modules, then for an unfavorable 
parameterization, the controllers can mutually influence one another negatively. The drives 
can become unstable, individual drives can unintentionally accelerate. 
• Activating the Vdc_max control: 

– Vector control: p1240 = 1 (factory setting) 
– Servo control: p1240 = 1 
– U/f control: p1280 = 1 (factory setting) 

• Inhibiting the Vdc_max control: 
– Vector control: p1240 = 0 
– Servo control: p1240 = 0 (factory setting) 
– U/f control: p1280 = 0 

• Activating the Vdc_max monitoring function 
– Vector control: p1240 = 4 or 6 
– Servo control: p1240 = 4 or 6 
– U/f control: p1280 = 4 or 6 
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2.2 STARTER commissioning tool 
The STARTER commissioning tool is used to parameterize and commission drive units from 
the SINAMICS product family.  

The STARTER commissioning tool can be used for the following: 

● Commissioning 

● Testing (via the control panel) 

● Drive optimization 

● Diagnostics 

● Setting up and activating the safety functions 

System prerequisites 
You can find the system requirements for the STARTER commissioning tool in the "readme" 
file in the STARTER installation directory. 

2.2.1 General information on STARTER 

2.2.1.1 Calling STARTER 

Calling the STARTER application 
1. Click on the STARTER symbol  of your user interface. 

Or 

2. Call the menu command "Start > SIMATIC > STEP 7 > STARTER" in your Windows Start 
menu. 
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2.2.1.2 Description of the user interface 
You can use the STARTER commissioning tool to create the project. The different areas of 
the user interface are used for different configuration tasks (refer to diagram below):  

● Project navigator: this area displays the elements and objects that can be added to your 
project.  

● Working area: in this area you perform the tasks to create the project:  

– When you are configuring the drive, this area contains the Wizards that help you 
configure the drive objects. 

– When you configure, for example, the parameters for the speed setpoint filter. 

– When you call up the expert list, the system displays a list of all the parameters that 
you can view or change. 

● Detail view: This area provides detailed information on faults and alarms, for example.  

 
Figure 2-1 The different areas of the STARTER user interface 
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2.2.2 Important functions in the STARTER commissioning tool 
The STARTER commissioning tool offers the following functions to support the project 
handling:  

● Restoring the factory settings 

● Various operating wizards 

● Configuring and parameterizing drives 

● A virtual control panel to rotate the motors 

● Run trace functions for drive controller optimization 

● Create and copy data records 

● Load the project from the programming device to the target device 

● Copy volatile data from the RAM to a ROM 

● Load the project from the target device to the programming device 

● Create and activate safety functions 

● Activate write protection 

● Activate know-how protection 

The programming device is called "PG/PC" in the subsequent text. The Control Unit of the 
SINAMICS drive system is called the "Target device". 

Restoring the factory settings 
You can use this function to set all the parameters in the working memory of the Control Unit 
to the factory settings. To ensure that the data on the memory card is also reset to the 
factory settings, choose the "Copy from RAM to ROM" function. This function can only be 
activated in the online mode. You activate the function by: 

1. Call the shortcut menu "Drive unit > Target device > Restore factory settings". 

In the following prompt window you can select as to whether you also wish to save the 
factory setting in the ROM. 

2. Click on "OK" to acknowledge. 

Operating support using wizards 
Wizards are integrated in STARTER for various functions to support operation. 
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Create data records (offline) and copy 
Drive and command data sets (DDS and CDS) can be added in the drive's configuration 
screen. Click on the appropriate buttons to do this. Before data sets are copied, all the wiring 
needed for both data sets should be completed. 

For more information about data sets, refer to Chapter "Basics of the drive system" in the 
SINAMICS S120 Function Manual Drive Functions. 

Load project to target device. 
You can use this function to load the actual project from the programming device into the 
Control Unit. A consistency check is first made for the project. If inconsistencies are 
detected, corresponding messages are output. You must resolve the inconsistencies before 
loading. If the data are consistent, then they will be transferred into the work memory of the 
Control Unit. In order to execute this function in the online mode, the following operator 
actions are alternatively available: 

1. Select the drive unit and call the menu "Project > Load to target system". 

or 

2. Select the drive unit and call the shortcut menu "Target device > Load to target device". 

or 

3. Select the drive unit and call the menu "Target system > Load > Load CPU/drive unit to 
target device...". 

or 

4. If the drive unit has a gray background, click on the symbol  "Load CPU/drive unit to 
target device...". 
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Retentively saving data 
You can use this function to save volatile Control Unit data to the non-volatile memory 
(memory card). After backing up, the data are also kept if the 24 V Control Unit supply has 
been switched off. In order to execute this function in the online mode, the following operator 
actions are alternatively available: 

1. Select the drive unit and call the menu "Target system > Copy RAM to ROM". 

or 

2. Select the drive unit and call the shortcut menu "Target device > Copy RAM to ROM". 

or 

3. If the drive unit has a gray background, click on the symbol  "Copy RAM to ROM". 

or  

4. if, after every download into the target device, data is also to be automatically transferred 
into the non-volatile memory, call the menu "Tools > Settings...". 

5. Click the "Download" tab and activate the option "After loading, copy RAM to ROM". Click 
"OK" to confirm this setting. 

Load the project to the PG/PC 
You can use this function to load the current Control Unit project to STARTER. This function 
can only be activated in the online mode. In order to execute this function in the online mode, 
the following operator actions are alternatively available: 

1. Select the drive unit and call the shortcut menu "Target device > Load CPU/drive unit into 
PG/PC...". 

or 

2. Select the drive unit and call the menu "Target system > Load > Load CPU/drive unit to 
PG...". 

or 

3. If the drive unit has a gray background, click on the symbol  "Load CPU/drive unit to 
PG/PC...". 
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Create and activate safety functions 
To set up, activate and operate the Safety Integrated functions, various screen forms are 
available in the STARTER commissioning tool wizards. You can access the Safety 
Integrated Functions online and offline in the project tree. 

1. In the project tree, open the following structure: "Drive unit xy > Drives > Drive xy > 
Functions > Safety Integrated". 

2. Double-click the function entry "Safety Integrated". 

 

 Note 

Additional information about how to use Safety Integrated Functions is provided in the 
SINAMICS S120 Function Manual Safety Integrated. 

 

Activate write protection 
Write protection prevents settings from being inadvertently changed. No password is 
required for write protection. This function can only be activated in the online mode. 

1. Select the required drive unit in the project navigator of your STARTER project. 

2. Call the shortcut menu "Write protection drive unit > Activate". 

Write protection is now activated. In the expert list you can recognize that write protection 
is active by the fact that the entry fields of all adjustable parameters are shown with gray 
shading. 

In order to permanently transfer your setting, after changing write protection, you must 
carry out the "RAM to ROM" data save operation.  

Activate know-how protection 
The "Know-how protection function (KHP)" prevents e.g. strictly confidential company know-
how for configuration and parameter assignment from being read. The know-how protection 
requires a password. The password must comprise at least 1 and a maximum of 30 
characters. 

1. Select the required drive unit in the project navigator of your STARTER project. 
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2. Call the shortcut menu "Know-how protection drive unit > Activate". 

The "Activate know-how protection for drive unit" dialog box opens. 

 
Figure 2-2 Activating know-how protection 

3. If you want to activate the copy protection in addition to know-how protection, then click 
on the "Know-how protection with copy protection" option. 

4. Click on "Assign". 

The "Know-how protection for the drive unit - assign password" dialog box opens.  

 
Figure 2-3 Setting the know-how protection password 

5. In the "New password" field, enter the password (1 to 30 characters) once. Pay attention 
to upper and lower case. 

6. Re-enter your password in the "Confirm password" box and click "OK" to confirm the 
entry. 

The dialog box is closed and the password is shown in encrypted form in the "Activate 
know-how protection for drive unit" dialog box. 

The "Copy RAM to ROM" option is automatically active and ensures that the know-how 
protection is permanently stored in the Control Unit. If you want to only temporarily 
activate know-how protection, you can deactivate this option.  

7. Click "OK" to confirm the settings you made. 

Know-how protection is now activated. The text "Know-how protected" is in all protected 
parameters of the expert list instead of the content. 
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 Note 

A detailed description of the know-how protection functions is provided in the chapter 
"Basics of the drive system" in the SINAMICS S120 Function Manual Drive Functions.  
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2.2.3 Activating online operation: STARTER via PROFIBUS 
The programming device (PG/PC), on which the STARTER commissioning tool is activated, 
is connected to PROFIBUS using a PROFIBUS adapter. 

STARTER via PROFIBUS (example with 2 CU320-2 DP)  

 
Figure 2-4 Connecting the programming device to the target device via PROFIBUS 

Making the STARTER settings for PROFIBUS 
The following settings are required in the STARTER commissioning tool for communication 
via PROFIBUS: 

1. Call the menu "Tools > Set PG/PC interface ...". 

2. If the interface has still not been installed, click on the "Select" button. 

3. In the selection list on the left-hand side, select the module that you want to use as the 
interface. 

4. Click the "Install" button. 

The selected module is then listed in the "Installed" list.  
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5. Click on "Close". 

6. Call the menu "Tools > Set PG/PC interface ..." and click on the "Properties" button. 

7. Activate or deactivate the option "PG/PC is the only master on the bus". 

 

 Note 
PROFIBUS setting 
• Baud rate 

– Connect STARTER to an operational PROFIBUS: 
The STARTER commissioning tool automatically detects the baud rate used by 
SINAMICS for PROFIBUS, and this is then used. 

– Connect STARTER for commissioning:  
The Control Unit automatically detects the baud rate set in the STARTER 
commissioning tool, and this is then used. 

• PROFIBUS addresses: 
The PROFIBUS addresses for the individual drive units must be specified in the project 
and must match the address settings on the devices. 

 

2.2.4 Activating online operation: STARTER via Ethernet 
The Control Unit can be commissioned with the programming device (PG/PC) via the 
integrated Ethernet Interface. This interface is provided for commissioning purposes only 
and cannot be used to control the drive in operation. Routing with a possibly inserted CBE20 
expansion card is not possible. 

Precondition 
● STARTER from version 4.1.5 or higher 

● Control Unit CU320-2 DP from version "C" and higher or CU320-2 PN 

STARTER via Ethernet (example) 

 
Figure 2-5 Connecting the programming device to the target device via Ethernet (example) 
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Install online operation via Ethernet 
1. Install the Ethernet interface in the programming device according to the manufacturer's 

instructions. 

2. Set the IP address of the Ethernet interface in Windows XP: 

– Assign the programming device a free IP address (e.g. 169.254.11.1). 

– In the delivery condition, the IP address of the internal Ethernet interface X127 of the 
Control Unit is 169.254.11.22. 

3. Set the access point of the STARTER commissioning tool. 

4. Using the STARTER commissioning tool, specify a name for the Control Unit interface. 

Setting the IP address in Windows XP  
1. On the desktop, click on the symbol "Network Environment" and click the right mouse 

button to open the "Properties" shortcut menu. 

2. Double-click the appropriate network card and then click "Properties". 

3. Select the Internet Protocol (TCP/IP) and click the "Properties" button. 

4. Then enter IPs for the "IP address" and the "Subnet mask". 

 
Figure 2-6 Setting the IP address from the PG/PC 
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Making settings in the STARTER commissioning tool 
In the STARTER commissioning tool, set the communication via Ethernet as follows (in our 
example, we are using the Ethernet interface "Belkin F5D 5055"): 

1. Call the menu "Tools > Set PG/PC interface ...". 

2. Select the "Access point of the application", and therefore the interface parameter 
assignment (in the example we use the access point "S7ONLINE (STEP 7)" and the 
interface parameterization "TCP/IP(Auto)->Belkin F5D 5055"). 

 
Figure 2-7 Selecting the Ethernet interface at the programming device 

If the desired interface does not yet exist in the selection list, you can create this.  
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3. Click on button "Select". 

 
Figure 2-8 Setting the interface 

4. In the selection list on the left-hand side, select the module that you want to use as the 
interface. 

5. Click the "Install" button. 

The selected module is then listed in the "Installed" list.  

6. Click on "Close". 

You can then check the IP address of the integrated Ethernet interface as follows:  
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7. Select the drive unit and call the shortcut menu "Target device > Online access ...". 

8. Then click on the "Module addresses" tab. 

 
Figure 2-9 Setting the online access 

Assigning the IP address and name  
 

 Note 

When assigning names to IO devices (e.g. a Control Unit) in Ethernet (SINAMICS 
components), then ST conventions (Structured Text) must be complied with. The names 
must be unique within Ethernet. "-" and "." are not permitted in the name of an IO device. 

 

 Note 

The IP address and device name for the Control Unit are stored on the memory card (non-
volatile).  

 



 Commissioning 
 2.2 STARTER commissioning tool 

Commissioning Manual 
Commissioning Manual, (IH1), 01/2013, 6SL3097-4AF00-0BP3 73 

Assigning the IP address using the "Accessible nodes" function 

Use the STARTER commissioning tool to assign an IP address and a name for the Ethernet 
interface. 

1. Connect the Control Unit to the programming device. 

2. Switch on the Control Unit. 

3. Open STARTER. 

4. Load your project or create a new project. 

5. Call the menu "Project > Accessible nodes" or click on the symbol  "Accessible nodes" 
to search for available nodes in the Ethernet. 

The SINAMICS drive unit is identified and displayed as bus participant Drive unit_1 with 
IP address 169.254.11.22. 

6. Select the bus node entry and select the shortcut menu "Edit Ethernet node...". 

7. In the dialog "Edit Ethernet nodes", enter the device name for the Ethernet interface. 

– Click "Assign name". 

– If no entry is in the subnet mask, enter 255.255.0.0 in the subnet mask for the IP 
configuration. 

– Then click the "Assign IP configuration" button. 

– Close the Information window "The parameters were transferred successfully". 

– Click on the "Close" button. 

8. Click on the "View/Refresh (F5)" button to display the IP address and the value 
"NameOfStation" = "The assigned name" in the entry for the bus node. 

  Note 

If these two pieces of information are not be displayed in the entry for the bus node, close 
the "Accessible nodes" dialog and search for nodes that can be accessed again.  

9. If the Ethernet interface is displayed as bus node, select the entry and click on the 
"Accept" button. 

The SINAMICS drive is displayed as new drive object in the project tree. You can now 
configure the new drive unit. 

10. Click on the button "Connect to selected target devices" and call the menu "Target 
system > Load to target device", to load the project to the Control Unit memory card. 

The IP address and device name are stored on the memory card of the Control Unit in a 
non-volatile fashion. 
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Parameterizing the interface in the expert list  

1. Assign the "Name of Station" using parameter p8900 

2. Assign the "IP Address of Station" using parameter p8901 (factory setting 169.254.11.22) 

3. Assign the "Default Gateway of Station" using parameter p8902 (factory setting 0.0.0.0) 

4. Assign the "Subnet Mask of Station" using parameter p8903 (factory setting 255.255.0.0) 

5. Activate the configuration with p8905 = 1 

6. Activate the configuration and save with p8905 = 2 

2.2.5 Activating online operation: STARTER via PROFINET IO 
Online operation with PROFINET IO is implemented using TCP/IP.  

Preconditions 
● STARTER from version 4.1.5 or higher 

● Control Unit CU320-2 PN 

● Communication Board CBE 20 in the Control Unit 

STARTER via PROFINET IO (example) 

 
Figure 2-10 Connecting the programming device to the target device via PROFINET (example) 
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Sequence: Establishing the online mode with PROFINET 
1. Setting the IP address in Windows XP 

Assign the programming device (PG/PC) a fixed, free IP address. In our example, we 
selected 169.254.11.1, based on the factory setting of the integrated Ethernet interface 
X127 (169.254.11.22). Set the subnet mask to 255.255.0.0. 

2. Settings in the STARTER commissioning tool 

3. Select online operation in the STARTER commissioning tool. 

Setting the IP address in Windows XP 
1. On the desktop, click on the symbol "Network Environment" and click the right mouse 

button to open the "Properties" shortcut menu. 

2. Double-click the appropriate network card and then click "Properties". 

3. Select the Internet Protocol (TCP/IP) and click the "Properties" button. 

4. Then enter IPs for the "IP address" and the "Subnet mask". 

 
Figure 2-11 Internet Protocol (TCP/IP) properties 

Setting the interface in the STARTER commissioning tool 
In the STARTER commissioning tool, you set communication via PROFINET as follows:  

1. Call the menu "Tools > Set PG/PC interface ...". 
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2. Select the "Access point of the application", and therefore the interface parameter 
assignment (in the example we use the access point "S7ONLINE (STEP7)" and the 
interface parameterization "TCP/IP(Auto)->Belkin F5D 5055"). 

 
Figure 2-12 Setting the PG/PC Interface 

If the desired interface does not yet exist in the selection list, you can create this.  
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3. Click on button "Select". 

 
Figure 2-13 Setting the interface 

4. In the selection list on the left-hand side, select the module that you want to use as the 
interface. 

5. Click the "Install" button. 

The selected module is then listed in the "Installed" list.  

6. Click on "Close". 
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You can then check the IP address of the integrated Ethernet interface as follows:  

7. Select the drive unit and call the shortcut menu "Target device > Online access ...". 

8. Then click on the "Module addresses" tab. 

The IP address that you set must be located under "Connect to target station". 

 
Figure 2-14 Setting online access 

Assigning an IP address and a name to the drive unit 
With the STARTER commissioning tool, you can assign an IP address and a name to the 
PROFINET interface (e.g. CBE20) of the drive unit. The following steps are required: 

1. Connect the programming device via a Crosslink-Ethernet cable with the CBE20, inserted 
in the CU320-2. 

2. Switch on the Control Unit. 

3. Open the STARTER commissioning tool. 
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4. Call the menu "Project > Accessible nodes" or click on the symbol  "Accessible 
nodes". 

– The search is performed for available nodes connected to PROFINET. 

– The Control Unit is identified and displayed under "Accessible nodes" as the bus node 
with the IP address 0.0.0.0, without any type information. 

 
Figure 2-15 Bus nodes found 

5. Right click on the bus node entry to open the shortcut menu "Edit Ethernet node ...". 

– In the selection window that opens "Edit Ethernet node" you will also see the MAC 
address. 

6. Under "Set IP configuration", enter the IP address that you selected (e.g. 169.254.11.33) 
and the subnet mask (e.g. 255.255.0.0). 

7. Click on the "Set IP Configuration" button. 

– The data transfer is confirmed. 

8. Click on the "Update" button. 

– The bus node is identified as drive unit. 

– The address and the type are specified. 

In the "Edit Ethernet node" selection window you can also assign a device name to the 
drive unit that has been detected. 

9. In the "Device name" field, enter the name that you have selected. 

  Note 

ST (Structured Text) conventions must be satisfied for the name assignment of IO 
devices in PROFINET (SINAMICS components). The names must be unique within 
PROFINET.  
The characters "-" and "." are not permitted in the name of an IO device. 
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10. Then click on the "Assign Name" button. 

– The data transfer is confirmed. 

11. Click on the "Update" button. 

– The bus node is detected as drive unit and is consecutively numbered. 

– The address, device name and the type are specified. 

12. Close the "Edit Ethernet node" window. 

13. Activate the option button in front of the detected drive unit and click the "Accept" button. 

The SINAMICS drive with CBE20 is transferred as a drive object into the project tree. You 
can now continue to configure the drive object. 

14. Click on the button "Connect to target system" and then call the menu "Target system > 
Load > To target device", to load the project to the Control Unit memory card. 

The IP address and device name for the Control Unit are stored on the memory card 
(non-volatile). 



 Commissioning 
 2.3 Creating a project in the STARTER commissioning tool 

Commissioning Manual 
Commissioning Manual, (IH1), 01/2013, 6SL3097-4AF00-0BP3 81 

2.3 Creating a project in the STARTER commissioning tool 

2.3.1 Creating a project offline 

PROFIBUS  
To create a project offline, you need the PROFIBUS address, the device type and the device 
version, e.g. firmware version 4.5 or higher. 

Table 2- 1 Example of a sequence for creating a project in the STARTER commissioning tool 

 What? How? Comment 
1. Create a new project 1. Call the menu "Project > New ...".  

The following default settings are displayed: 
– User projects: Projects already in the target directory 
– Name: Project_1 (can be freely selected) 
– Type: Project 
– Storage location (path): Default (can be set as required) 

2. If necessary, correct "Name" and "Storage location". 

 

The project is created 
offline and loaded to the 
target system when 
configuration is complete. 
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 What? How? Comment 
2. Add individual drive 

 

1. Double-click in the project tree on "Insert single drive unit". 
The following settings are pre-assigned: 
– Device type: CU320-2 DP 
– Device version: 4.5 or higher 
– Address type: PROFIBUS/USS/PPI 
– Bus address: 7 

2. If necessary, correct these settings. 

 

Information about the bus 
address: 
The PROFIBUS address of 
the Control Unit must be 
set for initial 
commissioning. 
Using the rotary coding 
switches on the Control 
Unit, the address can be 
set to a value between 1 
and 126 and read via 
p0918. If the coding 
switches are at "0" (factory 
setting), the value can be 
alternatively set between 1 
and 126 using p0918.  

3. Configure the drive unit Once you have created the project, you have to configure the drive unit. Some examples are 
provided in the following Chapters. 
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PROFINET  
To create a project offline, you need the PROFINET address, the device type and the device 
version, e.g. firmware version 4.5 or higher. 

 
 What? How? Comment 
1 Create a new project 1. Call the menu "Project > New ...".  

The following default settings are displayed: 
– User projects: Projects already in the target directory 
– Name: Project_1 (can be freely selected) 
– Type: Project 
– Storage location (path): Default (can be set as required) 

2. If necessary, correct "Name" and "Storage location". 

 

The project is created 
offline and loaded to the 
target system when 
configuration is complete. 
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 What? How? Comment 
2. Add individual drive 

 

1. Double-click in the project tree on "Insert single drive unit". 
The following settings are pre-assigned: 
– Device type: CU320-2 PN 
– Version: 4.5 or higher 
– Online access: IP 
– Address: 169.254.11.22 

2. If necessary, correct these settings. 

 

Information about the bus 
address: 
The PROFINET address 
of the Control Unit must 
not be set for initial 
commissioning. 
When delivered, the 
TCP/IP address of the 
Control Unit is set to 
169.254.11.22. The 
address can be 
correspondingly changed 
to meet individual 
requirements. 

3 Configure the drive unit Once you have created the project, you have to configure the drive unit. Some examples 
are provided in the following Chapters. 
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2.3.2 Creating a project online 
In order to search online for bus nodes via PROFIBUS or PROFINET, the drive unit must be 
connected with the programming device (PG/PC) via PROFIBUS or PROFINET.  

Table 2- 2 Example of search sequence with the STARTER commissioning tool 

 What? How? 
1. Create a new 

project 
1. Call the menu "Project > New with wizard". 
2. Click on "Find drive units online". 
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 What? How? 
1.1 Enter the project 

data. 
1. Enter the following project data: 

– Project name: Project_1, can be freely selected 
– Author: Any 
– Storage location: Any 
– Comment: Any 

2. If necessary, correct the corresponding project data. 

 
2 Set up the PG/PC 

interface 
The PG/PC interface can be setup in this window. 
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 What? How? 
2.1 Selecting the 

access point 
The target device can be accessed using STARTER or via STEP 7. 
1. For step 2, click on "Access point". 
2. Select the access point for the accessible nodes. 

 
2.2 Selecting the 

PG/PC interface 
In this window, the interface can be selected, set and tested. 
1. For step 2, click on "PG/PC". 
2. Select the "Access point of the application" and therefore also the interface parameter 

assignment.  
If the desired interface does not yet exist in the selection list, you can create additional 
interfaces using the "Select" button. 
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 What? How? 
3. Insert drives The nodes are shown here in the preview.  

Use the button "Refresh view" to update the preview.  

 
4. Summary You have now created the project. 

1. Click on "Finish". 

 
5. Configure the drive 

unit 
Once you have created the project, you have to configure the drive unit. Some examples are 
provided in the following Chapters. 
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2.4 Commissioning the servo control booksize format for the first time 
An example provided in this chapter explains all the configuration and parameter settings, as 
well as tests that are required for initial commissioning. Commissioning is carried out using 
the STARTER commissioning tool.  

Preconditions for commissioning 
● The commissioning preconditions (Page 18) have been met. 

● The commissioning checklists (Page 20) (Tables 1-1 and 1-2) have been completed and 
the points fulfilled. 

● The STARTER commissioning tool is installed and activated. 

– see the "Readme" file on the STARTER installation DVD 

● The drive system has been wired according to the specifications. 

● The communication between the PG/PC and drive system has been prepared. 

● The power supply of the Control Unit (24 V DC) has been switched on. 

2.4.1 Task 
Commissioning a drive unit with the following components: 

Table 2- 3 Component overview 

Designation Component Order number 
Closed-loop control and infeed 
Control Unit 1 Control Unit 320-2 DP 6SL3040-1MA00-0AA1 
Active Line Module Active Line Module 16 kW 6SL3130-7TE21-6AAx 
Line filter Active Interface Module 6SL3100-0BE21-6AB0 
Drive 1 
Single motor module 1 Single Motor Module 9 A 6SL3120-1TE21-0AAx 
Sensor Module 1.0 SMC20 6SL3055-0AA00-5BAx 
Motor 1 Synchronous motor 1FK7061–7AF7x–xxxx 
Motor encoder 1 Incremental encoder sin/cos C/D 

1 Vpp 2048 p/r 
1FK7xxx–xxxxx–xAxx 

Sensor Module 1.1 SMC20 6SL3055-0AA00-5BAx 
External encoder Incremental encoder 

sin/cos 1 Vpp 4096 p/r 
- 

Drive 2 
Single Motor Module 2.0 Single Motor Module 18 A 6SL3120-1TE21-8AAx 
Motor 2 Induction motor 1PH7103–xNGxx–xLxx 
Sensor Module 2 SMC20 6SL3055-0AA00-5BAx 
Motor encoder 2 Incremental encoder sin/cos  

1 Vpp 2048 p/r 
1PH7xxx–xMxxx–xxxx 
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The enable signals for the infeed and the two drives must be transmitted via PROFIBUS. 

● Telegram for the Active Line Module 
 Telegram 370: Infeed, 1 word 

● Telegram for drive 1  
Standard telegram 4: Speed control, 2 position encoders 

● Enable signals for drive 2  
Standard telegram 3: Speed control, 1 position encoder 

 

 Note 

For more information about telegram types, see SINAMICS S120 Function Manual Drive 
Functions or SINAMICS S120/S150 List Manual.  
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2.4.2 Component wiring (example) 
The following diagram shows the structure of the components and the appropriate wiring. 
The DRIVE-CLiQ wiring is highlighted in bold. 

 
Figure 2-16 Component wiring (example) 

Additional information on wiring and connecting the encoder system is provided in the 
Manual. 
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2.4.3 Signal flow of the commissioning example 

 
Figure 2-17 Signal flow of the commissioning example - servo control, Part 1 

 
Figure 2-18 Signal flow of the commissioning example - servo control, Part 2 
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2.4.4 Commissioning with STARTER (example) 
The table below describes the steps for commissioning a drive using the STARTER 
commissioning tool. 

Table 2- 4 Sequence for commissioning with of the STARTER commissioning tool (example) 

 What? How? Comment 
1. Creating a new 

project 
1. Call the menu "Project > New...". 
2. Assign a new name in the "New project" dialog. 
3. Click "OK". 

- 

2. Automatic 
configuration 

1. Call the menu "Project > Connect to selected target devices". 
As there is still no device available in the project, the 
STARTER commissioning tool offers the option of searching 
for accessible nodes. 

2. Click on "Yes". 
3. Activate the drive unit reached by clicking on the check box. 
4. Click on "Apply".  

The drive project is transferred into the project view. 
5. Call the menu again "Project" > "Connect to selected target 

devices".  
You are now connected online with the drive unit. . 

6. Double-click on "Automatic configuration". Click on 
"Configure". 

7. During automatic commissioning, the wizard will offer you the 
option of selecting the drive object type. As default 
assignment, select all of the "SERVO" components. 

8. Click on "Create". 
9. After the automatic configuration has been completed, you 

have the option of going OFFLINE or remaining ONLINE. 
Select "Go OFFLINE". 

- 

3. Configure the 
infeed 

1. Double-click in the project tree on "Infeeds" 
2. Double-click on the infeed that has been created 
3. Click on the yellow button "Wizard..." 
4. To check the automatic settings and to enter additional data, 

such as equipment codes etc. continue with Point 3.2. 
 

- 

Note: 
When the factory setting is p7826 = 1, the firmware is automatically updated to the status on the memory card when a 
configured DRIVE-CLiQ component is first booted. This may take several minutes and is indicated by the READY-LED on 
the corresponding components flashing green/red and the Control Unit flashing orange (0.5 Hz). Once all updates have 
been completed, the READY-LED on the Control Unit flashes orange at 2 Hz and the corresponding READY-LED on the 
components flashes green/red at 2 Hz. For the firmware to be activated, a POWER ON must be carried out for the 
components. 
For infeed units connected to the drive unit, which during the automatic configuration do not communicate with the Control 
Unit via DRIVE-CLiQ, you must manually configure and transfer into the drive topology. These devices can only be 
inserted in the offline mode. 
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 What? How? Comment 
3.1 Inserting an infeed 

unit 
If there is no DRIVE-CLiQ connection to the Control Unit, then 
you must manually enter the data of the infeed unit using the 
wizard. 
1. Double-click in the project tree on "Infeeds". 
2. Double-click on "Insert infeeds". 
3. Enter a name for the infeed unit. 
4. Select the type. 
5. Click "OK". 

If the line environment or 
DC link components are 
changed, line/DC link 
identification should be 
repeated. 

3.2 Infeed 1. Assign a component name. 
2. Select the line voltage range. 
3. Select the cooling type. 
4. Select the baud rate. 
5. The available components are now in the selection list. 
6. Select the required infeed from the list. 
7. Click on "Continue >". 

- 

3.3 Infeed - additional 
data 

1. Activate the line/DC link identification when switching-on for 
the first time. 

2. Accept the device supply voltage from the previous window.  
The rated line frequency is determined automatically. 

3. Make sure that the option "Line filter available" is activated. 
4. For an infeed in the "booksize" format, select a line filter.  

You can select one from several versions. 
5. If applicable, enter the number of parallel infeeds. 
6. Where relevant, select a Voltage Sensing Module. 
7. Where relevant, select an external Braking Module. 
8. Where relevant, select master/slave operation for several 

infeeds. 
9. Click on "Continue >". 

- 

3.4 Process data 
exchange 
(infeed) 

One of three telegrams can be selected for communication: 370, 
371 and 999. 
1. Select the required telegram (e.g. 370). 
2. Click on "Continue >". 

- 

3.6 Configuration, 
summary 

Configuration of the infeed unit has been completed. A summary 
is displayed. 
1. Click on "Complete". 

The infeed unit data can be 
copied to the clipboard for 
plant documentation 
purposes and then added 
to a text program, for 
example. 

Caution 
If the infeed is controlled by a Control Unit other than that used for the Motor Module, then the "Ready" signal for the infeed 
r0863.0 must be interconnected with drive parameter p0864 "Infeed ready" via a digital input/output. If this is not taken into 
account, the infeed may be damaged. 
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 What? How? Comment 
4. Configuration of 

the drives 
You must individually configure the drives in the offline mode. The 
wizard displays the data determined automatically from the 
electronic type plate. 

- 

For drives connected to the drive unit, which during the automatic configuration do not communicate with the Control Unit 
via DRIVE-CLiQ, you must manually configure and transfer into the drive topology. These devices can only be inserted in 
the offline mode. In this case, continue commissioning with step 4.1.  
If the drives have already been created by the automatic configuration, under the drive, click on "Configuration" > 
"Configure DDS... ". Then continue from 4.2. Settings of the power unit data and for motors with DRIVE-CLiQ interface 
also the motor data, are already pre-assigned based on the electronic rating plate/type plate. 
4.1 Inserting drives 1. Double-click in the project tree on "Drives". 

2. Double-click on the entry "Insert drives". 
3. Enter a name for the drive. 
4. For the drive object, select "SERVO". 
5. Click "OK". 

- 

4.2 Control structure 1. Select function modules. 
2. Select the required control mode. 
3. Click on "Continue >". 

- 

4.3 Power unit 1. Enter a name for the component. 
2. Select the DC supply voltage. 
3. Select the cooling type. 
4. Select the type. 

The available components are now in the selection list. 
5. Select the required power unit from the list. 
6. Click on "Continue >". 

- 

4.4 Configuration, 
power unit BICO 
interconnection 

If an infeed without DRIVE-CLiQ connection is used, a message 
is displayed stating that the operating signal must be connected. 
1. In the following dialog "Infeed in operation", set parameter 

p0864 to the binector output of the digital input to which the 
operating feedback signal of the infeed is interconnected. 

2. Click on "Continue >". 

- 

1. Enter a name for the motor (e.g. equipment code). 
2. If your motor has its own DRIVE-CLiQ interface, select the 

item. 
3. Click on "Continue >" and proceed with step 5.2. 
When commissioning, the motor data is automatically transferred 
to the Control Unit. 

5 Configuring the 
motor 

1. If you use a standard motor select the item, "Select standard 
motor from list". 

2. Select the standard motor type from the "Motor type" list. 
3. Then, select your motor. 
4. Click on "Continue >".  

Depending on the particular motor type, motor properties are 
additionally queried; then the continue with Point 5.2. 

You can select a standard 
motor from the list of 
motors or manually enter 
the motor data. You can 
then select the motor type. 
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 What? How? Comment 
1. If your motor is not in the default list, select "Enter motor 

data". 
2. Click on your motor type in the "Motor type" list. 
3. Click on "Continue >". 

1. Enter your motor data according to the data sheet. 

1. Alternatively, after entering the motor data, carry out a motor 
identification when commissioning for the first time. 

5.1 Configuring the 
motor data 

Alternatively, for some motor types you can use motor data from 
the motor list.  
1. To do so, click on the template. 
2. Follow the instructions of the wizard and click on "Continue >".
3. If known, enter the mechanical/electrical data of the motor and 

the drive train or the data of a PE spindle. 
4. For this drive, select whether you require a calculation of the 

motor/controller data. 

If you have no mechanical 
data, then the data are 
estimated based on the 
rating plate data. The 
equivalent circuit diagram 
data is also estimated on 
the basis of the data on the 
rating plate or determined 
by means of automatic 
motor data identification. 

5.2 Configuring a 
motor holding 
brake 

1. If you are not using a motor holding brake, click on "Continue 
>" 
Or 

2. If you are using a motor holding brake, select this in the dialog 
box and then subsequently configure it. 

3. Click on "Continue >". 

Additional information: see 
SINAMICS S120 Function 
Manual Drive Functions. 

You can connect up to 3 encoders.  
1. If you are using DRIVE-CLiQ encoders, select the appropriate 

item. 
2. Click on "Continue >". 
The encoder is automatically identified and configured. 
1. Alternatively, you can use a standard encoder. Select this 

encoder from the list. 
2. Click on "Continue >". 

5.3 Configuring an 
encoder 

Alternatively, you can use your own encoder. 
1. Select "Enter data". 
2. Click on "Encoder data". 
3. Select the measuring system. 
4. Enter the required data and click on "OK". 
5. Click on "Continue >". 

If you are using an encoder 
that is not in the list, you 
can also manually enter 
the data.  
By clicking on details, you 
can view the data of the 
encoder selected from the 
the encoder list. 
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 What? How? Comment 
5.4 Entering encoder 

data 
1. Enter the encoder data into the input screen form and click on 

"OK". 
2. If a standard motor was selected in step 5, continue with step 

5.6. 

Enter additional encoders 
in the same way as 
described above. 

5.5 Drive functions 1. If a standard motor was not selected, select the technological 
application here. 

2. When required, activate the motor identification function. 

Your choice of application 
influences the calculation 
for the open-loop/closed-
loop control parameters.  

5.6 Configuring 
process data 
exchange 

1. For communication, select the PROFIdrive telegram from 
several telegrams. 

- 

5.7 Configuration, 
summary 

The configuration of the drive train has been completed. A 
summary is displayed. 
1. Click on "Complete". 

The drive data can be 
copied to the clipboard for 
plant documentation 
purposes and then added 
to a text program, for 
example. 

5.8 Configuring drive 
functions 

1. In the project tree click on Drives\Drive xy\Configuration. 
2. Click on the "Function modules/technology packages" button. 

Under the "Function modules" tab, you can activate single or 
multiple function modules. 

3. Click "OK". 

- 

5.9 Summary The drive data can be copied to the clipboard for system 
documentation purposes and then pasted into a word processing 
program, for example. 

- 

Note 
The reference parameters and limit values can be protected from being automatically overwritten in the STARTER 
commissioning tool by p0340 = 1: Drive -> Configuration-> "Reference parameters / blocked list" tab. 
6 Enable signals 

and BICO 
interconnections 

The enable signals for the infeed and the two drives must be 
realized via the digital inputs on the Control Unit. 

- 

Line contactor 1. Make the following settings for the line contactor: 
– p0728.8 = 1, sets DI/DO as output 
– p0738 = 0863.1 line contactor on 
– p0860 = 0723.9 line contactor, feedback signal 

The line contactor should 
be controlled from the drive 
object (DO) Infeed_1. 
See function diagram 
[8834] 
In the "Function > Line 
contactor control" screen 
form, you can check that 
the interconnection is 
correct. 

6.1 
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 What? How? Comment 
1. Call the menu "Project" > "Connect to selected target devices" 

(online mode). 
2. Call the menu "Target system > Load > Load CPU/drive unit 

to target device...". 

7. Save the 
parameters on the 
device 

1. Select the drive unit in the project tree. 
2. Call the menu "Target system > Copy RAM to ROM". 

(save the data on the memory card) 

Left-click on the drive unit 
(SINAMICS S120). 

8. The motor starts to 
run. 

The drives can be started via the control panel in the STARTER 
commissioning tool.  
The control panel can be found in the project navigator under 
"Drive unit > Drives > Commissioning > Control panel". 

For more information about 
the control panel, see 
Getting Started. 
The control panel supplies 
the control word 1 (STW1) 
and speed setpoint 1 
(NSOLL). 
For more information about 
line/DC link identification, 
see the SINAMICS S120 
Function Manual Drive 
Functions. 

Diagnostic functions in the STARTER commissioning tool 
Under Component > Diagnostics > Control/status words 

● Control/status words 

● Status parameters 

● Missing enable signals 
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2.5 Commissioning U/f vector control booksize format for the first time 
An example provided in this chapter explains all the configuration and parameter settings, as 
well as tests that are required for initial commissioning. Commissioning is carried out using 
the STARTER commissioning tool.  

Preconditions for commissioning 
● The commissioning preconditions (Page 18) have been met. 

● The commissioning checklists (Page 20) (Tables 1-1 and 1-2) have been completed and 
the points fulfilled. 

● The STARTER commissioning tool is installed and activated. 

– see the "Readme" file on the STARTER installation DVD 

● The drive system has been wired according to the specifications. 

● The communication between the PG/PC and drive system has been prepared. 

● The power supply of the Control Unit (24 V DC) has been switched on. 

2.5.1 Task 
A drive in the "booksize" format with "U/f vector control" control mode with the following 
components is to be commissioned for the first time: 

Table 2- 5 Component overview 

Designation Component Order number 
Closed-loop control and infeed 
Control Unit Control Unit 320-2 DP 6SL3040-1MA00-0AA1 
Smart Line Module Smart Line Module 16 kW 6SL3130-6TE21-6Axx 
Line filter package 16 kW Line filter and line reactor 6SL3100-0BE21-6AB0 
Drive 1 
Motor Module Single Motor Module 9 A 6SL3120-1TE21-0Axx 
Motor Induction motor 1PH8083-1xF2x-xxxx 
Drive 2 
Motor Module Single Motor Module 9 A 6SL3120-1TE21-0Axx 
Motor Induction motor 1PH8083-1xF2x-xxxx 

The enable signals for the infeed and the drive should be realized via terminals. 
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2.5.2 Component wiring (example) 
The following diagram shows the structure of the components and the appropriate wiring. 
The DRIVE-CLiQ wiring is highlighted in bold. 

 
Figure 2-19 Component wiring (example) 

For more information on wiring and connecting the encoder system, see the Equipment 
Manual. 
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2.5.3 Signal flow of the commissioning example 

 
Figure 2-20 Signal flow diagram of the example vector U/f control mode in the booksize format 
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2.5.4 Commissioning with STARTER (example) 
The table below describes the steps for commissioning the example using the STARTER 
commissioning tool. 

Table 2- 6 Commissioning sequence (example) 

 What? How? Comment 
1. Creating a new 

project 
1. Call the menu "Project > New...". 
2. Assign a new name in the "New project" dialog. 
3. Click "OK". 

- 

2. Automatic 
configuration 

1. Call the menu "Project > Connect to selected target devices".
As there is still no device available in the project, STARTER 
offers the option of searching for accessible nodes. 

2. Click on "Yes". 
3. Activate the drive unit reached by clicking on the check box. 
4. Click on "Apply".  

The drive unit is transferred into the project window. 
5. Call the menu again "Project" > "Connect to selected target 

devices". 
You are now connected online with the drive unit. 

6. Double-click on "Automatic configuration". Click on 
"Configure". 

7. During automatic commissioning, the wizard will offer you the 
option of selecting the drive object type. As default 
assignment, select all of the "Vector" components. 

8. Click on "Create". 
9. After the automatic configuration has been completed, you 

have the option of going OFFLINE or remaining ONLINE. 
Select "Go OFFLINE". 

- 
 

3.  Configure the 
infeed 

1. Double-click in the project tree on "Infeeds". 
2. Double-click on the infeed that has been created. 
3. Click on the yellow button "Wizard...". 
4. To check the automatic settings and to enter additional data, 

such as equipment codes etc. continue with Point 3.2. 

- 

Note: 
When the factory setting is p7826 = 1, the firmware is automatically updated to the status on the memory card when a 
configured DRIVE-CLiQ component is first booted. This may take several minutes and is indicated by the READY-LED on 
the corresponding components flashing green/red and the Control Unit flashing orange (0.5 Hz). Once all updates have 
been completed, the READY-LED on the Control Unit flashes orange at 2 Hz and the corresponding READY-LED on the 
components flashes green/red at 2 Hz. For the firmware to be activated, a POWER ON must be carried out for the 
components. 
For infeed units connected to the drive unit, which during the automatic configuration do not communicate with the Control 
Unit via DRIVE-CLiQ, you must manually configure and transfer into the drive topology. These devices can only be 
inserted in the offline mode.  
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 What? How? Comment 
3.1 Inserting an infeed 

unit 
If there is no DRIVE-CLiQ connection to the Control Unit, then 
you must manually enter the data of the infeed unit using the 
wizard. 
1. Double-click in the project tree on "Infeeds". 
2. Double-click on "Insert infeed". 
3. Enter a name for the infeed unit. 
4. Select the type. 
5. Click "OK". 

If the line environment or 
DC link components are 
changed, line/DC link 
identification should be 
repeated. 

3.2 Infeed 1. Assign a component name. 
2. Select the line voltage range. 
3. Select the cooling type. 
4. Select the type. 

The available components are now in the selection list. 
5. Select the required infeed from the list. 
6. Click on "Continue >". 

- 

3.3 Infeed - additional 
data 

1. Activate the line/DC link identification when switching-on for 
the first time. 

2. Accept the device supply voltage from the previous window.  
The rated line frequency is determined automatically. 

3. If applicable, enter the number of parallel infeeds. 
4. Where relevant, select a Voltage Sensing Module. 
5. Where relevant, select an external Braking Module. 
6. Click on "Continue >". 

- 

3.4 Process data 
exchange 
(infeed) 

One of three telegrams can be selected for communication: 370, 
371 and 999. 
1. Select the required telegram. 
2. Click on "Continue >". 

- 

3.5 Configuration, 
summary 

Configuration of the infeed unit completed. A summary is 
displayed. 
1. Click on "Complete". 

The infeed unit data can be 
copied to the clipboard for 
plant documentation 
purposes and then added 
to a text program, for 
example. 

Notice 
If the infeed is controlled from another Control Unit, then the ready signal of the infeed must be connected to parameter 
p0864 "infeed ready" of the drive through a digital input/output. If this is not taken into account, the infeed may be 
damaged. 
4. Configuration of 

the drives 
You must individually configure the drives in the offline mode. 
The wizard displays the data determined automatically from the 
electronic type plate. 

- 
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 What? How? Comment 
For drives connected to the drive unit, which during the automatic configuration do not communicate with the Control Unit 
via DRIVE-CLiQ, you must manually configure and transfer into the drive topology. These devices can only be inserted in 
the offline mode. In this case, continue commissioning with step 4.1.  
If the drives have already been created by the automatic configuration, under the drive, click on "Configuration" > 
"Configure DDS... ". Then continue from 4.2. Settings of the power unit data and for motors with DRIVE-CLiQ interface 
also the motor data, are already pre-assigned based on the electronic rating plate/type plate. 
4.1 Inserting drives 1. Double-click in the project tree on "Drives". 

2. Double-click on the entry "Insert drives". 
3. Enter a name for the drive. 
4. For the drive object, select "VECTOR". 
5. Click "OK". 

- 

4.2 Control structure 1. Select function modules. 
2. Switch the closed-control to "U/f control". 
3. Select the required control mode. 
4. Click on "Continue >". 

- 

4.3 Power unit 1. Enter a name for the component. 
2. Select the DC supply voltage. 
3. Select the cooling type. 
4. Select the type. 

The available components are now in the selection list. 
5. Select the required power unit. 
6. Click on "Continue >". 

- 

4.4 Configuration, 
power unit BICO 
interconnection 

If an infeed without DRIVE-CLiQ connection is used, a message 
is displayed stating that the operating signal must be connected. 
1. In the following dialog "Infeed in operation", set parameter 

p0864 to the binector output of the digital input to which the 
operating feedback signal of the infeed is interconnected. 

2. Click on "Continue >". 

- 

4.5 Configuring 
additional data 

In this window, you can additionally select the following  
• Various output filters 
• A Voltage Sensing Module 
• A parallel connection 

With this dialog window, 
the configuration of the 
Motor Module has been 
completed. 

Notice 
If a sine-wave filter is connected, then it must be activated here as otherwise it could be destroyed! 
5 Drive setting You can select the motor standard (IEC/NEMA) and power unit 

application (duty cycles). 
- 
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1. Enter a name for the motor (e.g. equipment code). 
2. If your motor has its own DRIVE-CLiQ interface, select the 

item. 
3. Click on "Continue >". 
When commissioning, the motor data is automatically transferred 
to the Control Unit. 
1. If you use a standard motor select the item, "Select standard 

motor from list". 
2. Select the standard motor type from the "Motor type" list. 
3. Then, select your motor. 
4. Click on "Continue >". 

5.1 Configuring the 
motor 

1. If your motor is not in the default list, select "Enter motor 
data". 

2. Click on your motor type in the "Motor type" list. 
3. Click on "Continue >". 

You can select a standard 
motor from the list of 
motors or manually enter 
the motor data. You can 
then select the motor type. 

1. Enter your motor data according to the data sheet. 

1. Alternatively, after entering the motor data, carry out a motor 
identification when commissioning for the first time. 

5.2 Configuring the 
motor data 

Alternatively, for some motor types you can use motor data from 
the motor list. 
1. To do so, click on the template. 
2. Follow the wizard by clicking on "Next >". 
3. If known, you can enter the mechanical/electrical data of the 

motor and the drive train or the data of a PE spindle. 
4. If necessary, select a complete calculation of the 

motor/controller data without equivalent circuit diagram data. 
5. For this example, select the simple drive. 

If you have no mechanical 
data, then the data are 
estimated based on the 
rating plate data. The 
equivalent circuit diagram 
data is also estimated on 
the basis of the data on the 
rating plate or determined 
by means of automatic 
motor data identification. 

5.3 Configuring a 
motor holding 
brake 

1. If you are not using a motor holding brake, click on "Continue 
>". 
Or 

2. If you are using a motor holding brake, you can select and 
configure the brake in this window. 

3. Click on "Continue >". 

For additional information, 
see SINAMICS S120 
Function Manual Drive 
Functions. 

You can connect up to 3 encoders.  
1. If you are using a DRIVE-CLiQ encoder, then select the 

appropriate item. 
2. Click on "Next >". 

The encoder is automatically identified and configured. 

5.4 Configuring an 
encoder 

1. Alternatively, you can use a standard encoder.  
Select the encoder from the list. 

2. Click on "Continue >". 

When using an encoder 
that is not in the list, after 
point 4.8, you can also 
enter the data manually.  
By clicking on details, you 
can view the data of the 
encoder selected from the 
the encoder list. 
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Alternatively, you can use your own encoder. 
1. Select enter data. 
2. Click on encoder data. 
3. Select the measuring system. 
4. Enter the required data and click on "OK". 
5. Click on "Continue >". 

5.5 Entering encoder 
data 

1. Enter the encoder data into the input screen form and click on 
"OK". 

Enter additional encoders 
in the same way as 
described above. 

5.6 Configuring drive 
functions 

You can select certain technological applications and the type of 
motor identification.  

Your choice of application 
influences the calculation 
for the open-loop/closed-
loop control parameters. 

5.7 Configuring 
process data 
exchange 

1. For communication, select the PROFIdrive telegram from 
several telegrams. 

- 

5.8 Important 
parameters 

In this window, you can specify important parameters as limit 
values.  
When doing this, observe the general mechanical conditions for 
the drive train. 

- 

5.9 Configuration, 
summary 

The configuration of the drive train has been completed. A 
summary is displayed. 
1. Click on "Complete". 

The drive data can be 
copied to the clipboard for 
system documentation 
purposes and then added 
to a text program, for 
example. 

Note 
The reference parameters and limit values can be protected from being automatically overwritten in the STARTER 
commissioning tool by setting p0340 = 1. In the STARTER commissioning tool, you will find this under Drive > 
Configuration > Blocked list tab. 
6. Enable signals and 

BICO 
interconnections 

The enable signals for the infeed and the two drives must be 
realized via the digital inputs on the Control Unit. 
1. In the project tree, click on "Drive unit \ Control Unit \ 

Inputs/outputs". 
2. Select "Bidirectional digital inputs/outputs". 

- 

6.1 Line contactor 1. Make the following settings for the line contactor: 
– p0728.8 = 1, sets DI/DO as output 
– p0738 = 0863.1 control (energize) line contactor 
– p0860 = 0723.9 line contactor, feedback signal 

The line contactor must be 
controlled by the infeed_1 
drive object (DO). 
See function diagram 
[8834] 
In the "Function > Line 
contactor control" screen 
form, you can check that 
the interconnection is 
correct. 
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Enable Motor 
Module 

• Enable signals for the Motor Module (drive_1) 

p0840 = 722.0 ON/OFF1 

p0844 = 722.1 1. OFF2 

p0845 = 1 2. OFF2 

p0848 = 722.2 1. OFF3 

p0849 = 1 2. OFF3 

p0852 = 722.3 Enable operation 

See function diagram 
[2501] 

6.2 

 
 

Ramp-function 
generator 

• Ramp-function generator 

p1140 = 1 Ramp-function generator enable 

p1141 = 1 Ramp-function generator start 

p1142 = 1 Enable setpoint 

See function diagram 
[3060] 

6.3 

 

 

6.4 Setpoint • Specify setpoint 

p1001 = 40 Fixed setpoint 1 

See function diagram 
[3010] 
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7 Save the 
parameters on the 
device 

1. Select the drive unit in the project tree. 
2. Call the "Connect target device" shortcut menu. 
3. Call the "Target device > Load to target device" shortcut 

menu.  
The option "After loading, copy RAM to ROM" is active.  
Click on "Yes" to confirm backup.  
or 

4. Call the shortcut menu "Target device > Copy RAM to ROM". 

Position cursor on drive 
unit (SINAMICS S120) and 
right-click. 

8 The motor starts to 
run. 

The drives can be started via the control panel in the STARTER 
commissioning tool. 
• Line/DC link identification will be carried out once  

the pulses for the infeed have been enabled and line/DC link 
identification has been activated. The infeed then switches 
into the "Operation" state. 

• Once the pulses are enabled, a one-off motor data 
identification run (if activated) is carried out. 

• When the pulses are enabled again, optimization with a 
rotating motor is carried out, if this is activated. 

For more information about 
the control panel, see 
Getting Started. 
During motor data 
identification, a current 
flows through the motor, 
which means that it can 
align itself by up to a 
quarter of a revolution. 
For more information about 
line/DC link/motor data 
identification, see the 
SINAMICS S120 Function 
Manual Drive Functions. 

Diagnostic functions in the STARTER commissioning tool 
Under Component > Diagnostics > Control/status words 

● Control/status words 

● Status parameters 

● Missing enable signals 
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2.6 Commissioning the vector control chassis format for the first time 
An example provided in this chapter explains all the configuration and parameter settings, as 
well as tests that are required for initial commissioning. Commissioning is carried out using 
the STARTER commissioning tool.  

Preconditions for commissioning 
● The commissioning preconditions (Page 18) have been met. 

● The commissioning checklists (Page 20) (Tables 1-1 and 1-2) have been completed and 
the points fulfilled. 

● The STARTER commissioning tool is installed and activated. 

– see the "Readme" file on the STARTER installation DVD 

● The drive system has been wired according to the specifications. 

● The communication between the PG/PC and drive system has been prepared. 

● The power supply of the Control Unit (24 V DC) has been switched on. 

2.6.1 Task 
A drive in the "chassis" format in vector control with the following components is to be 
commissioned for the first time: 

Table 2- 7 Component overview 

Designation Component Order number 
Closed-loop control and infeed 
Control Unit Control Unit 320-2 PN 6SL3040-1MA01-0AA1 
Active Line Module Active Line Module 380 kW / 

400 V 
6SL3330–7TE36–1AAx 

Active Interface Module Active Interface Module 6SL3300–7TE38–4Ax0 
Drive 1 
Motor Module Motor Module 380 A 6SL3320–1TE33–8AAx 
Motor Induction motor 

• Without brake 
• With encoder 

Type: 1PL6226-xxFxx-xxxx 
Rated voltage = 400 V 
Rated current = 350 A 
Rated power = 200 kW 
Rated frequency = 59.10 Hz 
Rated speed = 1750 rpm 
Cooling type = non-ventilated 
HTL encoder, 1024 p/r, A/B, R 
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Designation Component Order number 
Drive 2 
Motor Module Motor Module 380 A 6SL3320–1TE33–8AAx 
Motor Induction motor 

• Without brake 
• With encoder 

Type: 1PL6226-xxFxx-xxxx 
Rated voltage = 400 V 
Rated current = 350 A 
Rated power = 200 kW 
Rated frequency = 59.10 Hz 
Rated speed = 1750 rpm 
Cooling type = non-ventilated 
HTL encoder, 1024 p/r, A/B, R 

The enable signals for the infeed and the drive should be realized via terminals. 
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2.6.2 Component wiring (example) 
The following diagram shows the structure of the components and the appropriate wiring. 
The DRIVE-CLiQ wiring is highlighted in bold.  

 
Figure 2-21 Component wiring (example) 

1) X500 at the Voltage Sensing Module 

For more information on wiring and connecting the encoder system, see the Equipment 
Manual. 
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2.6.3 Signal flow of the commissioning example 

 
Figure 2-22 Signal flow of the commissioning example chassis 
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2.6.4 Commissioning with STARTER (example) 
The table below describes the steps for commissioning a drive using the STARTER 
commissioning tool. 

Table 2- 8 Commissioning sequence (example) 

 What? How? Comment 
1. Creating a new 

project 
1. Call the menu "Project > New...". 
2. Assign a new name in the "New project" dialog. 
3. Click "OK". 

- 

2. Automatic 
configuration 

1. Call the menu "Project > Connect to selected target devices". 
As there is still no device available in the project, STARTER 
offers the option of searching for accessible nodes. 

2. Click on "Yes". 
3. Activate the drive unit reached by clicking on the check box. 
4. Click on "Apply".  

The drive unit is transferred into the project window. 
5. Call the menu again "Project" > "Connect to selected target 

devices". 
You are now connected online with the drive unit. 

6. Double-click on "Automatic configuration". Click on 
"Configure". 

7. During automatic commissioning, the wizard will offer you the 
option of selecting the drive object type. As default 
assignment, select all of the "Vector" components. 

8. Click on "Create". 
9. After the automatic configuration has been completed, you 

have the option of going OFFLINE or remaining ONLINE. 
Select "Go OFFLINE". 

- 

3.  Configure the 
infeed 

1. Double-click in the project tree on "Infeeds". 
2. Double-click on the infeed that has been created. 
3. Click on the yellow button "Wizard...". 
4. To check the automatic settings and to enter additional data, 

such as equipment codes etc. continue with Point 3.2. 

- 

Note: 
When the factory setting is p7826 = 1, the firmware is automatically updated to the status on the memory card when a 
configured DRIVE-CLiQ component is first booted. This may take a few minutes and is indicated by the READY-LED on 
the corresponding components flashing green/red and the LED on the Control Unit flashing orange (0.5 Hz). Once all 
updates have been completed, the READY-LED on the Control Unit flashes orange at 2 Hz and the corresponding 
READY-LED on the components flashes green/red at 2 Hz. For the firmware to be activated, a POWER ON must be 
carried out for the components.  
For infeed units connected to the drive unit, which during the automatic configuration do not communicate with the Control 
Unit via DRIVE-CLiQ, you must manually configure and transfer into the drive topology. These devices can only be 
inserted in the offline mode. 
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3.1 Inserting an infeed 

unit 
If there is no DRIVE-CLiQ connection to the Control Unit, then 
you must manually enter the data of the infeed unit using the 
wizard. 
1. Double-click in the project tree on "Infeeds". 
2. Double-click on "Insert infeed". 
3. Enter a name for the infeed unit. 
4. Select the type. 
5. Click "OK". 

If the line environment or 
DC link components are 
changed, line/DC link 
identification should be 
repeated. 

3.2 Infeed 1. Assign a component name. 
2. Select the line voltage range. 
3. Select the cooling type. 
4. Select the type. 

The available components are now in the selection list. 
5. Select the required infeed from the list. 
6. Click on "Continue >". 

- 

3.3 Infeed - additional 
data 

1. Activate the line/DC link identification when switching-on for 
the first time. 

2. Accept the device supply voltage from the previous window. 
The rated line frequency is determined automatically. 

3. Make sure that the option "Line filter available" is activated. 
4. If applicable, enter the number of parallel infeeds. 
5. Where relevant, select an external Braking Module. 
6. Where relevant, select master/slave operation for several 

infeeds. 
7. Click on "Continue >". 

- 

3.4 Process data 
exchange 
(infeed) 

One of three telegrams can be selected for communication: 370, 
371 and 999. 
1. Select the required telegram. 
2. Click on "Continue >". 

- 

3.5 Configuration, 
summary 

Configuration of the infeed unit completed. A summary is 
displayed. 
1. Click on "Complete". 

The infeed unit data can be 
copied to the clipboard for 
plant documentation 
purposes and then added 
to a text program, for 
example. 

Caution 
If the infeed is controlled by a Control Unit other than that used for the Motor Module, then the "Ready" signal for the infeed 
r0863.0 must be connected with drive parameter p0864 "Infeed ready" via a digital input/output. If this is not taken into 
account, the infeed may be damaged. 
4. Configuration of 

the drives 
You must individually configure the drives in the offline mode. 
The wizard displays the data determined automatically from the 
electronic type plate. 

- 
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For drives connected to the drive unit, which during the automatic configuration do not communicate with the Control Unit 
via DRIVE-CLiQ, you must manually configure and transfer into the drive topology. These devices can only be inserted in 
the offline mode. In this case, continue commissioning with step 4.1.  
If the drives have already been created by the automatic configuration, under the drive, click on "Configuration" > 
"Configure DDS... ". Then continue from 4.2. Settings of the power unit data and for motors with DRIVE-CLiQ interface 
also the motor data, are already pre-assigned based on the electronic rating plate/type plate. 
4.1 Inserting drives 1. Double-click in the project tree on "Drives". 

2. Double-click on the entry "Insert drives". 
3. Enter a name for the drive. 
4. Select "Vector" as drive object type. 
5. Click "OK". 

- 

4.2 Control structure 1. Where relevant, select function modules. 
2. Select the control "n-/M control + U/f control, I/f control". 
3. Select the control mode "[21] speed control (with encoder)". 
4. Click on "Continue >". 

- 

4.3 Power unit 1. Enter a name for the component. 
2. Select the DC supply voltage. 
3. Select the cooling type. 
4. Select the baud rate. 
5. Select the required power unit from the list. 
6. Click on "Continue >". 

- 

4.4 Configuration, 
power unit BICO 
interconnection 

If an infeed without DRIVE-CLiQ connection is used, a message 
is displayed stating that the operating signal must be connected. 
1. In the following dialog "Infeed in operation", set parameter 

p0864 to the binector output of the digital input to which the 
operating feedback signal of the infeed is interconnected. 

2. Click on "Continue >". 

- 

4.5 Additional power 
unit data 

In this window, you can additionally select the following  
• Various output filters 
• A Voltage Sensing Module 
• A parallel connection 

With this dialog window, 
the configuration of the 
Motor Module has been 
completed. 

Caution 
If a sine-wave filter is connected, then you must activate it here as otherwise it could be destroyed!  
5 Configuration, 

drive setting 
You can select the motor standard (IEC/NEMA) and power unit 
application (duty cycles). 

The motor data are 
selected and entered. 
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1. Enter a name for the motor (e.g. equipment code). 
2. If your motor has its own DRIVE-CLiQ interface, select the 

item. 
3. Click on "Continue >".  

When commissioning, the motor data is automatically 
transferred to the Control Unit. 

1. If you use a standard motor select the item, "Select standard 
motor from list". 

2. Select the standard motor type from the "Motor type" list. 
3. Then, select your motor. 
4. Click on "Continue >". 

5.1 Configuring the 
motor 

1. If your motor is not in the default list, select "Enter motor 
data". 

2. Click on your motor type in the "Motor type" list. 
3. Click on "Continue >". 

You can select a standard 
motor from the list of 
motors or manually enter 
the motor data. You can 
then select the motor type. 

1. Enter your motor data according to the data sheet. 

1. Alternatively, after entering the motor data, carry out a motor 
identification when commissioning for the first time. 

5.2 Configuring the 
motor data 

Alternatively, for some motor types you can use motor data from 
the motor list. 
1. To do so, click on the template. 
2. Follow the wizard by clicking on "Next >". 
3. If known, you can enter the mechanical data of the motor and 

the drive train or the data of a PE spindle. 
4. If necessary, select a complete calculation of the 

motor/controller data without equivalent circuit diagram data. 
5. For this example, select the simple drive. 

If you have no mechanical 
data, then the data are 
estimated based on the 
rating plate data. The 
equivalent circuit diagram 
data is also estimated on 
the basis of the data on the 
rating plate or determined 
by means of automatic 
motor data identification. 

5.3 Configuring a 
motor brake 

1. If you are not using a motor holding brake, click on "Continue 
>". 

2. If you are using a motor holding brake, you can select and 
configure the brake in this window. 

3. Click on "Continue >". 

For more information, see 
SINAMICS S120 Function 
Manual Drive Functions. 

You can connect up to 3 encoders.  
1. If you are using a DRIVE-CLiQ encoder, then select the 

appropriate item. 
2. Click on "Next >". 

The encoder is automatically identified and configured. 

5.4 Configuring an 
encoder 

1. Alternatively, you can use a standard encoder.  
Select the encoder from the list. 

2. Click on "Continue >". 

If you are using an encoder 
that is not in the list, you 
can also manually enter the 
data.  
By clicking on details, you 
can view the data of the 
encoder selected from the 
the encoder list. 
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Alternatively, you can use your own encoder. 
1. Select enter data. 
2. Click on encoder data. 
3. Select the measuring system. 
4. Enter the required data and click on "OK". 
5. Click on "Continue >". 

5.5 Entering encoder 
data 

1. Enter the encoder data into the input screen form. 
2. Click "OK". 

Enter additional encoders 
in the same way as 
described above. 

5.6 Configuring drive 
functions 

You can select certain technological applications and the type of 
motor identification.  

Your choice of application 
influences the calculation 
for the open-loop/closed-
loop control parameters. 

5.7 Configuring 
process data 
exchange 

For communication, you can select the PROFIdrive telegram 
from various telegrams. 
1. For the example, select "[ 999] Free telegram configuration 

with BICO". 
2. Click on "Continue >". 

- 

5.8 Important 
parameters 

In this window, you can specify important parameters as limit 
values.  
When doing this, observe the general mechanical conditions for 
the drive train. 

- 

5.9 Summary The configuration of the drive train has been completed. A 
summary is displayed. 
1. Click on "Complete". 

The drive data can be 
copied to the clipboard for 
plant documentation 
purposes and then added 
to a text program, for 
example. 

Note 
The reference parameters and limit values can be protected from being automatically overwritten in the STARTER 
commissioning tool by setting p0340 = 1. You can find this function in the STARTER commissioning tool under Drive > 
Configuration > Blocked list tab. 
6. Enable signals and 

BICO 
interconnections 

The enable signals for the infeed and the two drives must be 
realized via the digital inputs on the Control Unit. 

Note: 
If an Active Line Module is 
used, to enable the infeed 
unit, a signal source other 
that that used for the Motor 
Module must be used. 

6.1 Active Line Module • Enable signals for the Active Line Module: 

p0840 = 722.4 ON/OFF1 

p0844 = 722.5 OFF2 

p0852 = 722.6 Enable operation 

See function diagram 
[8920] 
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Enable Motor 
Module 

• Enable signals for the Motor Module (drive_1): 

p0840 = 722.0 ON/OFF1 

p0844 = 722.1 1. OFF2 

p0845 = 1 2. OFF2 

p0848 = 722.2 1. OFF3 

p0849 = 1 2. OFF3 

p0852 = 722.3 Enable operation 

p0864 = 863.0 Infeed operation 

See function diagram 
[2501] 

6.2 

 
 

Ramp-function 
generator 
configuration 

• Ramp-function generator 

p1140 = 1 Ramp-function generator enable 

p1141 = 1 Ramp-function generator start 

p1142 = 1 Enable setpoint 

See function diagram 
[3060] 

6.3 
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Setpoint 
configuration 

• Specify setpoint: 

p1001 = 0 Fixed setpoint 1 

p1002 = 40 Fixed setpoint 2 

p1020 = r0722 Fixed speed setpoint selection 

r1024 = p1070 Fixed setpoint active 

A setpoint of 0 (0 signal) or 
40 (1 signal) is defaulted 
via digital input 7. This 
setpoint is then applied to 
the main setpoint p1070. 
See function diagram 
[3010] 

6.4 

 
7. Load parameters 

to device 
1. Select the drive unit in the project tree. 
2. Call the "Connect target device" shortcut menu. 
3. Then call "Target device" > "Load to target device" shortcut 

menu. 

Position cursor on drive 
unit and right-click. 

8. Configuration, 
motor temperature 

For the setting, p0340 must be 0. If p0340 >< 0, then the 
temperature sensor selection is locked.  
1. Make the following settings: 

– the way in which the motor temperature is received 
– the temperature sensor type 
– for overtemperature, the response to alarm and fault (no 

reduction of Imax). 
– the alarm message when a sensor fails 
– the delay time to 0.100 s 
– the warning threshold to 120.0 C  
– the fault threshold to 155.0 °C 
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9. Save the 

parameters on the 
device 

1. Select the drive unit in the project tree. 
2. Call the "Connect target device" shortcut menu. 
3. Call the "Target device > Load to target device" shortcut 

menu.  
The option "After loading, copy RAM to ROM" is active.  
Click on "Yes" to confirm backup.  
or 

4. Call the shortcut menu "Target device > Copy RAM to ROM". 

Position cursor on drive 
unit (SINAMICS S120) and 
right-click. 

10 The motor starts to 
run. 

The drives can be started via the control panel in the STARTER 
commissioning tool.  
• Line/DC link identification will be carried out once the pulses 

for the infeed have been enabled and line/DC link 
identification has been activated. The infeed then switches 
into the "Operation" state. 

• When the pulses are enabled, a one-off motor data 
identification run (if activated) is carried out. 

• When the pulses are enabled again, optimization with a 
rotating motor (if activated) is carried out. 

For more information about 
the control panel, see 
Getting Started. 
During motor data 
identification, a current 
flows through the motor, 
which means that it can 
align itself by up to a 
quarter of a revolution. 
For more information about 
line/DC link/motor data 
identification, see the 
SINAMICS S120 Function 
Manual Drive Functions. 
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Important diagnostic parameters (see the SINAMICS S120/S150 List Manual) 
 
• r0002 Infeed/drive operating display 

• r0046 Missing enable signals, for more information, see Chapter, 
"Diagnostics" 
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2.7 First commissioning vector control AC drive blocksize format 
An example provided in this chapter explains all the configuration and parameter settings, as 
well as tests that are required for initial commissioning. Commissioning is carried out using 
the STARTER commissioning tool.  

Preconditions for commissioning 
● The commissioning preconditions (Page 18) have been met. 

● The commissioning checklists (Page 20) (Tables 1-1 and 1-2) have been completed and 
the points fulfilled. 

● The STARTER commissioning tool is installed and activated. 

– see the "Readme" file on the STARTER installation DVD 

● The drive system has been wired according to the specifications. 

● The communication between the PG/PC and drive system has been prepared. 

● The power supply of the Control Unit (24 V DC) has been switched on. 

2.7.1 Task 
A drive unit is to be commissioned (vector control, closed-loop speed control), without 
DRIVE-CLiQ and without speed encoder with the following components: 

 
Designation Component Order number 
Closed-loop control 
Control Unit Control Unit 310-2 DP 6SL3040-1LA00-0AA0 
Operator Panel Basic Operator Panel BOP20 6SL3055-0AA00-4BAx 
Infeed and drive 
Power Module Power Module 340 6SL3210-1SB14-xxxx 
Motor Induction motor  

(without DRIVE-CLiQ interface) 
1LA7 

Commissioning is performed using the BOP20. 

The function keys on the BOP20 must be parameterized so that the ON/OFF signal and 
speed settings can be defined via these keys. 
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2.7.2 Component wiring (example) 
The following diagram shows the structure of the components and the appropriate wiring. 

 
Figure 2-23 Component wiring (example) 

For more information on wiring, see the Equipment Manual. 

2.7.3 Quick commissioning using the BOP (example) 
 

WARNING  
Danger due to hazardous axis movements 

During motor data identification, the drive may cause the motor to move.  

The EMERGENCY OFF functions must be fully operational during commissioning. To 
protect the machines and personnel, the relevant safety regulations must be observed. 

 

 



Commissioning  
2.7 First commissioning vector control AC drive blocksize format 

 Commissioning Manual 
124 Commissioning Manual, (IH1), 01/2013, 6SL3097-4AF00-0BP3 

Table 2- 9 Quick commissioning for a VECTOR drive without a DRIVE-CLiQ interface 

 Procedure Description Factory 
setting 

Restore the drive to the factory setting: 
Device commissioning parameter filter * 

0 Ready 
1 Device configuration 

1. p0009 = 30 

30 Parameter reset 

1 

Reset and load all parameters 
0 Not active 

2. p0976 = 1 

1 Start restoring all parameters to their factory settings 

0 

After approx. 15 sec. wait time, the BOP display = 35 and the RDY-LED is green. p0009 is automatically set to 1, p0976 to 
0.  
Note: 
As soon as the RDY-LED is green again, the factory setting has been completed and commissioning can start. 

Device commissioning parameter filter * 
0 Ready 
1 Device configuration 

3. p0009 = 1 

30 Parameter reset 

1 

Select drive object type * 
0 No selection 
1 Drive object type SERVO 

4. p0097 = 2 

2 Drive object type VECTOR 

0 

Device commissioning parameter filter * 
0 Ready 

5. p0009 = 0 

1 Device configuration 

1 

Note: 
Wait approx. 10 sec. The basic configuration is saved once the RDY lights green. In order to transfer this state into the 
ROM, press the "p" button until the display flashes. When the flashing stops, the RDY changes from orange to green and 
the transfer has been completed. Alarm A07991 indicates that the motor data identification function has been activated at 
drive "DO 2".  
The drive parameters are entered: 

Select drive object (DO) = 2 ( = VECTOR) 
1 Expert list of the CU 
2 Expert list of the drive 

6. DO = 2 

To select a drive object (DO), simultaneously press the "Fn" key and the arrow ↑ 
key.  
The selected drive object is displayed at the top left. 

1 

Drive, commissioning parameter filter * 
0 Ready 

7. p0010 = 1 

1 Quick commissioning 

1 



 Commissioning 
 2.7 First commissioning vector control AC drive blocksize format 

Commissioning Manual 
Commissioning Manual, (IH1), 01/2013, 6SL3097-4AF00-0BP3 125 

 Procedure Description Factory 
setting 

IEC/NEMA motor standard 
0 IEC motor (SI units, e.g. kW) 

Preset: 
Rated motor frequency (p0310): 50 Hz 
Specification of the power factor cos φ (p0308) 

1 NEMA motor (US units, e.g. hp) 
Preset: 
Rated motor frequency (p0310): 60 Hz 
Specification of the efficiency (p0309) 

8. p0100 = 0 

Note: 
When p0100 is changed, all the rated motor parameters are reset. 

0 

Rated motor data [MDS] 
Only when p0300 < 100 (third-party motor) 
Enter the rated motor data in accordance with the rating plate, e.g. 

p0304[0] Rated motor voltage [MDS] 
p0305[0] Rated motor current [MDS] 
p0307[0] Rated motor output [MDS] 
p0308[0] Rated motor power factor [MDS] (only when p0100 = 0) 
p0309[0] Rated motor efficiency [MDS] (only when p0100 = 1) 
p0310[0] Rated motor frequency [MDS] 
p0311[0] Rated motor speed [MDS] 

9. p030X[0] = ... 

p0335[0] Motor cooling type [MDS] * 
0: Natural cooling 
1: Forced cooling 
2 Water cooling 

- 

Motor data identification and rotating measurement* 
0 Inhibited 
1 Motor data identification for rotating motor 
2 Motor data identification for a stationary motor 

10. p1900 = 2 

Message A07991 is displayed, motor data identification was activated. 

2 

Drive, commissioning parameter filter * 
0 Ready 

11. p0010 = 0 

1 Quick commissioning 
RDY is lit red, fault F07085 signals that a control parameter has been changed. 

1 

Parameter p0840[0] can only be changed with access level p0003 = 3.   
12. p0840[0] = 

r0019.0(DO 1) 
BI: ON/OFF1 [CDS] 
Sets the signal source for STW1.0 (ON/OFF1) 
Interconnection with r0019.000 of the drive object Control Unit (DO 1) 
Effect: Signal ON/OFF1 from the BOP 

0 

13. p1035[0] = 
r0019.0013 

(DO 1) 

BI: Motor potentiometer setpoint higher [CDS] 
Sets the signal source to increase the setpoint for the motorized potentiometer 
Interconnection with r0019.013 of the drive object Control Unit (DO 1) 
Effect: Signal, motorized potentiometer setpoint higher from BOP 

0 
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 Procedure Description Factory 
setting 

14. p1036[0] = 
r0019.0014 

(DO 1) 

BI: Motor potentiometer setpoint lower [CDS] 
Sets the signal source to reduce the setpoint for the motorized potentiometer 
Interconnection with r0019.014 of the drive object Control Unit (DO 1) 
Effect: Signal, motorized potentiometer lower setpoint from BOP 

0 

15. p1070[0] = 
r1050 (DO 63) 

CI: Main setpoint [CDS] 
Sets the signal source for speed setpoint 1 of the speed controller. 
Interconnection with r1050.000 to the separate drive object (DO 63) 
Effect: Motorized potentiometer supplies the speed setpoint 

0 

16. "FN", then press "P". The display indicates 41, press "O", the display jumps to 31. 
17. Start the motor data identification with "I". The drive switches off again after approx. 5 sec., the display goes back 

to 41. 
18. After pressing "O", 31 is displayed again. The drive is now ready. The drive is switched on by pressing "I", the 

motor accelerates by pressing the "↑" key. 
19. Save all 

parameters 
Press the P key for approx. 5 sec until the display flashes. 

* These parameters offer more setting options than the ones described here. For further setting options see 
SINAMICS S120/S150 List Manual 
[CDS] Parameter depends on command data sets (CDS). Data set 0 is preset. 
[DDS] Parameter depends on drive data sets (DDS). Data set 0 is preset. 
[MDS] Parameter depends on motor data sets (MDS). Data set 0 is preset. 
BI binector input 
BO binector output 
CI connector input 
CO connector output 
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2.8 First commissioning servo control AC drive blocksize format 
An example provided in this chapter explains all the configuration and parameter settings, as 
well as tests that are required for initial commissioning. Commissioning is carried out using 
the STARTER commissioning tool.  

Preconditions for commissioning 
● The commissioning preconditions (Page 18) have been met. 

● The commissioning checklists (Page 20) (Tables 1-1 and 1-2) have been completed and 
the points fulfilled. 

● The STARTER commissioning tool is installed and activated. 

– see the "Readme" file on the STARTER installation DVD 

● The drive system has been wired according to the specifications. 

● The communication between the PG/PC and drive system has been prepared. 

● The power supply of the Control Unit (24 V DC) has been switched on. 

2.8.1 Task 
A drive unit is to be commissioned (servo control, closed-loop speed control) with the 
following components: 

 
Designation Component Order number 
Closed-loop control 
Control Unit Control Unit 310-2 DP 6SL3040-1LA00-0AA0 
Operator Panel Basic Operator Panel 20 

(BOP20) 
6SL3055-0AA00-4BAx 

Infeed and drive 
Power Module Power Module 340 6SL3210-xxxx-xxxx 
Motor Synchronous motor with DRIVE-

CLiQ interface 
1FK7061–7AF7x–xAxx 

Motor encoder via DRIVE-CLiQ Incremental encoder sin/cos 
C/D 
1 Vpp 2048 p/r 

1FK7xxx–xxxxx–xAxx 

Commissioning is performed using the BOP20. 

The Basic Operator Panel (BOP) should be parameterized so that the ON/OFF signal and 
the speed setpoints are entered using the function keys. 
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2.8.2 Component wiring (example) 
The following diagram shows the structure of the components and the appropriate wiring. 

 
Figure 2-24 Component wiring with integrated Sensor Module (example) 

For more information on wiring and connecting the encoder system, see the Equipment 
Manual. 
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2.8.3 Quick commissioning using the BOP (example) 

Table 2- 10 Quick commissioning for a servo drive with a DRIVE-CLiQ interface 

 Procedure Description Factory 
setting 

Note: 
Before commissioning for the first time, in the drive mode DO = 1, the drive is restored to the factory setting. 

Device commissioning parameter filter 
0 Ready 
1 Device configuration 

1. p0009 = 30 

30 Parameter reset 

1 

Reset and load all parameters 
0 Not active 

2. p0976 = 1 

1 Start restoring all parameters to their factory settings 

0 

Note: 
As soon as the RDY-LED is green again, the factory setting has been established and commissioning can start. 

Access levels 
1 Standard 
2 Extended 

3.  p0003 = 3 

3 Expert 

1 

Device commissioning parameter filter * 
0 Ready 
1 Device configuration 

4. p0009 = 1 

30 Parameter reset 

1 

Select drive object type * 
0 No selection 
1 Drive object type SERVO 

5. p0097 = 1 

2 Drive object type VECTOR 

0 

Device commissioning parameter filter * 
0 Ready 
1 Device configuration 

6. p0009 = 0 

30 Parameter reset 

1 

Note: 
For the firmware to be activated, a POWER ON must be carried out for the components. 
The extended setpoint channel must be opened for motorized potentiometer simulation with p0108[1] = H0104 

Device commissioning parameter filter * 
0 Ready 
1 Device configuration 
2 Defining the drive type / drive options 

7. p0009 = 2 

30 Parameter reset 

1 

 Drive object, function module * 
Bit 2 Closed-loop speed/torque control 

8. p0108[1] = 
H0104 

Bit 8 Extended setpoint channel 

H0000 
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 Procedure Description Factory 
setting 

Device commissioning parameter filter * 
0 Ready 
1 Device configuration 

9. p0009 = 0 

30 Parameter reset 

1 

Note: 
Wait until the RDY-LED changes from orange to green. To save the setting in the ROM, press about 5 seconds on the "P" 
key until the BOP display flashes, then wait until flashing has stopped. The drive is now prepared.  

Select drive object (DO) 2 ( = SERVO) 
1 Expert list of the CU 
2 Expert list of the SERVO drive 

10. DO = 2 

To select a drive object (DO), simultaneously press the Fn key and the "Arrow up" 
key. 
The selected drive object is displayed at the top left. 

1 

11. p0840[0] = 
r0019.0(DO 1) 

BI: ON/OFF1 [CDS] 
Sets the signal source for STW1.0 (ON/OFF1) 
Interconnection with r0019.0 of the drive object Control Unit (DO 1) 
Effect: Signal ON/OFF1 from the BOP 

0 

12. p1035[0] = 
r0019.0013 

(DO 1) 

BI: Motor potentiometer setpoint higher [CDS] 
Sets the signal source to increase the setpoint for the motorized potentiometer 
Interconnection with r0019.13 of the drive object Control Unit (DO 1) 
Effect: Signal, motorized potentiometer setpoint higher from BOP 

0 

13. p1036[0] = 
r0019.0014 

(DO 1) 

BI: Motor potentiometer setpoint lower [CDS] 
Sets the signal source to reduce the setpoint for the motorized potentiometer 
Interconnection with r0019.14 of the drive object Control Unit (DO 1) 
Effect: Signal, motorized potentiometer lower setpoint from BOP 

0 

14. p1037 = 6.000 Max. speed, setpoint potentiometer 0.000 
15. p1070[0] = 

r1050 (DO 63) 
CI: Main setpoint [CDS] 
Sets the signal source for speed setpoint 1 of the speed controller. 
Interconnecting to r1050 on its own drive object (DO 63) 
Effect: Motorized potentiometer supplies the speed setpoint 

1024 

BOP operating display mode* 
0 Operation -> r0021, otherwise r0020 <-> r0021 
1 Operation -> r0021, otherwise r0020 
2 Operation -> p0005, otherwise p0005 <-> r0020 
3 Operation -> r0002, otherwise r0002 <-> r0020 

16. p0006 = 0 

4 p0005 

4 

"FN", then press "P", the display in DO = 2 displays 31.  
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 Procedure Description Factory 
setting 

17. Save all 
parameters 

Press the "P" key for approx. 5 sec, 41 is displayed. After pressing the "O" key, the display 
jumps to 31 - and the drive is now ready. 10 is displayed in DO = 1. 

* These parameters offer more setting options than the ones described here. For further setting options see 
SINAMICS S120/S150 List Manual 
[CDS] Parameter depends on command data sets (CDS). Data set 0 is preset. 
[DDS] Parameter depends on drive data sets (DDS). Data set 0 is preset. 
BI binector input 
BO binector output 
CI connector input 
CO connector output 
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2.9 Commissioning of power units connected in parallel 
During commissioning, power units connected in parallel are treated like a power unit on the 
line or motor side. With parallel connection, the parameter display for the actual values 
changes only slightly. Suitable "total values" are derived from the individual values of the 
power units. 

Only power units in the "chassis" format are released for a parallel connection: 

● Infeeds 

● Motor Modules for vector control 

When commissioning the power units for the first time, activate the parallel connection via 
the wizards in the STARTER commissioning tool. Select the parallel connection when 
selecting the power unit (infeed and/or Motor Module) according to the following diagrams as 
option:  

Parallel connection of infeeds in the STARTER commissioning tool 

 
Figure 2-25 Example of parallel connection of 3 Active Line Modules (chassis type)  
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You need to specify the number of infeeds to be connected in parallel in the appropriate field 
(maximum 4 infeeds are permitted). 

Active Line Modules can also be used in the master/slave mode. The master/slave function 
can be selected as option in this window (for further information, refer to the Chapter 
"Master/slave function for infeeds" in the SINAMICS S120 Function Manual Drive Functions). 

The line filter is offered as an option, depending on the infeed. An Active Interface Module 
(AIM) with integrated line filter is required to operate an "Active Line Module" (ALM). We 
recommend external line filters to operate the "Basic Line Module" (BLM) and "Smart Line 
Module" (SLM) Line Modules. 
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Parallel connection of Motor Modules in the STARTER commissioning tool 

 
Figure 2-26 Example of a parallel connection of 3 Motor Modules (chassis format, in vector control)  

Select the number of Motor Modules connected in parallel in the drop-down list, "Number of 
parallel modules" (max. 4 Motor Modules). 

 

 Note 

For the parallel connection, operation is released for a maximum of 8 power units (max. 4 
Motor Modules and max. 4 Line Modules).  
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Configuration of parallel connections using parameters 
From the perspective of the higher-level control system, the parallel connection of infeeds 
behaves exactly the same as when controlling a single infeed, whose power is the same as 
the total power of the individual infeeds connected in parallel. 

PROFIdrive telegrams allow the power units to be individually activated and their status 
queried using parameter services from a higher-level controller. Infeeds may also be 
activated using the appropriate control and status words. These are documented in the 
chapter "Communication according to PROFIdrive" in the SINAMICS S120 Drive Functions 
Function Manual. 

Power units should only be activated and deactivated in the event of a fault, for example, 
after replacing a failed power unit. This approach is unsuitable for variable power control, 
because the Control Unit recalculates the drive line-up control parameters after every 
change. Optimal, highly dynamic control behavior of the drive line-up can only be ensured by 
recalculation.  

The power units can be monitored and parameterized individually: 

● Using p0125, you activate or deactivate a power unit from the topology (select using the 
topology number). 

● With p0895, you specifically activate or deactivate power units via an interconnected 
digital input (BI). 

● The number of currently active power units in a parallel connection is displayed in r7000. 

● After a fault or replacement, parameter p7001 allows you to specifically deactivate or 
activate connected power units. 

Alarm messages (e.g. as a result of overtemperature) can still be sent in this state. Individual 
power units cannot be disabled for motors with separate winding systems (p7003 = 1). 
p7001 is reset automatically if a power unit is deactivated with p0125 or p0895. 

● You can use parameter r7002 to query whether the pulses in a power unit are inhibited or 
enabled. 

● The circulating currents of U, V, W at the power units are displayed in parameters r7050, 
r7051 and r7052. 

● Overload states and various temperature states in the power units can be displayed in 
parameters from r7200 up to r7219. 

Parallel connection is indicated with a "P" in front of the value shown on the parameter value 
display. 

Other parameters relevant for the operation and parameterization of power units can be 
taken from the SINAMICS S120/S150 List Manual from parameter r7002 or from p0125 
onwards.  
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Parallel connection with one or two Control Units  
If an infeed is deactivated, the pre-charging must be able to charge the remaining infeeds in 
the DC link. For example, the charging time is doubled, if only one of the two infeeds 
connected in parallel is activated. Configure the infeeds in such a way that one of the parallel 
infeeds or, for redundant interconnection (2 Control Units), one subsystem is able to pre-
charge the whole DC link. 

The connected capacitance should not be too large. However, pre-charging double an 
infeed's rated capacitance (one of two infeeds previously out of operation) will work with no 
problems. 

Pre-charging contactor monitoring 
To monitor the pre-charging contactors (for infeed failure), you must insert the auxiliary 
terminal blocks on the pre-charging contactors. 

The following diagram shows the basic concept of interconnection: 

 
Figure 2-27 Pre-charging contactor monitoring 

 

The contactor states can be monitored using the logic blocks "free blocks" in the SINAMICS 
drive. If one of the contactors does not pick up, an external fault message is generated. 
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Operating state of power units connected in parallel 
Fault messages and alarms from A05000 or F05000 onwards indicate faults in a power unit.  

Power unit faults are stored in the fault buffer in the appropriate Control Unit and can be read 
as a fault value using parameter r0949 (interpreted decimally). This fault value corresponds 
to the drive object number in the drive line-up topology. The number of the fault occurring is 
stored in parameter r0945. 

The power unit's operating state (infeed or Motor Module) is displayed at both front LEDs on 
the corresponding Control Interface Module (CIM). 

The power unit for a specific drive can be identified using parameter p0124. During 
p0124[0...n] = 1, the LED READY on the power unit concerned flashes green/orange or 
red/orange at 2 Hz. For parallel connections the parameter index is assigned to one power 
unit in each case. 

Configuration of power units connected in parallel 
Information on the hardware configuration and wiring the power units is provided in the 
SINAMICS S120 Manual Chassis Power Units. 

You can find information on configuration in "SINAMICS Configuration Manual G130, G150, 
S120 Chassis, S120 Cabinet Modules, S150". The installation of power units within a control 
cabinet with Line Connection Modules is also described in this manual. 
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2.10 Learn devices 

Description 
Using a software update, the "learning devices" function amends an existing STARTER 
(from version V4.2) with information about later drive firmware versions.  

The update is implemented with a SINAMICS Support Package (SSP) from STARTER 
version 4.2. Here, equipment descriptions have been added to the STARTER commissioning 
tool, without having to reinstall the tool or change the code and without the drive being 
physically available. 

A SINAMICS Support Package must be installed if SINAMICS versions are to be supported 
by the STARTER commissioning tool that are not included in STARTER version 4.2. You 
can download SINAMICS Support Packages on the Internet from the eSupport and Product 
Support pages. 
The existence of new SSPs in Product Support will be announced when a new SINAMICS 
version is released for delivery. 

SSP (SINAMICS Support Package)  
An SSP contains only description files of the devices and drive objects. By installing an SSP, 
new drive objects and devices can be added to an existing STARTER installation, without 
changing its program code.  
After installation, all the functions of the new SINAMICS version can be configured with the 
expert list. All screens and wizards are also available for all the functions compatible with the 
previous version.  

SSP content: 

● New drive objects 

● New device versions 

● New and changed parameters in the expert list 

● New and changed faults, alarms and messages 

● New and changed sequence parameterizations 

● Expansions of the component catalog (new motors, encoders, DRIVE-CLiQ components) 

● Expansion of the configuration catalog (SD) 

● Changed online help files (parameter help, function diagrams) 
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Installation 
All SSPs released for a STARTER version may be installed in any order. 

The installed SINAMICS Support Packages are displayed in the Info dialog box of 
STARTER. 

If a new STARTER version has been created and delivered, this STARTER contains all 
SSPs released up until the present time, or is compatible with them.  

Compatible SSPs can also be installed a multiple number of times if repairs are necessary, 
without functional changes. 

The STARTER commissioning tool should not be running during SSP installation. The 
installation program should be started and run through. Only after the installation has been 
finished and STARTER has been called up again, can you now configure the newly installed 
SINAMICS versions offline and operate them online (via "Accessible nodes" for example). 
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2.11 Selection and configuration of encoders 

Encoder selection  
For a SINAMICS drive system, there are three possibilities of selecting the encoder using the 
STARTER commissioning tool: 

● Evaluating the motor and encoder data via a DRIVE-CLiQ interface. 

The encoder is automatically identified by setting parameter p0400 = 10000 or 10100, i.e. 
all of the motor and encoder data required for the configuration are read out of the 
encoder. For p0400 = 10100, the identification time is not limited. 

● Select a standard encoder from a list (also possible via the motor order number for 
encoder 1/motor encoder). Every encoder type on the list has a code number, that can 
also be assigned using parameter p0400 (encoder type selection). 

● Manually entering user-defined encoder data. In this case, the encoder can be configured 
using the encoder-specific input screens in the STARTER commissioning tool. 

The encoders can also be configured on their own using parameters (parameters p0400 to 
p0499). 

Table 2- 11 Assigning encoder type, encoder code and evaluation modules for standard encoders 

Encoder type Encoder code Encoder evaluation procedure  Evaluation module 
DRIVE-CLiQ  
encoder 
 

Absolute rotary 
value  

202 
242 
204 
244 

Abs.,singleturn 20 bit 
abs.,singleturn 24 Bit 
abs.,multiturn 12 bit, singleturn 20 bit) 
abs.,multiturn 12 bit, singleturn 24 bit) 

- 

Resolver Incremental 
rotary 

1001 
1002 
1003 
1004 

Resolver 1-speed 
Resolver 2-speed 
Resolver 3-speed 
Resolver 4-speed 

SMC10, SMI10 

Encoder with 
sin/cos 1Vpp 

Incremental 
encoder 
rotary 

2001 
2002 
2003 
2005 
2010 

2048, 1 Vpp, A/B C/D R 
2048, 1 Vpp, A/B R 
256, 1 Vpp, A/B R 
512, 1 Vpp, A/B R 
18000, 1 Vpp, A/B R distance-coded 

SMC20, SMI20, 
SME20, SME120 
 
 

EnDat 
encoder 

Absolute value 
rotary 

2051 
2052 
2053 
2054 
2055 

2048, 1 Vpp, A/B, EnDat, multiturn 4096 
32, 1 Vpp, A/B, EnDat, multiturn 4096 
512, 1 Vpp, A/B, EnDat, multiturn 4096 
16, 1 Vpp, A/B, EnDat, multiturn 4096 
2048, 1 Vpp, A/B, EnDat, singleturn 

SMC20, SMC40, 
SMI20, SME25 
 

SSI encoder 
with 
sin/cos 1Vpp 

Absolute value 
rotary 

2081 
2082 
2083 
2084 

2048, 1 Vpp, A/B, SSI, singleturn 
2048, 1 Vpp, A/B, SSI, multiturn 4096 
2048, 1 Vpp, A/B, SSI, singleturn, error bit 
2048, 1 Vpp, A/B, SSI, multiturn 4096, error 
bit  

SMC20, SMI20, 
SME25, SME125 

Linear 
encoder 

Incremental 
linear 

2110 
2111 
2112 
2151 

4000 nm, 1 Vpp, A/B R distance-coded 
20000 nm, 1 Vpp, A/B R distance-coded 
40000 nm, 1 Vpp, A/B R distance-coded 
16000 nm, 1 Vpp, A/B, EnDat, resolution 
100 nm 

SMC20, SMI20, 
SME20 
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Encoder type Encoder code Encoder evaluation procedure  Evaluation module 
Absolute value 
linear 

2151 16000 nm, 1 Vpp, A/B, EnDat,  
resolution 100 nm 

SMC20, SMI20,  
SME25 

HTL/TTL  
encoders 

Incremental 
square wave 
rotary 

3001 
3002 
3003 
3005 
3006 
3007 
3008 
3009 
3011 
3020 

1024 HTL A/B R 
1024 TTL A/B R 
2048 HTL A/B R 
1024 HTL A/B 
1024 TTL A/B 
2048 HTL A/B 
2048 TTL A/B 
1024 HTL A/B unipolar 
2048 HTL A/B unipolar 
2048 TTL A/B R, with Sense 

SMC30 

SSI encoder 
absolute 

Absolute value 
rotary 

3081 
3082 

SSI, singleturn, 24 V 
SSI, multiturn 4096, 24 V 
Not for motor control, 
only as a direct measurement system 

SMC20, SMI20, 
SME25, SME125 

SSI encoder 
absolute HTL 

Absolute value 
rotary 

3090 4096, HTL, A/B, SSI, singleturn SMC30 

Linear 
encoder 

Incremental 
linear 

3109 2000 nm, TTL, A/B R distance-coded SMC20, SMI20, 
SME20 

SIMAG H2 Incremental 
encoder 
rotary 

2002 
2003 
2004 
2005 
2006 
2007 
2008 

2048, 1 Vpp, A/B R 
256, 1 Vpp, A/B R 
400, 1 Vpp, A/B R 
512, 1 Vpp, A/B R 
192, 1 Vpp, A/B R 
480, 1 Vpp, A/B R 
800, 1 Vpp, A/B R 

SMC20, SMI20, 
SME20 

 

 

 Note 

The SMC40 can only be completely configured, if an associated EnDat 2.2 encoder is 
connected. Without a connected encoder, it is not possible to integrate the SMC40 into the 
topology. 
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Configuring an encoder  
You can configure the encoders using an input screen in the STARTER commissioning tool. 
You have three configuration options:  

Configuration for encoders with DRIVE-CLiQ interface 

1. Activate the "Encoder with DRIVE-CLiQ interface" option button with a mouse click. 

Then the encoder with DRIVE-CLiQ interface is automatically identified in the encoder 
configuration screen. 

 
Figure 2-28 Identifying DRIVE-CLiQ encoders 
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Configuration of standard encoders 

1. Select the "Select standard encoder from list" option field. 

The encoder 1 / motor encoder can also be selected and configured at the same time 
using the motor order number. 

 
Figure 2-29 Standard encoder option 

When configuring the drive you can select the standard encoders offered by Siemens 
from a list under "encoder". When the encoder type is chosen, all necessary 
parameterizations are simultaneously and automatically transferred into the encoder 
configuration. The standard encoder type and the corresponding evaluation modules are 
shown in the above table.  
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Configuration using manually determined user data 

1. To manually enter user-defined encoder data, use the mouse to activate the option button 
"Enter data". 

In this case, the encoder can be configured using the encoder-specific input screens in 
the STARTER commissioning tool. 

 
Figure 2-30 User-defined encoder option  
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2. Click on the "Encoder data" button. 

The following window opens for encoder data: 

 
Figure 2-31 Rotary encoder types  

In this window, you can select between "rotary" and "linear" encoders. 

3. Select the encoder type by clicking on the appropriate option button. 

For encoder type "rotary", you can select the following encoders: 

– Resolver 

– Incremental encoder with sin/cos signal 

– Absolute encoder with EnDat protocol 

– Incremental encoder with HTL/TTL signal 

– Absolute encoder with SSI protocol 

– Absolute encoder with SSI protocol and HTL/TTL signal 

– Absolute encoder with SSI protocol and sin/cos signal 
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The drop-down list for the "rotary" encoder type lists the following encoders: 

 
Figure 2-32 Linear encoder types  

The following encoders can be configured for "linear" encoder type: 

– Absolute encoder with EnDat protocol 

– Incremental encoder with sin/cos signal 

– Incremental encoder with HTL/TTL signal 

– Absolute encoder with SSI protocol 

– Absolute encoder with SSI protocol and HTL/TTL signal 

– Absolute encoder with SSI protocol and sin/cos signal 

4. Select the required encoder from the drop-down list. 

The encoder-specific input screens for rotary and linear encoders are self-explanatory and 
therefore not explicitly explained here. 

The following describes commissioning and replacing an encoder using the DRIVE-CLiQ 
encoder as an example. 
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Encoders with a DRIVE-CLiQ interface  
Encoder evaluation units with DRIVE-CLiQ interface are available in the following versions: 

● Sensor Module Cabinet-Mounted (SMCx) for rail mounting 

● Sensor Module External (SMEx) to be incorporated in the feeder cable 

● Sensor Module Integrated (SMI), mounted on the motor 

● DRIVE-CLiQ Module Integrated (DQI) integrated in the motor 

A temperature sensor at the DRIVE-CLiQ encoder to detect the motor temperature is 
connected in the factory. 

Support with STARTER version 

The STARTER commissioning tool supports encoders with DRIVE-CLiQ interface. Additional 
order numbers (MLFBs) are available for the corresponding DRIVE-CLiQ motors in the 
encoder overview. 

The motor order number is used for an SMI or DQI motor. 

When configuring a motor with DRIVE-CLiQ interface, a distinction is not made between SMI 
motors and DQI motors. 

If you replace a motor with encoder and external DRIVE-CLiQ interface by an SMI motor or 
DQI motor, then you must appropriately reparameterize the SMI/DQI motor.  

The functional behavior differs for the following encoder changes: 

● If the encoders differ due to the measurement principle and the resolution. 

● If the encoders are used in applications where the evaluation requires a zero mark (for 
example for referencing purposes). The encoder with integrated DRIVE-CLiQ interface 
does not supply a separate zero mark, as it involves an absolute encoder. So in these 
applications (and/or in the superimposed controls) the changed behavior must be 
selected. 

● If an encoder is to be used on an axis with SINAMICS Safety Integrated Extended 
Functions or SINUMERIK Safety Integrated, because a lower position accuracy (SOS 
Safe Operating Stop) and a lower maximum velocity (SLS Safely Limited Speed) is 
obtained as a result of the lower resolution of the redundant position value (POS2). 

A new commissioning test and, if necessary, new configuration must be carried out for 
activated SINAMICS Safety Integrated Extended Functions or SINUMERIK Safety 
Integrated. 
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Commissioning encoders with DRIVE-CLiQ interface 

For DRIVE-CLiQ encoders, the properties of a rotary absolute encoder are identified with the 
following parameters of the Control Unit: 

 
p0404[0..n]  Encoder configuration active 
p0408[0..n]  Rotary encoder pulse No. 
p0421[0..n]  Absolute encoder rotary multi-turn resolution 
p0423[0..n]  Absolute encoder rotary single-turn resolution 

This data is pre-assigned according to the preset codes in p0400 (encoder type selection) 
from the encoder lists. Parameters p0404, p0408, p0421 and p0423 are checked by the 
Control Unit when booting. 

Alternatively, this data can be read out of the encoder with the setting p0400 = 10000 or 
p0400 = 10100. If the encoder data read out matches a known encoder type, this code is 
entered in p0400 using the Control Unit. In the other case, general codes are entered, e.g.: 
P0400 = 10050 (encoder with EnDat interface 2.1 identified), p0400 = 10058 (digital encoder 
(absolute) identified) or p0400 = 10059 (digital encoder (incremental) identified). 

A DRIVE-CLiQ encoder is identified by the parameter p0404.10 = 1. 

For DRIVE-CLiQ encoders, encoder codes are defined respectively for parameter p0400 
(see SINAMICS S120/S150 List Manual and above table).  
If the Control Unit identifies a DRIVE-CLiQ encoder type for which no code is stored, during 
identification it enters the code p0400 = 10051 (DRIVE-CLiQ encoder identified). 

The data is also automatically identified if a DRIVE-CLiQ encoder is found during automatic 
commissioning. During identification, the Control Unit reads out the values for p0404, p0421 
and p0423 from the DRIVE-CLiQ encoder. The Control Unit uses this data to determine the 
contents of p0400. The newly defined codes are not stored in the DRIVE-CLiQ encoder. 

Replacing a SINAMICS Sensor Module Integrated 

If a defect occurs in a SINAMICS Sensor Module Integrated (SMI) or in a DRIVE-CLiQ 
Sensor Integrated (DQI), contact your local Siemens office for a repair. 
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2.12 Notes on commissioning linear motors 

2.12.1 General information on commissioning linear motors 
Before commissioning motors, the following questions must be answered:  

● Are the preconditions for commissioning (Page 18) fulfilled? 

● Have the commissioning checklists (Page 20) been completed and are all of the points 
fulfilled? 

Detailed information on linear motors, encoders and power connection, configuring and 
mounting can be found in the Configuration Manual of the 1FN1, 1FN3 or 1FN6 linear 
motors. 

Terminology for rotary and linear drives 

Table 2- 12 Terminology 

Rotary Linear 
Speed Velocity 
Torque Force 
Stator Primary section 
Rotor Secondary section 
Rotor Secondary section 
Direction of rotation Direction 
Pulse number Grid spacing 
Rotate Run 
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Checks in the no-current state 
The following checks can be made: 

● Linear motor 

– What linear motor is used? 
1FN _ _ _ _ – _ _ _ _ _ – _ _ _ _ 

– Is the motor already mounted and ready to be powered up? 

– If a cooling circuit is being used, is it functional? 

● Mechanical system 

– Is the axis easy to move over the complete traversing range? 

– Does the air gap between the primary and secondary section and the mounting 
dimensions correspond to the motor manufacturer's data? 

– Suspended axis: 
If weight equalization is being used for the axis, is this functioning? 

– Brake: 
If a brake is being used, is it correctly controlled (see the SINAMICS S120 Function 
Manual Drive Functions)? 

– Traversing range limiting: 
Are the mechanical end stops available and tightly bolted to both ends of the 
traversing path? 

– Are the moving feeder cables correctly routed in a cable drag assembly? 

● Measuring system 

– Which measuring system is being used? 
 
_ _ _ _ _ _ _ _ _ _ _ _ 
 

– Absolute or incremental? abs incr  
 

– Grid spacing _ _ _ _ _ _ _ _ _ _ µm  
 

– Zero marks (number and position)_ _ _ _ _ _ _ _ _ _ _ _ 

– Where is the positive drive direction? 
Where is the positive counting direction of the measuring system?  
 

– Invert (p0410)? yes / no 
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● Wiring 

– Power unit (connect UVW, phase sequence, clockwise rotating field) 

– Protective conductor connected? 

– Shield connected? 

– Temperature monitoring circuits: 
Are the cables connected to the terminal block of the shield connecting plate? 
Temperature sensor (Temp-F): 
With the temperature sensor (Temp-F), the average absolute winding temperature can 
be measured. 
Overtemperature switch (Temp-S): 
The overtemperature trip circuit (Temp-S) enables each individual motor phase 
winding to be digitally monitored for an overtemperature condition. 

WARNING  
 

Risk of electric shock if there is no electrical isolation 

The circuits of Temp-F and Temp-S neither have "protective separation" between 
each other nor to the power circuits in accordance with IEC 61800-5-1.  

These specifications are not fulfilled when the temperature monitoring circuits are 
connected via the SMC20 Sensor Module. The temperature monitoring circuits must 
be connected via the Sensor Module SME12x so that the specifications of the EN 
61800-5-1 are fulfilled.  

Also refer to the Configuration Manuals for 1FN1, 1FN3 or 1FN6 linear motors. 

– Temperature sensor evaluation 

– Temperature monitoring with SME12x, (description of the temperature monitoring 
circuits see - connection to the SME12x in the Configuration Manual 1FN1, 1FN3 or 
1FN6 in chapter "Thermal motor protection", description for connection to the 
SME12x, see chapter "Connection of the temperature monitoring circuits) 

– Encoder system connection  
Is the encoder system connected correctly to SINAMICS? 
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2.12.2 Commissioning: Linear motor with one primary section 
 

WARNING  
Hazardous motion for linear motors 

Linear motors can achieve significantly higher rates of acceleration and velocities than 
conventional drives.  

The traversing range must always be kept clear in order to avoid any potential danger for 
man or machine.  

 

Commissioning a motor using the STARTER commissioning tool 
The required motor can be selected from a motor list. Alternatively, data for third-party 
motors can be manually entered. When doing this, the number of parallel primary sections 
(p0306) must be entered. 

1. Use the mouse to activate the "Select standard motor from list" option. Select a motor 
type, and then a standard motor from the "Motor selection" list. 
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Figure 2-33 STARTER screen, linear motor selection 1FN3 

OR 

2. Use the mouse to activate the "Enter motor data" option. Select a motor type and click on 
"Next". Then manually enter the data of a third-party motor. 
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The following motor data must be entered for third-party motors: 
 

Parameter Description 
p0305 Rated motor current 
p0311 Motor rated velocity 
p0315 Motor pole pair width 
p0316 Motor force constant 
p0322 Maximum motor velocity  
p0323 Maximum motor current 
p0338 Motor limit current 
p0341 Motor weight 
p0350 Motor stator resistance, cold 
p0356 Motor stator leakage inductance 

Optionally, further motor data (linear synchronous motor) can be entered for third-party 
motors: 

 

Parameter Description 
p0312 Rated motor force 
p0317 Motor voltage constant 
p0318 Motor stall current 
p0319 Motor stall force 
p0320 Rated motor magnetizing current 
p0325 Motor pole position identification current 1st phase 
p0326 Motor stall torque correction factor 
p0329 Motor pole position identification current 
p0348 Speed at start of field weakening 
p0352 Cable resistance cold 
p0353 Motor series inductance 
p0391 Current controller adaptation, starting point KP adapted  
p0392 Current controller adaptation, starting point KP adapted  
p0393 Current controller adaptation P gain adaptation 
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3. Enter user-defined encoder data via the dialog box with the same name.  
With linear motors, the encoder is configured in the "User-defined encoder data" screen. 

 
Figure 2-34 Encoder data screen in STARTER 

WARNING  
 

Hazardous motion for linear motors 

When linear motors are configured for the first time, the commutation angle offset 
(p0431) must be adjusted. For more information about the commutation angle offset and 
pole position identification, see the Chapter "Servo control" SINAMICS S120 Function 
Manual Drive Functions.  
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2.12.3 Commissioning: Linear motor with several identical primary sections 
If you are sure that the EMF of several linear motors has the same relative phase position to 
one another, then these linear motors can be connected in parallel using the connecting 
cables and operated from one Motor Module.  

Linear motors connected in parallel are commissioned based on the commissioning of a 
single linear motor. To activate the parallel connection of linear motors, in the window 
"Configuration - SINAMICS_S120_CU320 - 2nd motor" set a check mark for "Parallel motor 
connection". 

The number of linear motors connected in parallel is entered in the "Motor" screen form 
(p0306) when the drive is configured in the STARTER commissioning tool. 

The linear motors are connected individually in sequence to the drive, and are commissioned 
as a single motor (1FNx ...). The angular commutation offset is automatically determined and 
noted for each motor. Finally, the measured angular commutation offset of the motors are 
compared with each other. 

If the difference between the angular commutation offset is less than 5 degrees (electrical), 
all the motors can be connected to the drive in parallel and commissioned as a parallel 
configuration of n linear motors (e.g. 2 • 1FN3xxx). 

Permitted parallel connection 
Only linear motors that fulfill the following preconditions may be connected in parallel: 

● Identical primary section size 

● Identical winding type 

● Identical air gap 

 

 Note 

If linear motors in an axis are connected in parallel, the position of the primary sections with 
respect to one another and to the secondary sections must exhibit a specific grid, in order to 
achieve a matching electrical phase position.  

For additional information, refer to the Configuration Manual of the 1FN1, 1FN3 or 1FN6 
linear motors. 

 



 Commissioning 
 2.12 Notes on commissioning linear motors 

Commissioning Manual 
Commissioning Manual, (IH1), 01/2013, 6SL3097-4AF00-0BP3 157 

Temperature sensors and electrical wiring 
The temperature sensors can be evaluated, for example, as follows: 

● Temperature sensor 

– Motor 1: Connection via SME12x and evaluation via the drive control 

– Motor n: not connected  
(short-circuited and connected to the PE) 

● Temperature switch 

– Motor 1 to n: Evaluation via the drive control 

See also: Configuration Manual for Linear Motors 1FN3 or 1FN6 
 

WARNING  
Risk of electric shock 

When connecting-up the temperature monitoring circuits, carefully observe the 
requirements regarding protective separation in accordance with EN 61800-5-1. 

For additional information, refer to the Configuration Manual of the 1FN1, 1FN3 or 1FN6 
linear motors. 

 

2.12.4 Thermal motor protection 

Temperature monitoring circuits Temp-F and Temp-S  
The motors are supplied with two temperature monitoring circuits: Temp - F and Temp - S. 
Temp-F is to monitor and evaluate the temperature characteristic in the motor being used. 
Temp-S is used to activate the motor protection in the event of overheating in the motor 
windings. 

Both temperature monitoring circuits are independent of each other. The evaluation is 
realized via the Control Unit. The temperature sensors are connected to the drive system or 
to the Motor Module using Sensor Modules from the SME12x series. 

Temp-F (KTY 84 Sensor) 
The temperature monitoring circuit Temp-F consists of a KTY 84 temperature sensor located 
at the coils. Under certain circumstances – for example when the individual phases have 
different current levels – this can mean that the maximum temperature of the three phase 
windings is not Detective. Therefore, it is not permissible for motor protection to solely 
evaluate the Temp-F temperature monitoring circuit. Temp-F is used to monitor the 
temperature - and if necessary to output an alarm indicating that the drive is being shutdown 
because the Temp-S temperature monitoring circuit has responded.  
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Temp-S (PTC element) 
The temperature shutdown circuit comprises PTC thermistor temperature sensors (PTC 
elements). There is a PTC thermistor temperature sensor for monitoring the motor winding in 
each of the three phase-windings (U, V and W). This ensures overload protection, even if the 
current in the individual phases of a primary section is not the same - or if several primary 
sections have different load levels. The PTC elements are connected in series. 

The circuit and connection system for Temp-F and Temp-S are described in detail in the 
Configuration Manual; linear motors 1FN3 or 1FN6. 

The SME12x (Sensor Module External) is a device with connectors enabling the connection 
of various sensors of a direct drive (WMS, Hall sensors, temperature sensors). The output of 
the SME12x is connected to SINAMICS drive systems via DRIVE-CLiQ. The requirements 
regarding protective separation in accordance with EN 61800-5-1 are fulfilled by the 
electrical isolation between the voltage circuits for power and sensors. The SME12x 
therefore fulfills the following functions: 

● All signal cables can be connected close to the motor. 

● Temperature sensors can be fully evaluated: 

– Thermal motor protection through evaluation of Temp-S 

– Display of the temperature curve via evaluation of Temp-F 

There are two variants of SME12x: 

● SME120 for incremental position measurement systems 

● SME125 for absolute position measurement systems 

You will find further information on the SME12x in the SINAMICS S120 Manual, Control 
Units and Additional System Components, in the chapter "Encoder system connection". 

 

WARNING  
Risk of electric shock if there is no electrical isolation 

The circuits of Temp-F and Temp-S neither have "protective separation" between each 
other nor to the power circuits in accordance with IEC 61800-5-1.  

These specifications are not fulfilled when the temperature monitoring circuits are 
connected via the SMC20 Sensor Module. The temperature monitoring circuits must be 
connected via the Sensor Module SME12x so that the specifications of the EN 61800-5-1 
are fulfilled.  

Also refer to the Configuration Manuals for 1FN1, 1FN3 or 1FN6 linear motors. 
 



 Commissioning 
 2.12 Notes on commissioning linear motors 

Commissioning Manual 
Commissioning Manual, (IH1), 01/2013, 6SL3097-4AF00-0BP3 159 

NOTICE  
Material damage caused by overtemperature 

For thermal motor protection you must connect Temp-S. It is impermissible to not connect 
Temp-S!  

You can optionally connect Temp-F to a measuring instrument for commissioning or test 
purposes.  

In normal operation, short-circuit the Temp-F connections and connect to PE.  
 

 Note 

The Temp-F temperature sensor only evaluates the winding temperature of one phase in the 
primary section. However, the phases in the synchronous motor have different loads. Higher 
temperatures can occur in the phases that are not measured. 

 

WARNING  
Risk of electric shock 

Without using a suitable protective module (e.g. TM120), for safe electrical separation it is 
not permissible to connect Temp-F to a Sensor Module of the SINAMICS drive system.  

The drive must always be switched into a no-voltage condition. When handling and 
connecting Temp-F, when the drive is switched-on, hazardous voltages can be present at 
the terminals on the motor side and at the Temp-F connecting cable. 

 

WARNING  
Risk of electric shock 

If a 3RN1013-1BW10 thermistor motor protection device or a suitable protective module is 
not used, then for safe electrical separation it is not permissible to connect Temp-S to a 
PLC or to a Sensor Module of the SINAMICS drive system. 

The drive must always be switched into a no-voltage condition. When handling and 
connecting Temp-S, when the drive is switched-on, hazardous voltages can be present at 
the terminals on the motor side and at the Temp-S connecting cable. 
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Temperature evaluation unit with safe electrical separation  
Terminal Module 120 is a temperature evaluation unit with DRIVE-CLiQ interface for 
installation in a control cabinet. The TM120 has 4 measuring channels with safe electrical 
separation to connect KTY or PTC temperature sensors. A TM120 can also be used with 
Sensor Modules for encoder evaluation (SMCxx, SMIxx and SMExx) if safe electrical 
separation of the temperature sensors is necessary. 

Evaluating the temperature sensors 
For additional information, refer to the Configuration Manual of the 1FN1, 1FN3 or 1FN6 
linear motors. 

2.12.5 Measuring system 

Determining the control sense 
The control sense of an axis is correct if the positive direction of the drive (= clockwise 
rotating field U, V, W) coincides with the positive counting direction of the measuring system. 

 

 Note 

The data to determine the drive direction is only valid for Siemens motors (1FNx motors).  

If the positive direction of the drive and positive counting direction of the measuring system 
do not match, the actual speed value (P0410.0) must be inverted in the "Encoder 
configuration - details" screen form when the drive is being commissioned.  

The control sense can also be checked by first parameterizing the drive, and then manually 
moving it, with the enable signals inhibited (switched out).  

If the axis is pushed in the positive direction, the actual speed value must also count in the 
positive direction.  
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Determining the drive direction 
The direction of the drive is positive if the primary section moves relative to the secondary 
section in the opposite direction to the cable outlet direction. 

 
Figure 2-35 Determining the positive direction of the drive 

Determining the counting direction of the measuring system 
The counting direction is determined depending on the measuring system. 

Measuring systems from Heidenhain 
 

 Note 

The counting direction of the measuring system is positive, if the distance between the 
sensor head and rating plate increases. 

 

 
Figure 2-36 Determining the counting direction for measuring systems from the Heidenhain Company 



Commissioning  
2.12 Notes on commissioning linear motors 

 Commissioning Manual 
162 Commissioning Manual, (IH1), 01/2013, 6SL3097-4AF00-0BP3 

Measuring systems from Renishaw (e.g. RGH22B) 

As the reference mark for the Renishaw RGH22B has a direction-dependent position, with 
control cables BID and DIR, the encoder must be parameterized, so that the reference mark 
is only output in one direction. 

The direction (positive/negative) depends on the geometrical arrangement at the machine 
and the reference point approach direction. 

Table 2- 13 Overview of signals 

Connected to Signal Cable color Round connector 
12-pin +5 V 0 V 

BID Black Pin 9 Reference marks in 
both directions 

Reference marks in 
one direction 

DIR Orange Pin 7 Positive directions Negative direction 
+5 V Brown Pin 12 
0 V White Pin 10 

 

The counting direction of the measuring system is positive if the sensor head moves relative 
to the gold band in the cable outlet direction. 

 
Figure 2-37 Determining the counting direction for measuring systems from Renishaw 

 

 Note 
Cable outlet direction different to the counting direction 

If the sensor head is mechanically connected to the primary section, the cable outlet 
direction must be different to the counting direction. Otherwise, invert the actual value.  
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2.12.6 Checking the linear motor by taking measurements 

Why make measurements?  
If the linear motor was commissioned according to the relevant instructions, and unexplained 
fault messages still occur, then all of the EMF signals must be checked using an 
oscilloscope. 

Checking the phase sequence U-V-W 
For primary sections connected in parallel, the EMF_U from motor 1 must be in phase with 
the EMF_U from motor 2. The same is true for EMF_V and EMF_W.  
It is absolutely necessary that this is checked by making the appropriate measurements. 

Taking the necessary measurements 

● Disconnect the drive line-up from the power supply. 

● Notice: Wait until the DC link has been discharged! 

● Disconnect the power cables from the drive. 
Disconnect any primary components connected in parallel. 

● Form an artificial neutral point using 1 kOhm resistors. 

 
Figure 2-38 Configuration for taking the measurements 
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For a positive traversing direction, the phase sequence must be U-V-W. The direction of the 
drive is positive if the primary section moves relative to the secondary section in the opposite 
direction to the cable outlet direction. 

 
Figure 2-39 The positive direction of the drive (clockwise rotating field) 

Determining the commutation angle using an oscilloscope 
Once the oscilloscope has been connected, the drive must first pass the zero mark so that 
fine synchronization can be carried out. 

The angular, commutation offset can be determined by measuring the EMF and normalized 
electrical pole position via an analog output. 

 
Figure 2-40 Oscillogram 



 Commissioning 
 2.12 Notes on commissioning linear motors 

Commissioning Manual 
Commissioning Manual, (IH1), 01/2013, 6SL3097-4AF00-0BP3 165 

Definition of channels (Ch1 ... Ch4): 

● Ch1 EMF phase U to neutral point 

● Ch2: EMF phase V to neutral point 

● Ch3: EMF phase W to neutral point 

● Ch4: Normalized electrical angular pole position via analog output 

 
Figure 2-41 Setting of the measuring socket T0 on CU320 

When the drive is synchronized, the difference between the EMF/phase U and the electrical 
rotor position is a maximum of 10°. 

If the difference is greater, the commutation angle offset must be adjusted. 
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2.13 Commissioning SIMOTICS 1FW6 built-in torque motors 

2.13.1 Safety instructions for commissioning 
 

DANGER  
There is danger of death, serious bodily injury and/or property damage when untrained 
personnel is allowed to handle direct drives and/or their components. 

Only personnel who are familiar with and who observe the safety guidelines are allowed to 
handle direct drives and their components. 

Installation, commissioning, operation and maintenance may only be performed by 
qualified, trained and instructed personnel. The personnel must be thoroughly familiar with 
the content of this guide. 

All work must be performed by at least two persons. 
 

 
 

DANGER  
Risk of death, serious personal injury, and/or material damage if a machine is 
commissioned that does not fulfill the recognized safety requirements. 

Plants and machines with converter-fed low-voltage three-phase motors must fulfill the 
protection requirements of the EMC Directive 2004/108/EC. The company building the plant 
or system is responsible for ensuring that installation is carried out in an EMC-compliant 
manner. The signal and power cables must be shielded. Refer to the EMC installation 
guideline (order designation 6FC5297-□AD30-0AP□) issued by the converter manufacturer.

 

DANGER  
Unexpected movements of the motor may result in a risk of death, serious personal, and/or 
material damage. 

Danger from rotating rotor. Never carry out work in the vicinity of rotating parts when the 
machine is switched on. 

Keep persons away from rotating parts and areas where there is a danger of crushing. 

Ensure that the rotors can rotate without hindrance. 

Check the commutation setting before switching on the machine. Note also the 
commissioning instructions issued for the drive system. 

Limit the motor currents. 

Set low values for speed limiting. 

Monitor limit positions. 
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WARNING  
The surface temperature of the motors may be more than 100 °C (212 °F). Risk of burns 

Make sure that the cooling system (if available) is working properly. 

Do not touch the motor during/directly after use. 

Attach the "Hot Surface Do Not Touch" (DW-026) warning sign close to the source of 
danger where it can be easily seen! 

Temperature-sensitive parts (electric cables, electronic components) may not be placed on 
hot surfaces. 

 

 
 

DANGER  
Electrical shock hazard! 

A voltage is induced when the rotor rotates. The motor power connections must be properly 
connected or insulated before the rotor turns! 

 

 
 

DANGER  
The temperature monitoring circuits pose a risk of electric shock! 

The circuits of Temp-S and Temp-F do not meet the electrical separation requirements for 
power circuits according to DIN EN 61800-5-1 (previously protective electrical separation 
according to DIN EN 50178). 

Directly connecting temperature monitoring circuits Temp-S and Temp-F via the encoder 
connector of the Sensor Module SMC20 (X520 pin 13 and pin 15) does not fulfill the 
requirements of electrical isolation, and is therefore not permitted. 

Use, for example, the SME12x or TM120 to connect the Temp-S and Temp-F temperature 
monitoring circuits. 
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WARNING  
When a torque motor is being operated, the rotor must not exceed a temperature of 120°C 
otherwise the permanent magnet may become demagnetized. 

This must be ensured during initial commissioning by carrying out the appropriate checks. 

Special attention should be paid here to non-uniform current loads during standstill or 
operation with short, cyclic rotation because this can generate extremely high, localized 
temperatures. 

 

 
 

NOTICE  
The motor may overheat without temperature protection and be destroyed. 

Check whether the temperature protection is effective before (!) switching on the DC link 
voltage for the first time! 
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2.13.2 Checklists for commissioning 

Checklists for commissioning 1FW6 built-in torque motors 
Please thoroughly familiarize yourself with the safety instructions and observe the checklists 
below before starting any work. 

Table 2- 14 Checklist (1) - general checks 

Check OK 
Are all of the necessary components of the configured drive line-up available, correctly dimensioned, 
correctly installed and connected? 

 

Are the manufacturer's documentation for the system components (e.g. drive system, encoder, cooling 
system, brake) and the Configuration Manual "SIMOTICS T-1FW6 built-in torque motors" available? 

 

Are the following current SINAMICS documents available?  
• SINAMICS S120 Commissioning Manual 
• SINAMICS S120 Getting Started 
• SINAMICS S120 Function Manual Drive Functions 
• SINAMICS S120/S150 List Manual 

 

Was the Chapter "Checklists for commissioning SINAMICS S" taken into account?  
Is the motor type to be commissioned known? 
(e.g. 1FW6 _ _ _ – _ _ _ _ _ –  _ _ _ _) 

 

As a minimum, is the following data for the motor known, if it involves a "third-party motor"? 
("third-party motor" is every motor that is not saved as standard in the Siemens commissioning 
software.) 
• Rated motor current 
• Rated motor speed 
• Motor pole pair number 
• Motor torque constant 
• Maximum motor speed 
• Maximum motor current 
• Motor limit current 
• Motor moment of inertia 
• Motor stator resistance, cold 
• Motor stator leakage inductance 

 

Are the environmental conditions in the permissible range?  
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Table 2- 15 Checklist (2) - checking the mechanical system 

Check OK 
Has the motor been correctly installed according to the motor manufacturer's specifications and is it 
ready to be switched on? 

 

Were the transport locks removed according to the installation chapter of the Configuration Manual 
"SIMOTICS T-1FW6 built-in torque motors"? 

 

Can the axis freely rotate over the complete rotational range?  
Have all the screws been tightened to the specified torque?  
Are the stator and rotor centered with respect to one another corresponding to the motor manufacturer's 
specifications? 

 

If there is a motor holding brake, does this function correctly?  
Has the encoder been correctly mounted and adjusted according to the manufacturer's specifications? 
Important information on the encoders can also be found in the Configuration Manual "SIMOTICS T-
1FW6 built-in torque motors". 

 

Has a cooling system, required for liquid-cooled motors, been connected according to the manufacturer's 
specifications and is it functioning correctly? 

 

Does the cooling medium comply with the requirements listed in the Chapter "Cooling media" in the 
Configuration Manual "SIMOTICS T-1FW6 built-in torque motors"? 

 

Were the cooling circuits flushed before been filled with the cooling medium?  
Is it ensured that the permissible pressure in the cooling circuit is not exceeded (here, refer to "Technical 
features" in the Configuration Manual "SIMOTICS T-1FW6 built-in torque motors")? 

 

Are moving cables correctly routed in a tow chain?  
Have the power cables been properly connected to the component terminals with the specified torque?  
Have measures been taken to relieve strain on the cables?  
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Table 2- 16 Checklist (3) - checking the electrical system 

Check OK 
Has all wiring work been successfully completed?  
Is the protective conductor correctly connected?  
Is the motor ground directly connected to the Power Module ground (short distance in order to avoid high 
leakage currents)? 

 

Are all connectors correctly plugged in and screwed in place?  
Are the motors connected with shielded power cables?  
Are the power cable shields connected as closely as possible to the terminal box across a wide area?  
Are all cable shields connected to the respective housing through a large surface area?  
Have the control cables been connected in accordance with the required interface configuration and the 
shield applied? 

 

Have the motor power cables been correctly connected to the power module with the phase sequence 
UVW (clockwise rotating field)? 

 

Do the temperature monitoring circuits fulfill the specifications of protective separation? 
Additional important information on temperature monitoring circuits Temp-S and Temp-F can be found in 
the Configuration Manual "SIMOTICS T-1FW6 built-in torque motors". 

 

Before commissioning and before switching on the DC link voltage for the first time, have you checked 
the temperature monitoring circuits to ensure that they correctly trip/shut down? 

 

Is the encoder correctly connected?  
Are the digital and analog signals routed using separate cables?  
Has the distance from power cables been observed?  
Have the line-side and motor-side power cables been dimensioned and routed in accordance with the 
environmental and routing conditions? 

 

Have the maximum permissible cable lengths between the frequency converter and the motor 
(depending on the type of cables used) been observed? 
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2.13.3 General information for setting the commutation 
You can use the following two pole position identification techniques for all frame sizes of 
SIMOTICS T-1FW6 built-in torque motors: 

● The motion-based technique 

● The saturation-based technique (1st harmonic) 

 

 Note 
Fine synchronization is recommended for precise commutation 

Use either a measuring system with a zero mark that can be evaluated or an absolute 
measuring system. 

 

Motion-based technique 

This technique can also be used during commissioning when the commutation angle offset is 
initially determined or when it is checked in conjunction with an absolute measuring system 
(e.g. RCN 85xx from Heidenhain). 

The procedure can be applied for vertical and horizontal axes whose load cannot be reduced 
in an uncontrolled manner when the machine is disconnected from the power supply. In this 
case, the axes must be able to be freely moved and not be braked. (static friction < 10% of 
the rated motor torque). 

In the worst-case scenario, the rotor can move in the range of ± 5 degrees when this 
technique is used. 

 

WARNING  
For inclined and horizontal axes, the load may be reduced in an uncontrolled manner if the 
center of gravity is outside the rotary axes when the system is disconnected from the power 
supply. At certain times the axes angle cannot be monitored. 

Carefully take this into account when you use the motion-based technique. 
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Saturation-based technique 

This technique does not require the rotor to move, which means that it can also be used for 
axes that are locked (e.g. using a brake). Axes that are not locked can rotate, however. 
Depending on the actual mechanical design, this technique can result in a higher noise level 
when the axes is powered up during the identification routine. 

2.13.4 Parameterizing a motor and encoder 
 

 Note 
Parameterizing with STARTER 

The following descriptions and screenshots were created using the STARTER 
commissioning tool. 

The parameterization is shown with the help of screen forms and the expert list of the 
STARTER commissioning tool. 

 

Configuring data for a standard motor 
You must individually configure the drives. 

1. Double-click in the project navigator on "Drives" > "Drive name" > "Configuration" > 
"Configure DDS" one after the other. 
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2. Select the standard motor to be commissioned from the list. 

The associated motor data are stored and must not be entered manually. 

 
Figure 2-42 Screen to configure a motor - selecting a standard motor 

Configuring data for a third-party motor 
1FW6 built-in torque motors are not included in the list if they are customer-specific special 
motors or new developments. 

1. Please take the motor data from the attached motor data sheet and make the following 
settings: 
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Figure 2-43 Screen to configure the motor – setting for a third-party motor 
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2. Enter the following data for a rotating permanent-magnet synchronous motor: 

 
Figure 2-44 Example of motor data that have been entered 
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Figure 2-45 Example of optional motor data that have been entered 
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Entering equivalent circuit diagram data 

 
Figure 2-46 Example of equivalent circuit diagram data that have been entered 
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Calculating controller data 
After selecting the motor and entering the motor data, completely calculate the controller 
data. 

 
Figure 2-47 Screen form for calculating the motor/controller data 
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Configuring the motor holding brake 
If a motor holding brake is being used, configure it in the following window. 

 
Figure 2-48 Screen form for configuring a motor holding brake 

Encoder data 
1. Note the data of the encoder manufacturer and the information in Chapter "Selecting and 

configuring encoders (Page 140)" in this manual. 
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2. Configure the encoder data for the torque motor using the "Encoder data" screen form. 
To do this, in the dialog click on the "Encoder data" button. 

 
Figure 2-49 Screen form to configure an encoder 
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Incremental measuring system 
Example of an incremental sine/cosine encoder with 18,000 pulses per revolution with one 
zero mark per revolution: 

 
Figure 2-50 Screen form for entering the encoder data 

 
 

 Note 
Pole position identification is required for SIMOTICS T-1FW6 built-in torque motors with 
incremental measuring systems. 

The following techniques are possible to do this: 
• The motion-based technique 
• The saturation-based technique (1st harmonic) 

For incremental measuring systems, generally fine synchronization is performed at the zero 
mark. When commissioning the system for the first time, the angular commutation offset 
(p0431) must be pre-assigned, see Chapter "Determining the angular commutation offset 
(Page 193)". 

For third-party motors, a pole position identification routine to determine the angular 
commutation offset cannot be entered. 

 



 Commissioning 
 2.13 Commissioning SIMOTICS 1FW6 built-in torque motors 

Commissioning Manual 
Commissioning Manual, (IH1), 01/2013, 6SL3097-4AF00-0BP3 183 

Absolute measuring system 
The encoder is detected by the Control Unit as long as it is a DRIVE-CLiQ encoder. For 
other encoders, the following data must be entered via the configuration screen form after 
pressing the "Encoder data" button (example of an absolute encoder with Endat protocol, 
order code EnDat 01 or 02 with incremental signals to transfer the absolute values from the 
encoder to the Control Unit e.g. RCN 85xx Heidenhain): 

 
Figure 2-51 Screen form to configure an absolute encoder with EnDat protocol 

1. If necessary, use "Encoder data" and "Details" to invert the speed and position actual 
value. This allows the control sense to be changed. 
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2. To do this, first click on the "Encoder data" button in the screen form used for the encoder 
configuration. 

 
Figure 2-52 Screen form for entering additional encoder data 

Definition of the control sense 
The control sense of an axis is correct if the positive direction of the drive (= clockwise 
rotating field U, V, W) coincides with the positive counting direction of the measuring system. 

The data used to determine the drive direction is only valid for 1FWx motors from Siemens. 

If the positive direction of the drive and positive counting direction of the measuring system 
do not match, then you must invert the actual speed value in the "Encoder configuration - 
details" screen form when the drive is being commissioned (p0410.0 or p0410.1). 
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Determining the drive direction 
The direction of the drive is positive, if when viewing the DE flange, the rotor is rotating 
clockwise. 

 
Figure 2-53 Determining the positive direction of the drive 

 

Determining the counting direction of the measuring system 
The counting direction depends on the measuring system and the mounting position. The 
counting direction of the measuring system must match the direction of rotation of the motor. 
If necessary, you must adapt the counting direction by making the appropriate parameter 
assignment. Please refer to the manufacturer's documentation for the measuring system. If 
necessary, you must invert the counting direction as described in Figure 2-52 Screen form 
for entering additional encoder data (Page 184). 

 

 Note 
Checking the measuring system counting direction 

The measuring system counting direction can also be checked, by first parameterizing the 
drive, and then manually rotating it with the enable signals inhibited. 

If the axis is rotated in the positive direction, the actual speed value must also count in the 
positive direction. 

 

See also 
Parameterizing a motor and encoder (Page 173) 
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Completing parameterization 
SIMOTICS T-1FW6 built-in torque motors are feed drives (maximum current limiting). 

 
Figure 2-54 Screen form to select the application 
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Figure 2-55 Summary of the configuration 

The created offline project must now be loaded into the drive. In STARTER, go online with 
the target device. 

If an absolute measuring system with EnDat protocol was selected, then after establishing 
an online connection, the encoder serial number is loaded and the corresponding encoder 
parameters are set. 
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2.13.5 Parameterizing and testing the temperature sensors 

Sensor Module External SME12x 
The connection of the SME modules is described in the Chapter, "System integration" in the 
Configuration Manual "SIMOTICS T-1FW6 built-in torque motors". Information on the Sensor 
Module External SME12x can be found in the "SINAMICS S120 Equipment Manual for 
Control Units and Additional System Components" in the Chapter "Sensor Module External 
120 (SME120)" and in the Chapter "Sensor Module External 125 (SME125)". 

The parameterization of the temperature sensors is explained in detail in Chapter 
"Temperature sensors for SINAMICS components (Page 213)". 

A parameterizing example for a torque motor with a KTY 84 and two PTC sensors, 
connected to a Sensor Module External SME12x is subsequently provided.  

Use the parameter list to parameterize the drive.  

Table 2- 17 Parameterization in the drive: 

Parameter Input 
p0600 Motor temperature sensor for monitoring 

1: Temperature sensor via encoder 1 
p0601 Motor temperature sensor, sensor type 

10: Evaluation via several temperature channels SME12x 
p0604 Motor temperature alarm threshold  

Sets the alarm threshold for monitoring the motor temperature 
For motors from the motor list (p0301), this parameter is automatically pre-assigned (120 °C). 

p0605 Motor temperature fault threshold  
Sets the fault threshold for monitoring the motor temperature 
For motors from the motor list (p0301), this parameter is automatically pre-assigned (155 °C). 

p0606 Motor temperature timer 
0 to 2s 
Setting the timer for the alarm threshold for the motor temperature monitoring, when alarm with timer 
was selected in parameter p4600...4603. 
This timer is started when the temperature alarm threshold (p0604) is exceeded. 
If the timer has expired, and in the meantime the temperature alarm threshold has not been fallen 
below, then fault F07011 is output. 

p4600...p4603 Motor temperature sensor 1...4 sensor type 
Sets the temperature sensor type for the motor temperature monitoring. Channels 2 - 4 are used for 
the Sensor Module External SME12x. Channel 1 remains free. The following values are possible for 
torque motors: 
0: No sensor 
10: PTC fault 
12: PTC alarm & timer 
20: KTY 84 

If you make a selection with timer, you must pre-assign parameter p0606 with the 
corresponding timer of a maximum of 2 s. 
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Example: Standard SIMOTICS T-1FW6 built-in torque motors 

 
p4600 0: No sensor 
p4601 20: KTY 84 
p4602 10: PTC fault (PTC 130 °C) 
p4603 10: PTC fault (PTC 150 °C) 

If you are not using a standard motor, then you must parameterize parameters 
p0600...p0606 (see above). Select parameters p4600...p4603 to match the sensor types or 
temperature channels of the Sensor Module External SME12x. 

Checking the temperature sensors for the Sensor Module External SME12x 
In the online mode, you can read out the temperatures of the sensors at the channels of the 
Sensor Module External SME12x using parameter r4620[0…3] using the STARTER 
commissioning tool. 

The maximum motor temperature can also be read in r0035. This parameter indicates the 
highest value from parameters r4620[0…3]. 

For a parameterized PTC sensor type, irrespective of the actual temperature in r4620 - 200 
°C is always displayed. 

If a negative value in the range from – 40 °C to – 80 °C is displayed in parameter r0035 or 
r4620[1], then the KTY connection has been interchanged with that of the PTC.  

Checking the PTC sensor type 
You can simulate a sensor responding to an overtemperature condition (high ohmic state) by 
disconnecting the connections. You can disconnect the connections for the temperature 
sensors by removing the Sensor Module External SME12x (connector, interface X200). 

If the sensor type is parameterized as PTC fault, then fault "F07011 drive: Motor 
overtemperature" is immediately displayed independent of the setting of p0604 - p0606. If 
the sensor type is parameterized as PTC alarm with timer, after the time parameterized in 
p0606, fault F7011 is generated. 

Checking the KTY sensor type 
When you withdraw the connector of interface X200, and have therefore disconnected the 
KTY connection, after the time parameterized in p0607 has expired, fault "F07016 drive: 
Motor temperature sensor fault" is displayed in the alarm window of the STARTER 
commissioning tool. 

Check the wiring of the temperature sensors, by checking the resistance values at connector 
interface X200. The wiring is OK for the following resistance values: 

KTY 84 at 20 °C, approx. 570 Ω 

PTC at 20 °C, 120 Ω – 240 Ω 
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The assignment of connector interface X200 can be found in the "SINAMICS S120 Manual 
Control Units and Additional System Components". 

Terminal Module TM120 
Terminal Module TM120 is a DRIVE-CLiQ component for temperature evaluation with safe 
isolation, see also "SINAMICS S120 Manual for Control Units and Additional System 
Components" in the Chapter "Supplementary system components". 

TM120 is an autonomous input/output component. You can freely assign the temperature 
channels to any Motor Module. 

You can assign every channel to the following sensor types: 

● PTC 

● KTY 84 

● Bimetallic NC contact 

 

 Note 
Standard topology 

The standard topology is:  

Motor Module - Terminal Module TM120 - Sensor Module Cabinet SMC20 
 

Parameterization 
For a standard configuration with correct pre-assignment of the temperature channels, the 
Terminal Module TM120 must be located between the Sensor Module SMC20 and the Motor 
Module (DRIVE-CLiQ port X202). 

If this is not the case, you must parameterize all of the required temperature channels in both 
the Motor Module and Terminal Module TM120. 

You must always carefully check the temperature shutdown circuits (e.g. by disconnecting 
the sensors) before commissioning the motor for the first time. 

Use the expert list to parameterize the drive. 
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Table 2- 18 Parameterization in the drive: 

Parameter Input 
p0600 Motor temperature sensor for monitoring 

 20: Temperature sensor via BICO interconnection p0608 
p0601 Motor temperature sensor, sensor type 

11: Evaluation via several temperature channels BICO 
p0606 Motor temperature timer 

0 to 2s  
Sets the timer for the alarm threshold for the motor temperature monitoring, if alarm with timer was 
selected in p4610...4613. 
This timer is started when the temperature alarm threshold (p0604) is exceeded. 
If the timer expires before the temperature falls below the alarm threshold, then fault F07011 is 
output.  

p0608 [0...3] CI: Motor temperature, signal source 2 
Sets the signal source 2 for the evaluation of the motor temperature via a BICO interconnection, e.g. 
[0]: Motor temperature channel 1 TM120 . r4105[0]  
[1]: Motor temperature channel 2 TM120 . r4105[1] 
[2]: Motor temperature channel 3 TM120 . r4105[2]  
[3]: Motor temperature channel 4 TM120 . r4105[3] 

p4610...p4613 Motor temperature sensor 1...4 sensor type 
Sets the temperature sensor type for the motor temperature monitoring. The following values are 
possible for torque motors: 
0: No sensor 
10: PTC fault 
12: PTC alarm & timer 
20: KTY84 
30: Bimetallic NC contact fault 
32: Bimetallic NC contact alarm & timer 

If you make a selection with timer, you must pre-assign parameter p0606 with the 
corresponding timer of a maximum of 2 s. 

Table 2- 19 Parameterization in Terminal Module TM120 

Parameter Input 
p4100[0...3] TM120 temperature evaluation, sensor type 

Sets the temperature evaluation of Terminal Module TM120. 
This means that the temperature sensor type is selected and the evaluation is activated. The 
following values are possible: 
0: Evaluation deactivated 
1: PTC thermistor 
2: KTY84 
4: Bimetallic NC contact 

Check the temperature sensors in the same way as described for Sensor Module External 
SME12x. Test each individual temperature channel by withdrawing the connection. 
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PTC connection via thermistor motor protection device 3RN1013-1GW10 
You can evaluate the PTC sensors via a thermistor motor protection device 3RN1013-
1GW10. The normally closed contact must be connected to the temperature input at the 
Motor Module (terminals X21.1 X21.2). 

For a parallel connection of several motors, a thermistor motor protection device 3RN1013-
1GW10 must be used for each motor. The NC contacts must be connected in series. 

Table 2- 20 Parameterization in the drive: 

Parameter Input 
p0600 Motor temperature sensor for monitoring 

11: Temperature sensor via Motor Module / Control Unit terminals 
p0601 Motor temperature sensor, sensor type 

4: Bimetallic NC contact alarm & timer (only for temperature evaluation via the Motor Module) 
p0604 Motor temperature alarm threshold 

Sets the alarm threshold for monitoring the motor temperature. 
Pre-assignment,120 °C 

p0605 Motor temperature fault threshold 
Sets the fault threshold for monitoring the motor temperature. 
Pre-assignment,155 °C 

p0606 Motor overtemperature timer 
Maximum 0.1 s; for the bimetallic switch, you must select a timer of 0.1 s to ensure that the motor is 
reliably shutdown. 
If the timer has expired, then fault F07011 is output. 

Testing temperature sensors for interconnection via the thermistor motor protection device 
To test the PTC connection, remove at least one contact. F07011 is displayed after the time 
set in p0606 has expired (in this case, 0.1 s). 
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2.13.6 Determining the angular commutation offset 
 

CAUTION  
When the system is commissioned for the first time before adjusting the angular 
commutation offset, it is possible that the drive could be completely incorrectly 
commutated. Current is fed into the motor at the incorrect time for an incorrectly 
commutated motor. As a consequence, it can make unintentional movements, for example 
it can rotate at a high speed in the incorrect direction. 

As a consequence, for safety reasons you must limit the current to 20% of the maximum 
motor current using parameter p0640. 

 

 

You can determine the pole position, required for synchronous motors, for the SIMOTICS T-
1FW6 built-in torque motors using a software-based automatic pole position identification 
technique. 

The following two techniques are suitable for all frame sizes of SIMOTICS T-1FW6 built-in 
torque motors: 

● The motion-based technique p1980 = 10 

● The saturation-based technique (1st harmonic) p1980 = 1 

Also refer to the information in Chapter General information for setting the commutation 
(Page 172). 

Parameter entries / commutation setting 

Incremental measuring system 

Set the drive enable signals (OFF3, OFF2, OFF1). This results in coarse synchronization. A 
successful coarse synchronization is indicated by the parameter r1992.9. Then select the 
automatic determination of the angular commutation offset using p1990 = 1. Alarm A07971 
is output while the angular commutation offset is being determined. You must then move the 
drive over the zero mark. When the zero mark is passed, the angular commutation offset is 
entered into p0431. p1990 is automatically set to 0 after the angular commutation offset has 
been determined. Alarm A07965 is displayed as a prompt to save the change in a non-
volatile fashion. 

Absolute measuring system 

Set p1990 = 1 before activating the enable signals. By activating the enable signals, the 
angular commutation offset is entered into p0431 and p1990 is automatically set to 0. Alarm 
A07965 is displayed as a prompt to save the change in a non-volatile fashion. 
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2.13.6.1 Checking the angular commutation offset 
 

WARNING  
Danger as a result of an incorrectly commutated drive 

An incorrectly commutated drive can result in loss of torque, increased temperature rise 
and uncontrolled motion of the drive.  

Therefore, to complete commissioning, it is imperative that you check the angular 
commutation offset according to the following description! 

 

Coarse synchronization means that the pole position identification has been carried out, but 
the drive has not yet been moved over the zero mark. After the drive has been moved over 
the zero mark, the drive is finely synchronized. Fine synchronization is omitted when an 
absolute measuring system is being used. 

Checking the pole position identification 
You can check the pole position identification with p1983 in the finely-synchronized state. 

Position the drive at different points in an electrical period (pole pitch) and set parameter 
p1983 = 1. This means that a pole position identification is performed again and the 
deviation determined is displayed in parameter p1984. 

After completion of the pole position identification, parameter p1983 is set to 0 again. The 
angular difference read out of parameter p1984 must lie in the interval [- 10°...+10°]. If the 
average value of the measured angular differences is greater than + 10°, then the average 
value must be added to the angular commutation offset entered in p0431 (see Figure 2-66 
Tolerance envelope for the pole position angle (Page 204)).  

If the average value of the measured angular difference is less than - 10°, then the average 
value must be subtracted from the angular commutation offset entered in p0431. For a 
change to parameter p0431, p0010 must be set to 4. 

You must again perform coarse and fine synchronization. The fine synchronization is not 
applicable for an absolute measuring system. 

See also 
Checking the angular commutation offset by making a measurement (Page 195) 
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2.13.6.2 Checking the angular commutation offset by making a measurement 
 

DANGER  
Risk of electric shock when working on the DC link! 

After opening the line switch, hazardous DC link voltages can always be present. 

Observe the warning information on the component! 

Check the voltage using a voltmeter (CAT III) between the motor terminals U - V; V - W; U -
 W (DC voltage measuring range up to at least 600 V). 

 

Checking the EMF voltages 
If you have commissioned the built-in torque motor according to the appropriate instructions, 
and in spite of this, unexpected messages are output, then initially you must check the 
individual EMF voltages of the built-in torque motor. To do this, the following techniques are 
described: 

● Technique, "Recording the phase voltage and pole position angle using an oscilloscope" 

● Technique, "Tracing the phase voltage and pole position angle" using the trace function 
of the STARTER commissioning tool 

Technique, "Recording the phase voltage and pole position angle using an oscilloscope" 
1. Switch the drive line-up into a no-current condition. 

2. After the DC link has completely discharged, disconnect the motor cables from the 
converter. 
If motors are connected in parallel, then disconnect them. 

3. Form an artificial neutral point using 1 kΩ resistors (for a parallel connection, for each 
motor). 
 

 
Figure 2-56 Arrangement for checking using measurements 

4. Turn the rotor with the most constant speed possible in the clockwise direction. The rotor 
is turning in a clockwise direction if, when viewing the DE flange, it rotates clockwise (see 
also the Configuration Manual "SIMOTICS T-1FW6" built-in torque motors, Chapter 
"Technical features"). 
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Checking the phase sequence, EMF phase U - EMF phase V - EMF phase W 
For a positive direction of rotation of the drive, the phase sequence must be EMF phase U - 
EMF phase V - EMF phase W 

Checking the phase position, EMF phase U - EMF phase V - EMF phase W 
In the following diagram, the phase shift of the individual voltages with respect to each other 
is 120°. 

 
Figure 2-57 Phase sequence, EMF phase U - EMF phase V - EMF phase W 
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Checking the phase position, EMF phase U - EMF phase V - EMF phase W for parallel motors 
The phase positions of the individual motors with respect to each other must match: 

● EMF phase U motor 1 with EMF phase U motor 2 

● EMF phase V motor 1 with EMF phase V motor 2 

● EMF phase W motor 1 with EMF phase W motor 2 

The deviation within a particular phase position may be a maximum of 10°. 

 
Figure 2-58 Phase U motor 1 may not lag behind EMF phase U motor 2 by more than 10 ° 
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Figure 2-59 EMF phase U motor 1 may not lead EMF phase U motor 2 by more than 10 ° 

Determining the angular commutation offset using a measurement. 
In the event of a fault and for a parallel connection, you must check the angular commutation 
offset as follows. 

The drive with an incremental measuring system must be finely synchronized. This means 
that if required, you must connect the motor and set the controller enable so that coarse 
synchronization can be performed. Then move the drive over the zero mark. As described 
under the technique "Recording the phase voltage and pole position angle using an 
oscilloscope " you must bring the drive into a no-current condition. Please note that for this 
technique, it is not permissible that the control voltage for the Control Unit is shut down; 
however the infeed must be disconnected from the line supply 

 

DANGER  
Risk of electric shock when working on the DC link! 

After opening the line switch, hazardous DC link voltages can always be present. 

Observe the warning information on the component! 

Check the voltage using a voltmeter (CAT III) between the motor terminals U - V; V - W; U -
 W (DC voltage measuring range up to at least 600 V). 
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You can determine the angular commutation offset by measuring the EMF and the 
normalized electrical pole position angle via the analog output. The normalized electrical 
pole position angle allows you to parameterize the test socket connections T0 to T2 and 
retrieve the signals. 

Definition of channels (Ch1 ... Ch4): 

● Ch1: EMF phase U with respect to the neutral point 

● Ch2: EMF phase V with respect to the neutral point 

● Ch3: EMF phase W with respect to the neutral point 

● Ch4: Normalized electrical angular pole position via analog output 

 
Figure 2-60 Setting measuring socket T0 on CU320 

The status of the coarse and fine synchronization can be read out online via parameter 
r1992: r1992.8 (fine synchronization carried out) and r1992.9 (coarse synchronization carried 
out). 
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Figure 2-61 Ideal characteristic of EMF voltages and the pole position angle of an optimally commutated drive 

Technique, "Recording the phase voltage and pole position angle" using the trace function of the 
STARTER commissioning tool 

An oscilloscope is not used for this technique. You do not need to disconnect the motor. 
However, this technique is less accurate, as the motor voltages are not directly measured, 
but calculated from the transistor turn-on duration. This technique is not permitted for parallel 
motors, see Chapter "Special case parallel connection (Page 206)". 

You must set the following parameters: 

 
Figure 2-62 Assignment of trace channels to check the angular commutation offset 
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The drive is operated in the open-loop torque controlled mode. The following 
parameterization is required:  

1. Set p1501 = 1, to switch over the speed/torque control. 

2. Set p0640 = 0 to limit the motor current to 0. 

3. Set p1545 = 1, to activate the travel to fixed stop. 

4. The motor must be in closed-loop control and rotated externally. 

 
Figure 2-63 Example of an optimally commutated drive (recorded using the trace function of the 

STARTER commissioning tool, refer to the previous diagram for the color 
assignment) 
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Evaluation of the results (applies to both measuring techniques) 
For a positive drive direction (definition, refer to the diagram "Determining the positive 
direction of the drive (Page 185)", the sawtooth must increase monotonously between 0° and 
360°, refer to the diagram "Ideal characteristic of the EMF voltages and the pole position 
angle for an optimally commutated drive (Page 200)." 

If the curve is falling monotonously, and the phase sequence is EMF phase U - EMF phase 
V - EMF phase W, then you must change the control sense of the drive if necessary via 
p0410 bit 0 "Invert speed actual value". If the position controller is being used, then you must 
also check p0410 bit 1 "Invert position actual value". 

 
Figure 2-64 EMF for incorrect speed actual value inversion 

If the curve is monotonously decreasing, and the phase sequence is EMF phase U – 
EMF phase W – EMF phase V (i.e. if the phase sequence of V and W is interchanged), then 
according to the diagram "Determining the positive direction of the drive" in Chapter 
"Parameterizing a motor and encoder", the drive direction is negative (i.e. when viewing the 
DE flange the axis is rotating counterclockwise). 
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Figure 2-65 EMF for counterclockwise direction of rotation 
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Displaying the commutation angle tolerance 
For a finely synchronized drive, the difference between EMF phase U and the normalized, 
electrical pole position angle may be maximum of 10°. This means that the zero points of the 
falling edge of the sawtooth and EMF phase U may differ by a maximum of 10° electrical. 
For motors connected in parallel, this maximum deviation for the EMF, phase U is valid for 
each motor connected in parallel. 

If the difference is greater, then you must adapt the angular commutation offset. If, when 
passing the zero mark, fault message "F31130 (N, A) encoder 1: Zero mark and position 
error from the coarse synchronization" is output, then the deviation of the commutation is 
greater than 60° electrical. You must check the commutation angle again using the 
techniques described. 

 
Figure 2-66 Tolerance envelope for the pole position angle 
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Commutation angle outside the tolerance 
Example: The falling edge of the sawtooth voltage (pole position angle) leads the zero 
crossing of EMF phase U by approx. 18° electrical. 

 
Figure 2-67 Example of an incorrectly commutated drive 

Adapt the incorrect commutation shown in the diagram above according to the Chapter 
"Checking the angular competition offset (Page 194)". 

p0431 = p0431 - 18 

See also 
Parameterizing a motor and encoder (Page 173) 

Checking the angular commutation offset by making a measurement (Page 195) 
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2.13.7 Special case of a parallel connection 
 

 Note 
Parallel connection 

Only torque motors that are the same size and have the same current requirements (same 
winding design) can be connected in parallel. The order designations (MLFB) of the motors 
must only differ with regard to the position "component (position of the interfaces)". 

For more information and connection diagrams, refer to the Configuration Manual 
"SIMOTICS T-1FW6 built-in torque motors in Chapter "Coupled motors". 

 

The following requirements must be met in order to operate several torque motors in parallel 
on a SINAMICS Motor Module: 

● The motors must be arranged according to the data in the Configuration Manual 
"SIMOTICS T-1FW6 built-in torque motors". 

● The direction of rotation of parallel motors must match the data in the Configuration 
Manual "SIMOTICS T-1FW6 built-in torque motors". For a Janus arrangement, when 
connecting the stoker, phases V and W must be interchanged so that the stoker has the 
same direction of rotation as the master, also refer to the Configuration Manual 
"SIMOTICS T-1FW6 built-in torque motors" Chapter "Power and signal connection for 
parallel operation". 

● Ensure the position of the EMF voltages of the parallel motors as described under 
Chapter "Checking the angular commutation offset by taking measurements (Page 195)"; 
it is imperative that you check these carefully. Maintain the maximum deviation of the 
phase angle between the EMF voltages of the motors according to Chapter "Check 
angular commutation offset by taking measurements". You may only connect the motors 
to the converter after the deviation of the commutation angle for all of the motors to be 
connected in parallel lies within the limit value. 

● Before commissioning and switching-on the DC voltage for the first time, note that the 
temperature monitoring circuits must be carefully checked to ensure that they correctly 
trip. 

Then commission the system using the STARTER commissioning tool according to Chapter 
"Parameterizing a motor and encoder (Page 173)". The parallel connection for the 
SIMOTICS T-1FW6 built-in torque motors selected from the motor list can only be 
parameterized in the expert list of the drive. 

After completing the configuration, in the STARTER commissioning tool, open the expert list 
of the drive and assign parameter p0306 = N, where N is the number of motors to be 
operated in parallel. The number of motors set must correspond to the number of motors that 
are actually connected in parallel.  

After changing p0306, you must unconditionally adapt the control parameters using 
automatic calculation with p0340 = 1, see also help for parameter p0306 in the STARTER 
commissioning tool. 
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If p0306 is changed during quick commissioning (p0010 = 1), then the maximum current 
p0640 is appropriately pre-assigned. This is not the case in the motor commissioning (p0010 
= 3)! 

The motor data displayed in the STARTER commissioning tool is only valid for one motor 
and is only internally interpolated up to N motors connected in parallel. 

2.13.8 Optimization of the closed-loop control 
When running through the drive configuration, in the step "Calculating the motor/controller 
data", drive-specific controller parameters are calculated, see the diagram "Screen form to 
calculate motor/controller data (Page 179)" However, to be able to use the optimal 
performance of the machine, a subsequent optimization of the controller parameters is 
required. Higher positioning/machining accuracy can be achieved and cycle times can be 
reduced by means of optimized settings. 

Controller optimization may only be performed by experienced specialists. 

In the control, for optimizing the controller, there is the possibility of measuring frequency 
responses or recording setpoint steps. Especially the frequency response measurement 
allows machine-specific natural frequencies that restrict the bandwidth of the closed-loop 
control to be taken into account, .  

You can ask your local Siemens office regarding optimization of the closed-loop control as a 
service. 

See also 
Parameterizing a motor and encoder (Page 173) 
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2.14 Notes on commissioning SSI encoders 

Using error bits 
The number and position of error bits may vary for SSI encoders. In the event of faults, error 
codes may even sometimes be transferred within the position information.  

It is therefore essential that you assess all the error bits present (see "Parameterization" and 
"Limitations" in this chapter) as otherwise an error code may be interpreted as position 
information if faults are present. 

Hardware requirements 
● SMC20 Sensor Module Cabinet-Mounted 

● SME25 Sensor Module External 

● SMC30 Sensor Module Cabinet-Mounted 

● CU320-2 Control Unit 

Types of encoder that can be connected  

Table 2- 21 Overview of encoder types that can be connected depending on the SIEMENS evaluation module  

Encoder 
evaluation 
using the module 

Incremental tracks Absolute position Voltage supply for 
encoder 

SSI baud rate Remarks 

SMC20 sin/cos, 1 Vpp SSI not cyclic 1) 5 V 100 kBaud - 
SME25 sin/cos, 1 Vpp SSI not cyclic 1) 5 V 100 kBaud SME25 is only 

suited to direct 
measuring 
systems 

SMC30 Square or  
no incremental 
tracks 

SSI not cyclic 1), 3) 
SSI, cyclic 2) 

5 V or 24 V 100-
250 kBaud 

- 

1) "not cyclic" means that the absolute position is only read when initializing the Sensor Module, after which the position is 
only calculated by the incremental tracks. 
2) "cyclic" means that the absolute position is read permanently (usually in the PROFIBUS or position controller cycle) and 
the position (X_IST1) formed from this. 
3) the SSI protocol is cyclically read-out for the plausibility checks 
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 Note 

Only encoders that support a transfer rate of 100 kHz and that have a high level in idle state 
may be used. 

The monoflop time should be parameterized such that it is greater than or equal to the 
specified monoflop time of the encoder. This must lie in the range between 15 – 30 µs. 

The level during the monoflop time must be low. 
 

Ramp-up time of the encoder 
In order to ensure that the correct sensor data is received, the encoder evaluation module 
checks whether the connected encoder is activated and ready for operation:  

● After the power supply is switched on at the encoder, no signals are evaluated for a 
waiting period of 800 ms. 

● After the waiting period has expired, test signals are applied to the clock cable and the 
response of the data line observed. As long as the encoder is not ready, the encoder 
holds the data line permanently in the idle state (as a rule, "high"). 
It is expected that the encoder has reached its ready state by this time. 

● If the encoder has not signaled that it is in the ready state after approx. 10 seconds, the 
encoder evaluation module signals a timeout error. 

The waiting period starts again when: 

● The 5 V power supply is applied to the encoder. 

● Switchover to 24 V power supply after completed ramp-up of the encoder evaluation in 
accordance with the parameterized voltage level. 

 

 Note 

The activation routine is started each time that the encoder is inserted. The activation routine 
has been completed with the ready message to the evaluation module. 

 

 Note 

An external 24 V encoder supply is permitted. 
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Parameterization 
Predefined encoders 

Various predefined SSI encoders are available for commissioning. These can be selected in 
the commissioning windows of the STARTER commissioning tool. 

User-defined encoders 

If there are no predefined entries for the encoder used, user-defined encoder data can be 
entered via windows using the commissioning wizard. 

Special settings 
● Error bits (special case, several error bits) 

If an SSI encoder has several error bits, the evaluation is activated in the list of experts as 
follows using parameter p0434[x]: 

Value = dcba 
ba: Position of error bit in protocol (0 ... 63) 
c: Level (0: Low level 1: High level) 
d: Status of evaluation (0: Off, 1: On with 1 error bit, 2: On with 2 error bits ... 9: On with 9 
error bits) 

For several error bits, the following applies: 

– The position specified under ba and the additional bits are assigned in ascending 
order. 

– The level set under c is applicable for all error bits. 

Example: 

p0434 = 1013 
--> the evaluation is activated, and the error bit is at position 13 with low level. 

p0434 = 1113 
--> the evaluation is activated, and the error bit is at position 13 with high level. 

p0434 = 2124 
--> the evaluation is activated, and the 2 error bits are at a high level from position 24. 

● Fine resolution p0418 and p0419 

In order to make full use of the entire traversing range of the absolute encoder, the 
position information, including fine resolution, must not exceed 32 bits. 

Example: 

An SSI encoder without incremental tracks is used. The encoder has a singleturn 
resolution of 16 bits and a multiturn resolution of 14 bits. The absolute position resolution 
is therefore 30 bits.  

Consequently, only a fine resolution of 2 bits can be set. Parameters p0418[x] and 
p0419[x] in the list of experts should therefore be set to the value 2. 
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Diagnostics 
Example 1 

An SSI encoder without incremental tracks is used. The encoder has a singleturn resolution 
of 16 bits and a multiturn resolution of 14 bits. The fine resolution p0418[x] and p0419[x] is 
set to the value 2. In parameter r0482[x] (X_IST1), the product is formed from "pulses per 
revolution" and fine resolution p0418[x]. If using SSI encoders without incremental tracks, the 
number of pulses and singleturn resolution are identical. In our example, the actual position 
value X_IST1 (r0482[x]) must therefore have changed by the following value after one 
encoder revolution:  
Single turn resolution * fine resolution = 216 * 22 = 262144 

Example 2 

An SSI encoder with incremental tracks is used. In this case, incorrect SSI protocol settings 
can be seen, e.g. by the fact that once the system has been switched on a different absolute 
position is indicated from that before it was last deactivated. 

The absolute position X_IST2 (r0483[x]) must be considered by way of a check. Following 
PROFIdrive, however, just one value is displayed in this parameter if bit 13 (request absolute 
value in cycles) is set to the value 1 in the encoder control word p0480[x]. 

This bit can be set, e.g. with the aid of the binector-connector converter. 

Once switched on, the SSI encoder is now turned a few revolutions. Once switched off and 
on again, the absolute position of X_IST2 (r0483[x]) must indicate an unchanged value. Only 
minor deviations may occur in the fine resolution area. 
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2.15 Notes on the commissioning of a 2-pole resolver as absolute 
encoder 

Description  
You can use 2-pole (1 pole pair) resolvers as singleturn absolute encoders. The absolute 
encoder position actual value is provided in Gn_XIST2 (r0483[x]).  

Actual position value format  

The factory setting for the fine resolution of Gn_XIST1 differs from the fine resolution in 
Gn_XIST2 (p0418 = 11, p0419 = 9). This may cause a slight displacement of the encoder 
position after switching the drive unit off/on. 

Therefore, when using a 2-pole resolver as an absolute encoder, we recommend that the 
fine resolution for Gn_XIST1 (p0418) is set the same as the fine resolution for Gn_XIST2 
(p0419), e.g. p0418 = p0419 =11. 

2-pole resolvers are automatically entered in the PROFIdrive profile (r0979) as singleturn 
absolute encoders. 

Position tracking  

You can also activate position tracking for a 2-pole resolver. Please note, however, that the 
resolver may not be moved more than half an encoder revolution (pole width) when switched 
off. The activation and configuration of the position tracking is described in the chapter 
"Position tracking". 

EPOS - absolute encoder adjustment  

If the 2-pole resolver is used as an absolute encoder for basic positioning (EPOS), the 
absolute encoder adjustment must be performed: 

● In the STARTER commissioning tool (Basic positioner → Referencing) or 

● In the Expert list. 

To do this, set reference point coordinate p2599 to the value corresponding to the 
mechanical system and request the adjustment with p2507 = 2. 

You will then need to back up the data from RAM to ROM.  
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2.16 Temperature sensors for SINAMICS components 
 

DANGER  
Risk of electric shock 

Only temperature sensors that meet the electrical separation specifications laid out in 
EN 61800-5-1 may be connected to terminals "+Temp" and "-Temp". If safe electrical 
separation cannot be guaranteed (e.g. for linear motors or third-party motors), a Sensor 
Module External SME120, SME125 or the Terminal Module TM120 must be used. If these 
instructions are not complied with, there is a risk of electric shock! 

 

The following table provides an overview of the SINAMICS drive system components 
available with temperature sensor connections.  

Table 2- 22 Temperature sensor connections for SINAMICS components 

Module Interface Pin Signal name Technical specifications 
SMC10/SMC20 X520 (sub D) 13 

25 
+Temp 
- Temp 
 

Temperature sensor  
KTY84-1C130 / PTC 

X520 (sub D) 
Temperature 
channel 2 

1 
8 

+Temp 
- Temp 

Temperature sensor 
KTY84-1C130 / PTC / bimetallic 
switch with NC contact 

SMC30 

X531 (terminal) 
temperature 
channel 1 

3 
4 

- Temp 
+Temp 

Temperature sensor 
KTY84-1C130 / PTC / bimetallic 
switch with NC contact 

X23 (sub D) 1 
8 

+Temp  
- Temp 

Temperature sensor  
KTY84-1C130 / PTC 

CU310-2 DP 
CU310-2 PN 

X120 (terminal) 1 
2 

+Temp  
- Temp 

Temperature sensor  
KTY84-1C130 / PTC 

CUA31 X210 (terminal) 1 
2 

+Temp  
- Temp 

Temperature sensor  
KTY84-1C130 / PTC 

X210 (terminal) 
Temperature 
channel 2 

1 
2 

+Temp  
- Temp 

Temperature sensor 
KTY84-1C130 / PTC / bimetallic 
switch with NC contact 

CUA32 

X220 (sub D) 
Temperature 
channel 1 

1 
8 

+Temp  
- Temp 

Temperature sensor 
KTY84-1C130 / PTC / bimetallic 
switch with NC contact 

TM31 X522 (terminal) 7 
8 

+Temp 
- Temp  

Temperature sensor  
KTY84-1C130 / PTC 

1 
2 

- Temp 
+Temp 

3 
4 

- Temp 
+Temp 

5 
6 

- Temp 
+Temp 

TM120 X524 (terminal) 

7 
8 

- Temp 
+Temp 

Temperature sensor connection 
KTY84-1C130 / PTC/bimetallic 
switch with NC contact 
for linear motor applications, here 
the motor temperature sensor 
connect KTY84-1C130 
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Module Interface Pin Signal name Technical specifications 
X531 1 

2 
3 
4 

+Temp 
- Temp 
+Temp 
- Temp 

X532 1 
2 
3 
4 

+Temp 
- Temp 
+Temp 
- Temp 

X533 1 
2 
3 
4 

+Temp 
- Temp 
+Temp 
- Temp 

X534 1 
2 
3 
4 

+Temp 
- Temp 
+Temp 
- Temp 

X535 1 
2 
3 
4 

+Temp 
- Temp 
+Temp 
- Temp 

TM150 

X536 1 
2 
3 
4 

+Temp 
- Temp 
+Temp 
- Temp 

KTY84-1C130/PTC/bimetallic NC 
contact/-PT100/PT1000 
Information on interconnecting the 
temperature channels can be 
found below. 

SME20 Measuring system  
interface 

7 
9 

- Temp 
+Temp 

Temperature sensor  
KTY84-1C130 / PTC 
connection cable with order 
number 6FX8002-2CA88- xxxx 
necessary 1) 

X200 (connector) 
Temperature 
channel 2 

1 
2 

- Temp  
+Temp  

Temperature sensor 
KTY84-1C130 / PTC / bimetallic 
switch with NC contact 

X200 (connector) 
Temperature 
channel 3 

3 
4 

+Temp 
- Temp 

Temperature sensor 
KTY84-1C130 / PTC / bimetallic 
switch with NC contact 

SME120/SME125 

X200 (connector) 
Temperature 
channel 4 

5 
6 

+Temp 
- Temp 

Temperature sensor 
KTY84-1C130 / PTC / bimetallic 
switch with NC contact 

Booksize 
X21 (terminal) 

1 
2 

+Temp  
- Temp 

Active Line Module 

Chassis 
X41 (terminal) 

4 
3 

+Temp  
- Temp 

Active Line Module temperature 
sensor 
Temperature switch type: 
bimetallic switch with NC contact 

Booksize 
X21 (terminal) 

1 
2 

+Temp  
- Temp 

Smart Line Module 

Chassis 
X41 (terminal) 

4 
3 

+Temp  
- Temp 

Active Line Module temperature 
sensor 
Temperature switch type: 
bimetallic switch with NC contact 

Booksize 
X21 (terminal) 

1 
2 

+Temp  
- Temp 

Basic Line Module 

Chassis 
X41 (terminal) 

4 
3 

+Temp  
- Temp 

Basic Line Module temperature 
sensor temperature switch type: 
bimetallic switch with NC contact 
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Module Interface Pin Signal name Technical specifications 
Booksize 
X21/X22 (terminal) 

1 
2 

+Temp  
- Temp 

Motor Module 

The following 
applies to chassis: 
X41 (terminal) 

4 
3 

+Temp  
- Temp 

Temperature sensor  
KTY84–1C130 / PTC 
Bimetallic switch with NC contact: 
Alarm and timer (only for 
temperature evaluation via MM) 
PT100 temperature sensor 

1) Cable for connection to direct measurement systems: Order number 6FXx002-2CB54-xxxx 

Commissioning information 
The index [0..n] used in the following identifies either the motor data set or the encoder data 
set. 

SMC10/SMC20  

You can use the STARTER screen (\signals and monitoring \ motor temperature) to 
parameterize the motor temperature evaluation via SUB-D socket X520.  

SMC30 (from Order No. 6SL3055-0AA00-5CA2)  

In addition to temperature evaluation via terminal X531 (temperature channel 1), this module 
also has temperature evaluation at SUB-D socket X520 (temperature channel 2). 

At the default setting (p0600 = 1 "Temperature via encoder 1" and p0601 = 2 "KTY") the 
temperature is evaluated via the first temperature channel. The temperature sensor is 
connected to terminal X531 on the SMC30. The temperature is shown via r0035. 

The parameterization of the motor temperature evaluation via the sub D socket X520 must 
be performed in the expert list as follows: 

● p0600[0..n]: Selection of the encoder (1, 2 or 3) to which the SMC30, that is used for the 
temperature evaluation, is assigned (n = motor data set). 

● p0601[0..n] = 10 (evaluation via several temperature channels), n = motor data set. 

● p4601[0..n]: Select the temperature sensor type for temperature channel 2 (depends on 
encoder data set n, not motor data set). 

  Note 

With several encoders, the index [n] of the relevant encoder / encoder data set, via which 
the temperature evaluation is performed, must be used. 

The temperature is displayed in parameter r4620[1] (temperature channel 2). For multiple 
temperature channels (use of temperature channels 1 and 2 on SMC30), parameter r0035 
shows the maximum temperature. 
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Example: 

A KTY temperature sensor is connected at the sub D socket X520 on the SMC30 of Encoder 
1.  

This is parameterized via: 

● p0600[0..n] = 1 / p0601[0..n] = 10 / p4601[0..n] = 20 

Both temperature channels (X520 and X531) can be used at the same time. In addition to 
the above parameterization, the sensor type of the temperature sensor connected at terminal 
X531 must be entered in p4600[0..n]. The maximum value is then generated for the motor 
temperature and displayed in r0035. 

 

 Note 

With several encoders, the index [n] of the relevant encoder / encoder data set, via which the 
temperature evaluation is performed, must be used. 

 

CU310-2 DP/CU310-2 PN  

The Control Unit 310-2 has an integrated SMC30 encoder interface. This encoder interface 
is accessed via the 15-pin Sub-D-contact X23 and is evaluated as temperature channel 1. 
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There are three options available to evaluate the temperature: 

 
Option The following parameter settings must be made: 
Temperature channel 1 via the SMC30 
encoder interface X23. 

• p0600[0..n] = 1: Selects the encoder (1, 2 or 3), which is assigned to 
encoder interface X23 and via which the temperature is evaluated (n = 
motor data set). 

• p0601[0..n] = 1 or 2: Selection of the temperature sensor type, n = motor 
data set 

• r0035: Display of the temperature value. 

Temperature channel 1 via terminal X120, 
for example, if an encoder is being used. 

• p0600[0..n] = 11: Activation from temperature channel 1 via terminal 
X120 

• p0601[0..n] = 1 or 2: Selection of the temperature sensor type, n = motor 
data set 

• r0035: Display of the temperature value. 

Two temperature channels via X23 and 
X120. Encoder interface X23 is assigned to 
temperature channel 1 and terminal X120 is 
assigned to temperature channel 2. 

• p0600[0..n] = 1: Selects the encoder (1, 2 or 3), which is assigned to 
encoder interface X23 and via which the temperature is evaluated (n = 
motor data set). 

• p0601[0..n] = 10: Evaluation via several temperature channels 
• p4600[0..n]: Selection of the temperature sensor type from temperature 

channel 1, n = encoder data set 
• p4601[0..n]: Selection of the temperature sensor type from temperature 

channel 2, n = encoder data set 
• r4620[0...3]: Reading the temperature values. 

– Index n = 0 temperature channel 1 
– Index n = 1 temperature channel 2 

• r0035: Display of the higher temperature value of temperature channels 
1 and 2. 

CUA31  

The parameterization of the temperature evaluation via terminal X210 can be performed 
using the STARTER screen (messages and monitoring > motor temperature). "Temperature 
sensor via Motor Module (11)" should be selected in the "Temperature sensor selection" 
field. The temperature of the sensor is displayed in r0035. 

CUA32 

The parameterization of the temperature evaluation via terminal X210 or sub D socket X220 
is performed using two temperature channels. 

p0600 = 11: Temperature sensor via Motor Module 

For the SINAMICS S120 AC Drive (AC/AC) and if Control Unit Adapter CUA31/CUA32 is 
used, the temperature sensor connection is on the adapter (X210). 
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TM31  

A Terminal Module 31 (TM31) is used when additional digital and analog inputs/outputs 
required. The sensor type used is set via p4100 and the temperature signal interconnected 
via r4105.  

TM120  

If the temperature sensors in the installed motors do not have protective separation, then 
you require a Terminal Module 120 (TM120). Up to 4 different temperature sensors can be 
connected to the TM120. The TM120 senses the temperature values, evaluates them, and 
sends them via DRIVE-CLiQ to the Control Unit. The temperature actual values measured 
using KTY84 are evaluated in the range from -140 °C ... +188.6 °C. Temperature actual 
values outside this range are not taken into account. The fault and alarm thresholds (p4102) 
of the temperature values can be set from -48 °C up to 251°C.  

Settings for the measurement: 

● With p0600 = 20 or 21, the motor temperature sensing is activated using an external 
sensor. 

● With p0601 = 11, the evaluation is set over several temperature channels. 

● In p0604, the motor temperature alarm threshold is set. 

● In p0605, the motor temperature fault threshold is set. 

● With p0608 and p0609, the temperature channels are assigned to the signal sources for 
the motor temperatures. 

– With p4100[0...3] = 1, temperature sensor type PTC is set to the corresponding 
channel 1 to 4 and the evaluation activated. 

– With p4100[0...3] = 2, temperature sensor type KTY84 is set to the corresponding 
channel 1 to 4 and the evaluation activated. 

– With p4100[0...3] = 4, the temperature sensor type bimetal NC contact is set and the 
evaluation activated. 

● The actual resistance value of the particular temperature sensor is displayed in 
parameter r4101[0...3]. 

● The temperature actual value of the temperature evaluation is displayed in parameter 
r4105[0...3]. If no sensor has been selected, or if the temperature actual value is invalid, 
then the value -300 °C is in parameter r4105[0...3]. 

● With p4610[0...n] to p4613[0...n], the temperature sensors are assigned to the motor and 
the response defined. 
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TM150  

The Terminal Module 150 (TM150) has 6x 4-pole terminals for temperature sensors. 
Temperature sensors can be connected in a 2, 3 or 4-wire system. Up to 12 input channels 
can be evaluated if two 2-wire sensors are connected to the 4 poles at the input terminal 
strips. Twelve (12) input channels can be evaluated in the factory setting. The temperature 
channels of a TM150 can be subdivided into 3 groups and evaluated together. 

When using 2-wire sensors, to increase the measuring accuracy, the cable resistance can 
be measured and saved. To do this, short-circuit the sensor cable as close as possible to the 
sensor. The procedure is described in the SINAMICS S120/150 List Manual under 
p4109[0...11]. The measured cable resistance is then taken into account when evaluating 
the temperature. The cable resistance value is saved in p4110[0...11]. 

The TM150 can acquire the signals from KTY84, PTC, bimetallic NC contact, PT100 and 
PT1000 temperature sensors and evaluate them. The fault and alarm thresholds of the 
temperature values can be set from -99 °C to 251°C. The temperature sensors are 
connected at terminal strip X531 to X536 according to the table above. For further 
information on the configuration and the connections, refer to the function diagrams 9625, 
9626 and 9627 in the SINAMICS S120/S150 List Manual. 

● p4100[0...11] sets the sensor type for the respective temperature channel. 

 

Value of p4100[0...11] Temperature sensor Temperature display range r4105[0...11] 
0 Evaluation disabled - 
1 PTC thermistor -50°C or +250°C 
2 KTY84 -99°C to +250°C 
4 Bimetallic NC contact -50°C or +250°C 
5 PT100 -99°C to +250°C 
6 PT1000 -99°C to +250°C 

● r4105[0...11] indicates the actual value of the temperature channel. 

For switching temperature sensors, such as PTC and bimetallic NC contact, two limit 
values are displayed symbolically: 

– r4105[0...11] = -50°C: The actual temperature value is below the rated response 
temperature. 

– r4105[0...11] = +250°C: The actual temperature value is above the rated response 
temperature. 

  Note 
For PTC and bimetal NC contact the following applies 

What is shown in r4105[0...11] does not correspond to the actual temperature value. 

● With p4108[0...5] = 0, you evaluate a sensor in a 2-wire system at a 4-wire connection at 
terminals 1 and 2. Terminals 3 and 4 remain open. 
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● With p4108[0...5] = 2, you evaluate a sensor in a 3-wire system at a 4-wire connection at 
terminals 3 and 4. The measuring cable is connected to terminal 1. You must short-circuit 
terminals 2 and 4. 

● With p4108[0...5] = 3, you evaluate a sensor in a 4-wire system at a 4-wire connection at 
terminals 3 and 4. The measuring cable is connected to terminals 1 and 2. 

You can find additional information in function diagram 9626 in the SINAMICS S120/S150 
List Manual and in the SINAMICS S120 Function Manual Drive Functions in Chapter 
"Thermal motor protection". 

SME20  

The evaluation of KTY or PTC temperature sensors can be parameterized using the 
STARTER screen (Messages and monitoring > Motor temperature): 

● Temperature sensor selection (≙ p0600[0..n]): Selection of the source to which the SME 
module is assigned (temperature sensor via encoder (1, 2 or 3), temperature sensor via 
BICO interconnections or temperature sensor via Motor Module) 

● Temperature sensor type (≙ p0601[0..n]): Sets the sensor type for motor temperature 
monitoring. 

 
Figure 2-68 Selection of temperature sensor for SME20 modules 

SME120/SME125  

For modules with several temperature sensor connections (SME Modules), the temperature 
sensor is selected depending on encoder data set n via parameters p4601[0..n]..p4603[0..n]. 
A maximum of three motor temperature sensors can be evaluated simultaneously via 
terminal X200.  

The parameterization of the motor temperature evaluation via terminal X200 must be 
performed in the expert list as follows: 

● p0600[0..n]: Selection of the encoder (1, 2 or 3) to which the SME Module, that is used 
for the temperature evaluation, is assigned (n = motor data set). 

● p0601[0..n] = 10 (evaluation via several temperature channels), n = motor data set. 
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● p4601[0..n]-p4603[0..n]: Select the temperature sensor type of temperature channels 2-4, 
depending on encoder data set n. 
Only temperature channels 2-4 are available at terminal X200. 

● Parameter r4620[0...3] Motor temperatures SME 
is used to display the current temperatures in the motor, measured via an SME120 or 
SME125. The indices mean: 
[1] = SME temperature channel 2 / motor temperature sensor 2 
[2] = SME temperature channel 3 / motor temperature sensor 3 
[3] = SME temperature channel 4 / motor temperature sensor 4 

Diagnostic parameters r0458[0...2] Sensor Module properties 

Index [0...2]: Encoder 1...encoder 3 

Parameter r0458 allows the following properties to be queried at the temperature sensor 
modules: 

 
Bit  Feature 
02 Temperature sensor connection present 
03 Connection for PTC for motors with DRIVE-CLiQ also present 
04 Module temperature available 
08 Evaluation set up across several temperature channels 

 

Selection of several temperature channels p4601 ... p4603 is only possible, for example, 
when parameter p0601 = 10 is set. This can be checked using the entry r0458.8 = 1. 

You can find further information on parameter r0458 in: SINAMICS S 120/S150 List Manual. 

Active Line Module, Basic Line Module, Smart Line Module, Motor Module (chassis) 

Parameter p0601 "Motor temperature sensor type" enables the setting for the sensor type for 
the temperature measurement at input X21 (booksize) or X41 (chassis). The measured 
value is displayed in r0035. 
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Faults and alarms  

F07011 drive: Motor overtemperature 

KTY sensor: 
The motor temperature has exceeded the fault threshold (p0605) or the timer stage (p0606) 
after the alarm threshold was exceeded (p0604) has expired. 
This results in the reaction parameterized in p0610. 

PTC sensor + bimetallic switch: 
The response threshold of 1650 Ohm was exceeded and the timer stage (p0606) has 
expired. 
This results in the reaction parameterized in p0610. 

If an SME Module is used (p0601 = 10), parameter r949 displays the number of the sensor 
channel that has triggered the message. 

A07015 drive: Motor temperature sensor alarm 

An error was detected when evaluating the temperature sensor set in p0600 and p0601. 

When the fault occurs, the time in p0607 is started. If the fault is still present after this time 
has expired, fault F07016 is output – however, not until at least 50 ms after alarm A07015. 

If an SME Module is used (p0601 = 10), parameter r2124 displays the number of the sensor 
channel that has triggered the message. 

F07016 drive: Motor temperature sensor fault 

An error was detected when evaluating the temperature sensor set in p0600 and p0601. 

If alarm A07015 is present, the time in p0607 is started. If the fault is still present after this 
time has expired, fault F07016 is output – however, not until at least 50 ms after alarm 
A07015. 

If an SME Module is used (p0601 = 10), parameter r949 displays the number of the sensor 
channel that has triggered the message. 
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Function diagrams (see SINAMICS S120/S150 List Manual) 
 
• 8016 Signals and monitoring functions - thermal monitoring motor 

Overview of important parameters (see SINAMICS S120/S150 List Manual) 
 
• r0035 CO: Motor temperature 

• r0458[0...2] Sensor Module properties 

• p0600[0..n] Motor temperature sensor for monitoring 

• p0601[0..n] Motor temperature sensor type 

• p0601 Motor temperature sensor type 

• p0603 CI: Motor temperature signal source 

• p0604[0...n] Mot_temp_mod 2/KTY alarm threshold 

• p0605[0...n] Mot_temp_mod 1/2 threshold 

• p0606[0...n] Mot_temp_mod 2/KTY timer 

• p0607[0...n] Temperature sensor fault timer 

• p0610[0...n] Motor overtemperature response 

• p4100[0...3] TM120 temperature evaluation, sensor type 

• p4100 TM31 temperature evaluation, sensor type 

• p4102[0...7] TM150 fault threshold/alarm threshold 

• r4105[0...3] CO:TM120 temperature evaluation actual value 

• r4105 CO:TM31 temperature evaluation actual value 

• p4600[0...n] Motor temperature sensor 1 sensor type 

• p4601[0...n] Motor temperature sensor 2 sensor type 

• p4602[0...n] Motor temperature sensor 3 sensor type 

• p4603[0...n] Motor temperature sensor 4 sensor type 

• r4620[0...3] Motor temperature measured 
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2.17 Basic Operator Panel 20 (BOP20) 

Short description 
The Basic Operator Panel 20 (BOP20) is a basic operator panel with six keys and a two-line 
display unit with background lighting. The BOP20 can be plugged onto the SINAMICS 
Control Unit and operated.  

The BOP20 supports the following functions: 

● Input and changing parameters 

● Display of operating modes, parameters and alarms 

● Display and acknowledgement of faults 

● Powering-up/powering-down while commissioning 

● Simulation of a motorized potentiometer 

2.17.1 Operation with BOP20 (Basic Operator Panel 20) 

2.17.1.1 General information about the BOP20 
The BOP20 can be used to switch on and switch off drives during the commissioning phase 
as well as to display and modify parameters. Faults can be diagnosed as well as 
acknowledged.  

The BOP20 is snapped onto the Control Unit. To do this, the blanking cover must be 
removed (for additional information on mounting, please refer to the SINAMICS S120 
Manual Control Units and Supplementary System Components). 

Displays and keys 

 
Figure 2-69 Overview of displays and keys 
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Information on the displays 

Table 2- 23 LED 

Display Meaning 
top left  
2 positions 

The active drive object of the BOP is displayed here. 
The displays and key operations always refer to this drive object. 

RUN Lit if at least one drive in the drive line-up is in the RUN state (in operation). 
RUN is also displayed via bit r0899.2 of the drive. 

top right  
2 positions 

The following is displayed in this field: 
• More than 6 digits: Characters that are still present but are invisible  

(e.g. "r2" ––> 2 characters to the right are invisible, "L1" ––> 1 character to the left is invisible)
• Faults: Selects/displays other drives with faults 
• Designation of BICO inputs (bi, ci) 
• Designation of BICO outputs (bo, co) 
• Source object of a BICO interconnection to a drive object different than the active one. 

S Is (bright) if at least one parameter was changed and the value was not transferred into the non-
volatile memory. 

P Is lit (bright) if, for a parameter, the value only becomes effective after pressing the P key. 
C Is light (bright) if at least one parameter was changed and the calculation for consistent data 

management has still not been initiated. 
Below, 6 digit Displays, e.g. parameters, indices, faults and alarms. 

Information on the keys 

Table 2- 24 Keys 

Key Name Meaning 

 
ON Powering up the drives for which the command "ON/OFF1" should come from the BOP. 

Binector output r0019.0 is set using this key. 

 
OFF Powering down the drives for which the commands "ON/OFF1", "OFF2" or "OFF3" should come 

from the BOP. 
The binector outputs r0019.0, .1 and .2 are simultaneously reset when this key is pressed. After 
the key has been released, binector outputs r0019.1 and .2 are again set to a "1" signal. 
Note: 
The effectiveness of these keys can be defined by appropriately parameterizing the BICO (e.g. 
using these keys it is possible to simultaneously control all of the existing drives). 

 
Functions The significance of this key depends on the actual display. 

Note: 
The effectiveness of this key to acknowledge faults can be defined using the appropriate BiCo 
parameterization. 
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Key Name Meaning 

 
Parameter The significance of this key depends on the actual display. 

If this key is pressed for 3 s, the "Copy RAM to ROM" function is executed. The "S" displayed on 
the BOP disappears. 

 
Raise 

 
Lower 

The significance of these keys is dependent on the actual display and is used to increase or 
decrease values. 

BOP20 functions 

Table 2- 25 Functions 

Name Description 
Backlighting The backlighting can be set using p0007 in such a way that it switches itself off automatically 

after the set time if no actions are carried out. 
Changeover active drive From the BOP perspective the active drive is defined using p0008 or using the keys "FN" and 

"Arrow up". 
Units The units are not displayed on the BOP. 
Access level The access level for the BOP is defined using p0003. 

The higher the access level, the more parameters can be selected using the BOP. 
Parameter filter Using the parameter filter in p0004, the available parameters can be filtered corresponding to 

their particular function. 
Selecting the operating 
display 

Actual values and setpoints are displayed on the operating display. 
The operating display can be set using p0006. 

User parameter list Using the user parameter list in p0013, parameters can be selected for access. 
Unplug while voltage is 
present 

The BOP can be withdrawn and inserted under voltage. 
• The ON key and OFF key have a function. 

When withdrawing, the drives are stopped. 

After inserting, the drives must be switched on again. 
• The ON key and OFF key have no function. 

Withdrawing and inserting has no effect on the drives. 
Actuating keys The following applies to the "P" and "FN" keys: 

• When used in a combination with another key, "P" or "FN" must be pressed first and then 
the other key. 
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Overview of important parameters (see SINAMICS S120/S150 List Manual) 
 
All drive objects 
• p0005 BOP status display selection 

• p0006 BOP status display mode 

• p0013 BOP user-defined list 

• p0971 Save drive object parameters 

Drive object, Control Unit 
• r0002 Control Unit status display 

• p0003 BOP access level 

• p0004 BOP display filter 

• p0007 BOP backlighting 

• p0008 BOP drive object after powering up 

• p0009 Device commissioning parameter filter 

• p0011 BOP password input (p0013) 

• p0012 BOP password confirmation (p0013) 

• r0019 CO/BO: Control word, BOP 

• p0977 Save all parameters 

Other drive objects (e.g. SERVO, VECTOR, X_INF, TM41 etc.) 
• p0010 Commissioning parameter filter 
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2.17.1.2 Displays and using the BOP20 

Features 
● Status indicator 

● Changing the active drive object 

● Displaying/changing parameters 

● Displaying/acknowledging faults and alarms 

● Controlling the drive using the BOP20 

Status indicator 
The operating display for each drive object can be set using p0005 and p0006. Using the 
operating display, you can change into the parameter display or to another drive object. The 
following functions are possible: 

● Changing the active drive object 

– Press key "FN" and "Arrow up" -> the drive object number at the top left flashes 

– Select the required drive object using the arrow keys 

– Acknowledge using the "P" key 

● Parameter display 

– Press the "P" key. 

– The required parameters can be selected using the arrow keys. 

– Press the "FN" key -> "r00000" is displayed 

– Press the "P" key -> changes back to the operating display 
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Parameter display 
The parameters are selected in the BOP20 using the number. The parameter display is 
reached from the operating display by pressing the "P" key. Parameters can be searched for 
using the arrow keys. The parameter value is displayed by pressing the "P" key again. You 
can toggle between the drive objects by simultaneously pressing the "FN" key and an arrow 
key. You can toggle between "r00000" and the parameter that was last displayed by 
pressing the "FN" key in the parameter display. 

 
Figure 2-70 Parameter display 
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Value display 
To switch from the parameter display to the value display, press the "P" key. In the value 
display, the values of the adjustable parameters can be increased and decreased using the 
arrow. The cursor can be selected using the "FN" key. 

 
Figure 2-71 Value display 
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Example: Changing a parameter 
Precondition: The appropriate access level is set  
(for this particular example, p0003 = 3). 

 
Figure 2-72 Example: Changing p0013[4] from 0 to 300 
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Example: Changing binector and connector input parameters 
For the binector input p0840[0] (OFF1) of drive object 2 binector output r0019.0 of the 
Control Unit (drive object 1) is interconnected. 

 
Figure 2-73 Example: Changing indexed binector parameters 
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2.17.1.3 Fault and alarm displays 

Displaying faults 

 
Figure 2-74 Faults 

Displaying alarms 

 
Figure 2-75 Alarms 



Commissioning  
2.17 Basic Operator Panel 20 (BOP20) 

 Commissioning Manual 
234 Commissioning Manual, (IH1), 01/2013, 6SL3097-4AF00-0BP3 

2.17.1.4 Controlling the drive using the BOP20 
When commissioning the drive, it can be controlled via the BOP20. A control word is 
available on the Control Unit drive object (r0019) for this purpose, which can be 
interconnected with the appropriate binector inputs of e.g. the drive.  

The interconnections do not function if a standard PROFIdrive telegram was selected as its 
interconnection cannot be disconnected. 

Table 2- 26 BOP20 control word 

Bit (r0019) Name Example, interconnection parameters 
0 ON / OFF (OFF1) p0840 
1 No coast down/coast down (OFF2) p0844 
2 No fast stop/fast stop (OFF3) p0848 
7 Acknowledge fault (0 -> 1) p2102 
13 Motorized potentiometer, raise p1035 
14 Motorized potentiometer, lower p1036 

 
 

 Note 

For simple commissioning, only bit 0 should be interconnected. When interconnecting  
bits 0 ... 2, then the system is powered-down according to the following priority: OFF2, 
OFF3, OFF1. 
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2.17.2 Important functions via BOP20 

Description 
The BOP20 can be used to execute the following functions (via parameters) that help you 
handle your project:  

● Restoring the factory settings 

● Copy RAM to ROM 

● Identification via LED 

● Acknowledging faults 

Restoring the factory settings 
The factory setting of the complete device can be established in the drive object CU. 

● p0009 = 30 

● p0976 = 1 

Copy RAM to ROM 
You can initiate the saving of all parameters to the non-volatile memory (memory card) in the 
drive object CU: 

● Press the P key for 3 seconds,  
or 

● p0009 = 0 

● p0977 = 1 

  Note 

This parameter is not accepted if an identification run (e.g. motor data identification) has 
been selected on a drive.  
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Identification via LED 
The main component of a drive object (e.g. Motor Module) can be identified using the index 
of p0124. The "Ready" LED on the component starts to flash. The index matches the index 
in p0107. The drive object type can be identified via this parameter. 

On the drive objects, the components can also be identified via the following parameters: 

● p0124 Power unit detection via LED 

● p0144 Voltage Sensing Module detection via LED 

● p0144 Sensor Module detection via LED 

Acknowledging faults 
To acknowledge all the faults that have been rectified, press the Fn key. 
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Diagnostics 3
 

This chapter describes the following diagnostic features of the SINAMICS S drive system: 

● Diagnostics via LEDs 

● Diagnostics via STARTER 

● Diagnostic buffer 

● Diagnostics of uncommissioned axes 

● Fault and alarm messages 

● Encoder troubleshooting 
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3.1 Diagnostics via LEDs 

3.1.1 Control Units 

3.1.1.1 Description of the LED states of a CU320-2 
The various states of the Control Units CU320-2 DP and CU320-2 PN during power-up and 
during operation are displayed using LEDs on the Control Unit. The duration of the individual 
statuses varies. 

Table 3- 1 LEDs 

LED Function 
RDY Ready 
DP/PN PROFIdrive cyclic operation via PROFIBUS (DP) or PROFINET (PN) 
OPT OPTION 

● If an error occurs, the booting procedure is terminated and the cause is indicated 
accordingly via the LEDs. 

● Once the unit has successfully booted up, all the LEDs are switched off briefly. 

● Once the unit has booted up, the LEDs are controlled via the loaded software. 
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Control Unit 320-2 DP while powering up 

Table 3- 2 Load software  

LED 

RDY DP OPT 

State Comment 

Red Orange Orange Reset Hardware reset 
RDY LED lights up red, all other LEDs light 
up orange 

Red Red Off BIOS loaded – 
Red 

flashing 
light 2 Hz 

Red Off BIOS error • Error occurred while loading the BIOS 

Red 
flashing 

light 2 Hz 

Red  
Flashing 
light 2 Hz 

Off File error • Memory card not inserted or faulty 
• Software on memory card not present 

or corrupted 

Red Orange 
flashing 

light  

Off FW loading RDY LED lights up red, PN LED flashes 
orange without fixed frequency 

Red Off Off FW loaded – 
Off Red Off FW checked 

(no CRC error)
– 

Red 
flashing 

light 0.5 Hz 

Red 
flashing 

light 0.5 Hz 

Off FW checked 
(CRC error) 

• CRC invalid 

 

Table 3- 3 Firmware 

LED 

RDY DP OPT 

State Comment 

Orange Off Off Initializing – 
Alternating Running See the table below 
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Control Unit 320-2 DP in operation 

Table 3- 4 Control Unit CU320-2 DP – Description of the LEDs after booting 

LED Color State Description, cause  Remedy 
– OFF Electronic power supply is missing or outside 

permissible tolerance range. 
Check power supply 

Continuous 
light 

The component is ready for operation and cyclic 
DRIVE-CLiQ communication is taking place. 

– 

Flashing light 
0.5 Hz 

Commissioning/reset – 

Green 

Flashing light 
2 Hz 

Writing to the memory card – 

Red Flashing light 
2 Hz 

General errors Check parameterization / 
configuration data 

Red/  
green 

Flashing light 
0.5 Hz 

Control Unit is ready for operation. 
However, there are no software licenses. 

Obtain licenses 

Flashing light 
0.5 Hz 

Updating the firmware of the DRIVE-CLiQ 
components 

– Orange 

Flashing light 
2 Hz 

DRIVE-CLiQ component firmware update complete. 
Wait for POWER ON for the components in 
question. 

Turn POWER ON for the 
components in question 

RDY 
(READY) 

Green/ 
orange 
or 
red/ 
orange 

Flashing light 
2 Hz 

Component detection via LED is activated 
(p0124[0]). 
Note: 
Both options depend on the LED status when 
component recognition is activated via p0124[0] = 1. 

– 

– Off Cyclic communication has not (yet) taken place. 
Note: 
PROFIdrive is ready for communication when the 
Control Unit is ready (see LED RDY). 

– 

Continuous 
light 

Cyclic communication is taking place. – Green 

Flashing light 
0.5 Hz 

Full cyclic communication has not yet taken place. 
Possible causes: 
• The controller is not transferring any setpoints. 
• During isochronous operation, no global control 

(GC) or a faulty global control (GC) is transferred 
by the controller. 

– 

Flashing light 
0.5 Hz 

PROFIBUS master is sending wrong 
parameterization/configuration data 

Adapt configuration 
between 
master/controller and CU 

DP 
PROFIdrive 
cyclic 
operation 

Red 

Flashing light 
2 Hz 

Cyclic bus communication has been interrupted or 
could not be established 

Remedy fault 
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LED Color State Description, cause  Remedy 
– Off Electronic power supply is missing or outside 

permissible tolerance range. 
Component is not ready. 
Option board not installed or no associated drive 
object has been created. 

Check power supply 
and/or component 

Continuous 
light 

Option board is ready. – Green 

Flashing light 
0.5 Hz 

Depends on the option board used. – 

OPT 
(OPTION) 

Red Flashing light 
2 Hz 

This component has at least one fault. 
The Option Board is not ready (e.g. after switching 
on). 

Remedy and 
acknowledge fault 

RDY and DP Red Flashing light 
2 Hz 

Bus error - communication has been interrupted Remedy fault 

RDY and 
OPT 

Orange Flashing light 
0.5 Hz 

Firmware update in progress for connected Option 
Board CBE20 

– 

Control Unit 320-2 PN while powering up 

Table 3- 5 Load software  

LED 

RDY PN OPT 

Status Comment 

Red Orange Orange Reset Hardware reset 
RDY LED lights up red, all other LEDs 
light up orange 

Red Red Off BIOS loaded – 
Red 

flashing 
light 2 Hz 

Red Off BIOS error • Error occurred while loading the BIOS 

Red 
flashing 

light 2 Hz 

Red  
flashing 

light 2 Hz 

Off File error • Memory card not inserted or faulty 
• Software on memory card not present 

or corrupted 

Red Orange 
flashing 

light 

Off FW loading RDY LED lights up red, PN LED flashes 
orange without fixed frequency 

Red Off Off FW loaded – 
Off Red Off FW checked 

(no CRC error) 
– 

Red 
flashing 

light 0.5 Hz 

Red 
flashing 

light 0.5 Hz 

Off FW checked 
(CRC error) 

• CRC invalid 
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Table 3- 6 Firmware 

LED 

RDY PN OPT 

Status Comment 

Orange Off Off Initializing – 
Alternating Running See the table below 

Control Unit 320-2 PN in operation 

Table 3- 7 Control Unit CU320-2 PN – Description of the LEDs after booting 

LED Color Status Description, cause  Remedy 
– OFF Electronics power supply is missing or outside the 

permissible tolerance range. 
Check power supply 

Continuous 
light 

The component is ready for operation and cyclic 
DRIVE-CLiQ communication is taking place. 

– 

Flashing 
light 
0.5 Hz 

Commissioning/reset – 

Green 

Flashing 
light 
2 Hz 

Writing to the memory card – 

Red Flashing 
light 
2 Hz 

General error Check parameterization / 
configuration 

Red/  
green 

Flashing 
light 
0.5 Hz 

Control Unit is ready for operation. 
However, there are no software licenses. 

Obtain licenses 

Flashing 
light 
0.5 Hz 

Updating the firmware of the DRIVE-CLiQ 
components 

– Orange 

Flashing 
light 
2 Hz 

DRIVE-CLiQ component firmware update 
complete. Wait for POWER ON for the 
components in question. 

Turn POWER ON for the 
components in question 

RDY 
(READY) 

Green/ 
orange 
or 
red/ 
orange 

Flashing 
light 
2 Hz 

Component detection via LED is activated 
(p0124[0]). 
Note: 
Both options depend on the LED status when 
component recognition is activated via  
p0124[0] = 1. 

– 

– Off Cyclic communication has not (yet) taken place. 
Note: 
PROFIdrive is ready for communication when the 
Control Unit is ready (see LED RDY). 

– PN  
PROFIdrive 
cyclic 
operation 

Green Continuous 
light 

Cyclic communication is taking place. – 
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LED Color Status Description, cause  Remedy 
Flashing 
light 
0.5 Hz 

Full cyclic communication has not yet taken place. 
Possible causes: 
• The controller is not transferring any setpoints. 
• During isochronous operation, no global 

control (GC) or a faulty global control (GC) is 
transferred by the controller. 

• "Shared Device" is selected (p8929=2) and 
only one controller connected. 

– 

Flashing 
light 
0.5 Hz 

Bus error, 
incorrect parameter assignment/configuration 

Adapt configuration between 
controller and devices 

Red 

Flashing 
light 
2 Hz 

Cyclic bus communication has been interrupted or 
could not be established 

Remove fault 

– Off Electronics power supply is missing or outside the 
permissible tolerance range. 
Component is not ready. 
Option board not installed or no associated drive 
object has been created. 

Check power supply and/or 
component 

Continuous 
light 

Option board is ready. – Green 

Flashing 
light 
0.5 Hz 

Depends on the option board used. – 

OPT 
(OPTION) 

Red Flashing 
light 
2 Hz 

This component has at least one fault. 
The Option Board is not ready (e.g. after switching 
on). 

Remove the fault and 
acknowledge 

RDY and DP Red Flashing 
light 
2 Hz 

Bus error - communication has been interrupted Remove fault 

RDY and OPT Orange Flashing 
light 
0.5 Hz 

Firmware update in progress for connected Option 
Board CBE20 

– 
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3.1.1.2 Description of the LED states of a CU310-2 
There are four LEDs on the front panel of the CU310-2 DP housing.  

Table 3- 8 LEDs 

RDY Ready 
COM Option Board 
OUT > 5V Encoder current supply > 5 V (TTL/HTL) 
MOD Operating mode (reserved) 

The various LEDs are switched on and off as the control unit is powered up (depending on 
the phase the system is currently running through). When switched on, the color of the LEDs 
shows the status of the corresponding power-up phase. 

In the event of a fault, power up will be ended in the corresponding phase. The LEDs that 
are switched on retain their colors so that the fault can be determined on the basis of the 
combination of the color LEDs that are lit and unlit. 

All the LEDs go out briefly if the CU310-2 DP has powered up without error. The system is 
ready for operation when the LED "RDY" is permanently green. 

All the LEDs are controlled by the software loaded during operation. 

Control Unit 310-2 DP while powering up 

Table 3- 9 Load software 

LED 

RDY COM OUT > 5V MOD 

State Comment 

Orange Orange Orange Orange POWER ON All LEDs light up for approx. 1 s 
Red Red Off Off Hardware 

reset 
After pressing the RESET button the 
LEDs light up for approx. 1 s 

Red Red Off Off BIOS loaded - 
Red  

Flashing light 2 
Hz 

Red Off Off BIOS error Error occurred while loading the 
BIOS 

Memory card not inserted or faulty Red  
Flashing light 2 

Hz 

Red  
Flashing light 2 

Hz 

Off Off File error 
Software on memory card not 
present or corrupted 
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Table 3- 10 Firmware 

LED 

RDY COM OUT > 5V MOD 

State Comment 

Red Orange Off Off Firmware 
loading 

COM-LED flashing without specific 
flashing frequency 

Red Off Off Off Firmware 
loaded 

- 

Off Red Off Off Firmware 
check 

(no CRC 
error) 

- 

Red  
Flashing light 

0.5 Hz 

Red  
Flashing light 

0.5 Hz 

Off Off Firmware 
check 

(CRC error) 

CRC is incorrect 

Orange Off Off Off Firmware 
initialization 

- 

Control Unit 310-2 DP in operation 

Table 3- 11 Description of the LEDs during operation of the CU310-2 DP 

LED Color State Description / cause Remedy 
- Off Electronic power supply is missing or outside 

permissible tolerance range. 
Check the power 
supply 

Continuous light The unit is ready for operation. 
Cyclic DRIVE-CLiQ communication is in progress. 

- 

Flashing light 
0.5 Hz 

Commissioning/reset - 

 
Green 

Flashing light 2 
Hz 

Writing to the memory card. - 

Red Flashing light 
2 Hz 

General errors Check parameter 
assignment/configurati
on 

Red/green Flashing light 
0.5 Hz 

The control unit is ready for operation, but there 
are no software licenses. 

Install the missing 
licenses. 

Flashing light 
0.5 Hz 

Updating the firmware of the DRIVE-CLiQ 
components. 

-  
Orange 

Flashing light 
2 Hz 

DRIVE-CLiQ component firmware update 
completed. Waiting for POWER ON of the 
corresponding components. 

Switch on the 
component. 

RDY 
(READY) 

Green/ 
orange 
or 
red/orange 

 
Flashing light 
2 Hz 

Detection of the component via LED is activated 
(p0124[0]). 
Note: 
Both options depend on the LED status when 
module recognition is activated via p0124[0] = 1. 

- 
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LED Color State Description / cause Remedy 
- Off Cyclic communication is not (yet) running. 

Note: 
The PROFIdrive is ready for communication when 
the Control Unit is ready for operation (see LED: 
RDY). 

- 

Continuous light Cyclic communication is taking place. -  
Green Flashing light 

0.5 Hz 
Cyclic communication is not fully established yet. 
Possible causes: 
- The controller is not transmitting any setpoints. 
- In isochronous mode, the controller is not sending 
a GC (Global Control) or is sending a defective 
GC. 

- 

Flashing light 
0.5 Hz 

The PROFIBUS master is sending a faulty 
parameter assignment or the configuration file is 
corrupted. 

Modify the 
configuration between 
master/controller and 
control unit. 

COM 

 
Red 

Flashing light 
2 Hz 

Cyclic bus communication has been interrupted or 
could not be established. 

Rectify the fault in bus 
communication. 

MOD - Off - - 
- Off - - OUT > 5 V 
Orange Continuous light The voltage of the electronics power supply for the 

measuring system is 24 V. 1) 
 

1) Make sure that the encoder connected is designed for a 24 V supply. Connecting a 5 V encoder to a 24 V supply can 
result in destruction of the encoder electronics. 

Control Unit 310-2 PN while powering up 

Table 3- 12 Load software 

LED 

RDY COM OUT>5V MOD 

State Comment 

Orange Orange Orange Orange POWER ON All LEDs light up for approx. 1 s 
Red Red Off Off Hardware reset After pressing the RESET button 

the LEDs light up for approx. 1 s 
Red Red Off Off BIOS loaded - 
Red  

Flashing light 2 
Hz 

Red Off Off BIOS error Error occurred while loading the 
BIOS 

Memory card not inserted or faulty Red  
Flashing light 2 

Hz 

Red  
Flashing light 2 

Hz 

Off Off File error 
Software on memory card not 
present or corrupted 
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Table 3- 13 Firmware 

LED 

RDY COM OUT>5V MOD 

State Comment 

Red Orange Off Off Firmware 
loading 

COM-LED flashing without specific 
flashing frequency 

Red Off Off Off Firmware 
loaded 

- 

Off Red Off Off Firmware 
check 

(no CRC error)

- 

Red  
Flashing light 

0.5 Hz 

Red  
Flashing light 

0.5 Hz 

Off Off Firmware 
check 

(CRC error) 

CRC is incorrect 

Orange Off Off Off Firmware 
initialization 

- 

Control Unit 310-2 PN in operation 

Table 3- 14 Description of the LEDs during operation of the CU310-2 PN 

LED Color State Description / cause Remedy 
- Off Electronic power supply is missing or outside 

permissible tolerance range. 
Check the power 
supply 

Continuous light The unit is ready for operation. 
Cyclic DRIVE-CLiQ communication is in 
progress. 

- 

Flashing light  
0.5 Hz 

Commissioning/reset - 

 
Green 

Flashing light 2 Hz Writing to the memory card. - 
Red Flashing light 

2 Hz 
General errors Check parameter 

assignment/configurati
on 

Red/green Flashing light 
0.5 Hz 

The control unit is ready for operation, but there 
are no software licenses. 

Install the missing 
licenses. 

Flashing light 
0.5 Hz 

Updating the firmware of the DRIVE-CLiQ 
components. 

-  
Orange 

Flashing light 
2 Hz 

DRIVE-CLiQ component firmware update 
completed. Waiting for POWER ON of the 
corresponding components. 

Switch on the 
component. 

RDY 
(READY) 

Green/ 
orange 
or 
red/orange 

Flashing light 
2 Hz 

Component detection via LED is activated 
(p0124[0]). 
Note: 
Both options depend on the LED status when 
component recognition is activated via  
p0124[0] = 1. 

- 
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LED Color State Description / cause Remedy 
- Off Cyclic communication has not (yet) taken place. 

Note: 
PROFIdrive is ready for communication when 
the Control Unit is ready (see LED: RDY). 

- 

Continuous light Cyclic communication is taking place. -  
Green Flashing light 

0.5 Hz 
Full cyclic communication is not yet taking place. 
Possible causes: 
• The controller is not transferring any 

setpoints. 
• During isochronous operation, no GC (Global 

Control) or a faulty GC is transferred by the 
controller. 

- 

Flashing light 
0.5 Hz 

The PROFIBUS master is sending a faulty 
parameter assignment or the configuration file is 
corrupted. 

Modify the 
configuration between 
master/controller and 
control unit. 

COM 

 
Red 

Flashing light 
2 Hz 

Cyclic bus communication has been interrupted 
or could not be established. 

Rectify the fault in bus 
communication. 

MOD - Off - - 
- Off - - OUT > 5 V 
Orange Continuous light The voltage of the electronics power supply for 

the measuring system is 24 V. 1) 
 

1) Make sure that the encoder connected is designed for a 24 V supply. Connecting a 5 V encoder to a 24 V supply can 
result in destruction of the encoder electronics. 
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3.1.2 Power units 

3.1.2.1 Active Line Module booksize 

Table 3- 15 Meaning of the LEDs on the Active Line Module  

State 

Ready DC link  

Description, cause 
 

Remedy 
 

Off Off Electronic power supply is missing or outside permissible 
tolerance range. 

– 

Off The component is ready for operation and cyclic DRIVE-CLiQ 
communication is taking place. 

– 

Orange The component is ready for operation and cyclic DRIVE-CLiQ 
communication is taking place. 
The DC link voltage is present. 

– 

Green 

Red The component is ready for operation and cyclic DRIVE-CLiQ 
communication is taking place. 
The DC link voltage is too high. 

Check the line voltage 

Orange Orange DRIVE-CLiQ communication is being established. – 
Red – At least one fault is present in this component. 

Note: 
LED is controlled irrespective of the corresponding messages 
being reconfigured. 

Remedy and acknowledge 
fault 

Green / red 
flashing light  
0.5 Hz  

– Firmware is being downloaded. – 

Green / red 
flashing light 
2 Hz 

– Firmware download is complete. Wait for POWER ON. Carry out a POWER ON 

Green / 
orange 
or 
Red / orange 

– Component detection via LED is activated (p0124). 
Note: 
Both options depend on the LED status when module 
recognition is activated via p0124 = 1. 

– 

 

 

WARNING  
Risk of electric shock as a result of the high DC link voltage 

Hazardous DC link voltages may be present at any time regardless of the state of the "DC 
link" LED.  
Note the warning information on the component!  
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3.1.2.2 Basic Line Module booksize 

Table 3- 16 Meaning of the LEDs on the Basic Line Module  

State 

Ready DC link 

Description, cause 
 

Remedy 
 

Off Off Electronic power supply is missing or outside permissible 
tolerance range. 

– 

Off The component is ready for operation and cyclic DRIVE-CLiQ 
communication is taking place. 

– 

Orange The component is ready for operation and cyclic DRIVE-CLiQ 
communication is taking place. 
The DC link voltage is present. 

– 

Green 

Red The component is ready for operation and cyclic DRIVE-CLiQ 
communication is taking place. 
The DC link voltage is too high. 

Check the line voltage. 

Orange Orange DRIVE-CLiQ communication is being established. – 
Red – At least one fault is present in this component. 

Note: 
LED is controlled irrespective of the corresponding messages 
being reconfigured. 

Remedy and acknowledge 
fault. 

Green / red 
flashing light 
0.5 Hz 

– Firmware is being downloaded. – 

Green / red 
flashing light 
2 Hz 

– Firmware download is complete. Wait for POWER ON. Carry out a POWER ON 

Green / 
orange 
or 
Red / orange 
flashing light 

– Component detection via LED is activated (p0124). 
Note: 
Both options depend on the LED status when module 
recognition is activated via p0124 = 1. 

– 

 

 

WARNING  
Risk of electric shock as a result of the high DC link voltage 

Hazardous DC link voltages may be present at any time regardless of the state of the "DC 
link" LED.  
Note the warning information on the component!  
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3.1.2.3 Smart Line Modules booksize 5 kW and 10 kW 

Table 3- 17 Meaning of the LEDs at the Smart Line Modules 5 kW and 10 kW  

LED Color State Description, cause Remedy 
– Off Electronic power supply is missing or outside 

permissible tolerance range. 
– 

Green Continuous 
light 

Component is ready to operate. – 

Yellow Continuous 
light 

Pre-charging not completed. 
Bypass relay dropped out 
EP terminals not supplied with 24 VDC. 

– 

READY 

Red Continuous 
light 

Overtemperature 
Overcurrent 

Diagnose fault (via output 
terminals) and 
acknowledge it (via input 
terminal) 

– Off Electronic power supply is missing or outside 
permissible tolerance range. 

– 

Yellow Continuous 
light 

DC link voltage within permissible tolerance range. – 

DC LINK 

Red Continuous 
light 

DC link voltage outside permissible tolerance range. 
Line supply fault. 

Check the line voltage. 

 

 

WARNING  
Risk of electric shock as a result of the high DC link voltage 

Hazardous DC link voltages may be present at any time regardless of the state of the "DC 
link" LED.  
Note the warning information on the component! 
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3.1.2.4 Smart Line Modules booksize 16 kW to 55 kW 

Table 3- 18 Meaning of the LEDs at the Smart Line Modules ≥ 16 kW  

State 

Ready DC link  

Description, cause 
 

Remedy 
 

Off Off Electronic power supply is missing or outside permissible 
tolerance range. 

– 

Off The component is ready for operation and cyclic DRIVE-
CLiQ communication is taking place. 

– 

Orange The component is ready for operation and cyclic DRIVE-
CLiQ communication is taking place. 
The DC link voltage is present. 

– 

Green 

Red The component is ready for operation and cyclic DRIVE-
CLiQ communication is taking place. 
The DC link voltage is too high. 

Check the line voltage 

Orange Orange DRIVE-CLiQ communication is being established. – 
Red – At least one fault is present in this component. 

Note: 
LED is controlled irrespective of the corresponding 
messages being reconfigured. 

Remedy and acknowledge 
fault 

Green / red 
flashing light 
0.5 Hz 

– Firmware is being downloaded. – 

Green / red 
flashing light 
2 Hz 

– Firmware download is complete. Wait for POWER ON. Carry out a POWER ON 

Green / 
orange 
or 
Red / orange 
flashing light 

– Component detection via LED is activated (p0124). 
Note: 
Both options depend on the LED status when module 
recognition is activated via p0124 = 1. 

– 

 

 

WARNING  
Risk of electric shock as a result of the high DC link voltage 

Hazardous DC link voltages may be present at any time regardless of the state of the "DC 
link" LED.  
Note the warning information on the component! 
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3.1.2.5 Single Motor Module / Double Motor Module / Power Module 

Table 3- 19 Meaning of the LEDs on the Motor Module  

State 

Ready DC link 

Description, cause 
 

Remedy 
 

Off Off Electronic power supply is missing or outside permissible 
tolerance range. 

– 

Off The component is ready for operation and cyclic DRIVE-
CLiQ communication is taking place. 

– 

Orange The component is ready for operation and cyclic DRIVE-
CLiQ communication is taking place. 
The DC link voltage is present. 

– 

Green 

Red The component is ready for operation and cyclic DRIVE-
CLiQ communication is taking place. 
The DC link voltage is too high. 

Check the line voltage 

Orange Orange DRIVE-CLiQ communication is being established. – 
Red – At least one fault is present in this component. 

Note: 
LED is controlled irrespective of the corresponding 
messages being reconfigured. 

Remedy and acknowledge 
fault 

Green / red 
flashing light 
0.5 Hz 

– Firmware is being downloaded. – 

Green / red 
flashing light 
2 Hz 

– Firmware download is complete. Wait for POWER ON. Carry out a POWER ON 

Green / 
orange 
or 
Red / orange 

– Component detection via LED is activated (p0124). 
Note: 
Both options depend on the LED status when module 
recognition is activated via p0124 = 1. 

– 

 
 

WARNING  
Risk of electric shock as a result of the high DC link voltage 

Hazardous DC link voltages may be present at any time regardless of the state of the "DC 
link" LED.  
Note the warning information on the component! 
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3.1.2.6 Braking Modules booksize format 

Table 3- 20 Meaning of the LEDs on the Braking Module booksize  

LED Color State Description, cause Remedy 
– Off Electronic power supply is missing or outside permissible 

tolerance range. 
Component deactivated via terminal. 

– 

Green Continuous 
light 

Component is ready to operate. – 

READY 

Red Continuous 
light 

Enable signal missing (input terminal) 
Overtemperature 
Overcurrent trip 
I2t monitoring responded 
Ground fault/short circuit 
Note: 
In the event of an overtemperature, the error cannot be 
acknowledged until after a cooling down time. 

Diagnose fault (via 
output terminals) 
and acknowledge it 
(via input terminal) 

– Off There is no DC link voltage or the electronic power supply is 
missing or outside permissible tolerance range. 
Component not active. 

– DC LINK 

Green Flashing 
light 

Component active (DC link discharge via braking resistor in 
progress). 

– 
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3.1.2.7 Smart Line Module booksize compact format 

Table 3- 21 Meaning of the LEDs on the Smart Line Module booksize compact  

State 

RDY DC LINK 

Description, cause 
 

Remedy 
 

Off Off Electronic power supply is missing or outside permissible 
tolerance range. 

– 

– The component is ready for operation and cyclic DRIVE-
CLiQ communication is taking place. 

– 

Orange The component is ready for operation and cyclic DRIVE-
CLiQ communication is taking place. 
The DC link voltage is present. 

– 

Green 

Red The component is ready for operation and cyclic DRIVE-
CLiQ communication is taking place. 
The DC link voltage is too high. 

Check the line voltage 

Orange Orange DRIVE-CLiQ communication is being established. – 
Red – At least one fault is present in this component. 

Note: 
LED is controlled irrespective of the corresponding 
messages being reconfigured. 

Remedy and acknowledge 
fault 

Green/red 
(0.5 Hz) 

– Firmware is being downloaded. – 

Green/red  
(2 Hz) 

– Firmware download is complete. Wait for POWER ON. Carry out a POWER ON 

Green/ 
orange 
or 
red/orange 

– Identifying whether the component is activated using the 
LED (p0124) 
Note: 
Both options depend on the LED status when module 
recognition is activated via p0124 = 1. 

– 

 

 

WARNING  
Risk of electric shock as a result of the high DC link voltage 

Hazardous DC link voltages may be present at any time regardless of the state of the LED 
"DC LINK".  
Note the warning information on the component! 

 



Diagnostics  
3.1 Diagnostics via LEDs 

 Commissioning Manual 
256 Commissioning Manual, (IH1), 01/2013, 6SL3097-4AF00-0BP3 

3.1.2.8 Motor Module booksize compact format 

Table 3- 22 Meaning of the LEDs on the Motor Module booksize compact  

State Description, cause Remedy 
RDY DC LINK   
Off Off Electronic power supply is missing or outside permissible 

tolerance range. 
– 

– The component is ready for operation and cyclic DRIVE-
CLiQ communication is taking place. 

– 

Orange The component is ready for operation and cyclic DRIVE-
CLiQ communication is taking place. 
The DC link voltage is present. 

– 

Green 

Red The component is ready for operation and cyclic DRIVE-
CLiQ communication is taking place. 
The DC link voltage is too high. 

Check the line voltage 

Orange Orange DRIVE-CLiQ communication is being established. – 
Red – At least one fault is present in this component. 

Note: 
LED is controlled irrespective of the corresponding 
messages being reconfigured. 

Remedy and acknowledge 
fault 

Green/red 
(0.5 Hz) 

– Firmware is being downloaded. – 

Green/red  
(2 Hz) 

– Firmware download is complete. Wait for POWER ON. Carry out a POWER ON 

Green/ 
orange 
or 
red/orange 

– Component detection via LED is activated (p0124). 
Note: 
Both options depend on the LED status when module 
recognition is activated via p0124 = 1. 

– 

 

 

WARNING  
Risk of electric shock as a result of the high DC link voltage 

Hazardous DC link voltages may be present at any time regardless of the state of the LED 
"DC LINK".  
Note the warning information on the component! 
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3.1.2.9 Control Interface Module in the Active Line Module chassis format 

Table 3- 23 Meaning of the LEDs "READY" and "DC LINK" on the Control Interface Module in the Active Line Module  

LED, state 

Ready DC link 

Description 

Off Off The electronic power supply is missing or lies outside the permissible tolerance range. 
Off The component is ready for operation and cyclic DRIVE-CLiQ communication is taking 

place. 
Orange The component is ready for operation and cyclic DRIVE-CLiQ communication is taking 

place. 
The DC link voltage is present. 

Green 

Red The component is ready for operation and cyclic DRIVE-CLiQ communication is taking 
place. 
The DC link voltage is too high. 

Orange Orange DRIVE-CLiQ communication is being established. 
Red --- At least one fault is present in this component. 

Note: 
LED is activated irrespective of any reconfiguring of the corresponding messages. 

Green / red 
flashing light  
0.5 Hz 

--- Firmware is being downloaded. 

Green / red 
flashing light  
2 Hz 

--- Firmware download is complete. Wait for POWER ON. 

Green / 
orange or 
red / orange 
flashing light 
2 Hz 

--- Component detection using LED is activated (p0124). 
Note: 
Both options depend on the LED state when module recognition is activated via p0124 = 1. 

Table 3- 24 Meaning of the LED "POWER OK" on the Control Interface Module in the Active Line Module  

LED Color State Description 
Off DC link voltage < 100 V and voltage at -X9:1/2 less than 12 V. 
On The component is ready for operation. 

POWER OK Green 

Flashing 
light 

There is a fault. If the LED continues to flash after you have performed a 
POWER ON, please contact your Siemens service center. 

 

 

WARNING  
Risk of electric shock as a result of the high DC link voltage 

Hazardous DC link voltages may be present at any time regardless of the state of the "DC 
link" LED. 

Observe the warning information on the component! 
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3.1.2.10 Control Interface Module in the Basic Line Module chassis format 

Table 3- 25 Meaning of the LEDs "Ready" and "DC Link" on the Control Interface Module in the Basic Line Module  

LED, state 

Ready DC link 

Description 

Off Off The electronic power supply is missing or lies outside the permissible tolerance range. 
Off The component is ready for operation and cyclic DRIVE-CLiQ communication is taking 

place. 
Orange The component is ready for operation and cyclic DRIVE-CLiQ communication is taking 

place. 
The DC link voltage is present. 

Green 

Red The component is ready for operation and cyclic DRIVE-CLiQ communication is taking 
place. 
The DC link voltage is too high. 

Orange Orange DRIVE-CLiQ communication is being established. 
Red --- At least one fault is present in this component. 

Note: 
LED is activated irrespective of any reconfiguring of the corresponding messages. 

Green / red 
flashing light  
0.5 Hz 

--- Firmware is being downloaded. 

Green / red 
flashing light 
2 Hz 

--- Firmware download is complete. Wait for POWER ON. 

Green / 
orange or 
red / orange 
flashing light 
2 Hz 

--- Component detection using LED is activated (p0124). 
Note: 
Both options depend on the LED state when module recognition is activated via p0124 = 1. 

Table 3- 26 Meaning of the LED "POWER OK" on the Control Interface Module in the Basic Line Module  

LED Color State Description 
Off DC link voltage < 100 V and voltage at -X9:1/2 less than 12 V. 
On The component is ready for operation. 

POWER OK Green 

Flashing 
light 

There is a fault. If the LED continues to flash after you have performed a 
POWER ON, please contact your Siemens service center. 

 

 

WARNING  
Risk of electric shock as a result of the high DC link voltage 

Hazardous DC link voltages may be present at any time regardless of the state of the "DC 
link" LED. 

Observe the warning information on the component! 
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3.1.2.11 Control Interface Module in the Smart Line Module chassis format 

Table 3- 27 Meaning of the LEDs "READY" and "DC LINK" on the Control Interface Module in the Smart Line Module  

LED, state 

READY DC LINK 

Description 

Off Off The electronic power supply is missing or lies outside the permissible tolerance range. 
Off The component is ready for operation and cyclic DRIVE-CLiQ communication is taking 

place. 
Orange The component is ready for operation and cyclic DRIVE-CLiQ communication is taking 

place. 
The DC link voltage is present. 

Green 

Red The component is ready for operation and cyclic DRIVE-CLiQ communication is taking 
place. 
The DC link voltage is too high. 

Orange Orange DRIVE-CLiQ communication is being established. 
Red --- At least one fault is present in this component. 

Note: 
LED is activated irrespective of any reconfiguring of the corresponding messages. 

Flashing 
light  
0.5 Hz: 
Green / red 

--- Firmware is being downloaded. 

Flashing 
light 2 Hz: 
Green / red 

--- Firmware download is complete. Wait for POWER ON. 

Flashing 
light 2 Hz: 
Green / 
orange or 
red / orange 

--- Component detection using LED is activated (p0124). 
Note: 
Both options depend on the LED state when module recognition is activated via p0124 = 1. 

Table 3- 28 Meaning of the LED "POWER OK" on the Control Interface Module in the Smart Line Module  

LED Color State Description 
Off DC link voltage < 100 V and voltage at -X9:1/2 less than 12 V. 
On The component is ready for operation. 

POWER OK Green 

Flashing 
light 

There is a fault. If the LED continues to flash after you have performed a 
POWER ON, please contact your Siemens service center. 

 

 

WARNING  
Risk of electric shock as a result of the high DC link voltage 

Hazardous DC link voltages may be present at any time regardless of the state of the "DC 
LINK" LED. 

Observe the warning information on the component! 
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3.1.2.12 Control Interface Module in the Motor Module chassis format 

Table 3- 29 Meaning of the LEDs "Ready" and "DC Link" on the Control Interface Module in the Motor Module  

LED, state 

Ready DC link 

Description 

Off Off The electronic power supply is missing or lies outside the permissible tolerance range. 
Off The component is ready for operation and cyclic DRIVE-CLiQ communication is taking 

place. 
Orange The component is ready for operation and cyclic DRIVE-CLiQ communication is taking 

place. 
The DC link voltage is present. 

Green 

Red The component is ready for operation and cyclic DRIVE-CLiQ communication is taking 
place. 
The DC link voltage is too high. 

Orange Orange DRIVE-CLiQ communication is being established. 
Red --- At least one fault is present in this component. 

Note: 
LED is activated irrespective of any reconfiguring of the corresponding messages. 

Green / red 
flashing light 
0.5 Hz 

--- Firmware is being downloaded. 

Green / red 
flashing light 
2 Hz 

--- Firmware download is complete. Wait for POWER ON. 

Green / 
orange or 
red / orange 
flashing light 
2 Hz 

--- Component detection using LED is activated (p0124). 
Note: 
Both options depend on the LED status when module recognition is activated via p0124 = 1. 

Table 3- 30 Meaning of the LED "POWER OK" on the Control Interface Module in the Motor Module  

LED Color State Description 
Off DC link voltage < 100 V and voltage at -X9:1/2 less than 12 V. 
On The component is ready for operation. 

POWER OK Green 

Flashing 
light 

There is a fault. If the LED continues to flash after you have performed a 
POWER ON, please contact your Siemens service center. 

 

 

WARNING  
Risk of electric shock as a result of the high DC link voltage 

Hazardous DC link voltages may be present at any time regardless of the state of the "DC 
link" LED. 

Observe the warning information on the component! 
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3.1.2.13 Control Interface Module in the Power Module chassis format 

Table 3- 31 Meaning of the LEDs "READY" and "DC LINK" on the Control Interface Module in the Power Module  

LED, state 

READY DC LINK 

Description 

Off Off The electronic power supply is missing or lies outside the permissible tolerance range. 
Off The component is ready for operation and cyclic DRIVE-CLiQ communication is taking 

place. 
Orange The component is ready for operation and cyclic DRIVE-CLiQ communication is taking 

place. The DC link voltage is present. 

Green 

Red The component is ready for operation and cyclic DRIVE-CLiQ communication is taking 
place. The DC link voltage is too high. 

Orange Orange DRIVE-CLiQ communication is being established. 
Red --- At least one fault is present in this component. 

Note: 
LED is controlled irrespective of the corresponding messages being reconfigured. 

Flashing 
light  
0.5 Hz: 
Green / red 

--- Firmware is being downloaded. 

Flashing 
light 2 Hz: 
Green / red 

--- Firmware download is complete. Wait for POWER ON. 

Flashing 
light 2 Hz: 
Green / 
orange or 
red / orange 

--- Component detection using LED is activated (p0124). 
Note: 
Both options depend on the LED status when module recognition is activated via p0124 = 1. 

Table 3- 32 Meaning of the LED "POWER OK" on the Control Interface Module in the Power Module  

LED Color State Description 
Off DC link voltage < 100 V and voltage at -X9:1/2 less than 12 V. 
On The component is ready for operation. 

POWER OK Green 

Flashing 
light 

There is a fault. If the LED continues to flash after you have performed a 
POWER ON, please contact your Siemens service center. 

 

 

WARNING  
Risk of electric shock as a result of the high DC link voltage 

Hazardous DC link voltages may be present at any time regardless of the state of the "DC 
LINK" LED. 

Observe the warning information on the component! 
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3.1.3 Additional modules 

3.1.3.1 Control Supply Module 

Table 3- 33 Control Supply Module – description of the LEDs 

LED Color State Description, cause Remedy 
– off Electronic power supply is missing or outside permissible 

tolerance range. 
– READY 

Green Continuous 
light 

Component is ready to operate. – 

– off Electronic power supply is missing or outside permissible 
tolerance range. 

– 

Orange Continuous 
light 

DC link voltage within permissible tolerance range. – 

DC LINK 

Red Continuous 
light 

DC link voltage outside permissible tolerance range. – 

3.1.3.2 Sensor Module Cabinet SMC10 / SMC20 

Table 3- 34 Sensor Module Cabinet 10/20 (SMC10/SMC20) – description of the LEDs  

LED Color State Description, cause Remedy 
– off Electronic power supply is missing or outside permissible 

tolerance range. 
– 

Green Continuous 
light 

The component is ready for operation and cyclic DRIVE-
CLiQ communication is taking place. 

– 

Orange Continuous 
light 

DRIVE-CLiQ communication is being established. – 

Red Continuous 
light 

At least one fault is present in this component. 
Note: 
LED is controlled irrespective of the corresponding messages 
being reconfigured. 

Remedy and 
acknowledge fault 

Flashing light 
0.5 Hz 

Firmware is being downloaded. – Green/red 

Flashing light 
2 Hz 

Firmware download is complete. Wait for POWER ON Carry out a 
POWER ON 

RDY 
READY 

Green/ 
orange 
or 
Red/orange 

Flashing light Component recognition via LED is activated (p0144). 
Note: 
Both options depend on the LED status when module 
recognition is activated via p0144 = 1. 

– 
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3.1.3.3 Sensor Module Cabinet SMC30 

Table 3- 35 Meaning of LEDs on the Sensor Module Cabinet SMC30  

LED Color State Description, cause Remedy 
– Off Electronic power supply is missing or outside permissible 

tolerance range. 
– 

Green Continuous 
light 

The component is ready for operation and cyclic DRIVE-
CLiQ communication is taking place. 

– 

Orange Continuous 
light 

DRIVE-CLiQ communication is being established. – 

Red Continuous 
light 

This component has at least one fault. 
Note: 
LED is controlled irrespective of the corresponding messages 
being reconfigured. 

Remedy and 
acknowledge fault 

Green/red Flashing light 
0.5 Hz 

Firmware is being downloaded. – 

Green/red Flashing light 
2 Hz 

Firmware download is complete. Wait for POWER ON. Carry out a 
POWER ON 

RDY 
READY 

Green/ 
orange 
or 
Red/orange 

Flashing light Component recognition via LED is activated (p0144). 
Note: 
Both options depend on the LED status when module 
recognition is activated via p0144 = 1. 

– 

– Off Electronic power supply is missing or outside permissible 
tolerance range. 
Power supply ≤ 5 V. 

– OUT >  
5 V 

Orange Continuous 
light 

Electronics power supply for encoder system available. 
Power supply > 5 V. 
Notice 
Make sure that the connected encoder can be operated with 
a 24 V power supply. If an encoder that is designed for a 5 V 
supply is operated with a 24 V supply, this can destroy the 
encoder electronics. 

– 
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3.1.3.4 Sensor Module Cabinet SMC40 

Table 3- 36 Meaning of the LEDs on the Sensor Module Cabinet-Mounted SMC40  

LED Color Status Description, cause Remedy 
– Off Electronics power supply is missing or outside the 

permissible tolerance range. 
– 

Green Continuous 
light 

The component is ready for operation and cyclic DRIVE-
CLiQ communication is taking place. 

– 

Orange Continuous 
light 

DRIVE-CLiQ communication is being established. – 

Red Continuous 
light 

At least one fault is present in this component. 
Note: 
LED is controlled irrespective of the corresponding 
messages being reconfigured. 

Remedy and 
acknowledge fault 

Green/red Flashing light 
2 Hz 

Firmware download is complete. Waiting for POWER ON. Carry out a POWER 
ON 

RDY 
READY 

Green/ 
orange 
or 
Red/ 
orange 

Flashing light Component recognition via LED is activated (p0144). 
Note: 
Both options depend on the LED status when module 
recognition is activated via p0144 = 1. 

– 

Each channel has a multifunction LED. 

3.1.3.5 Communication Board CBC10 for CANopen 

Table 3- 37 Meaning of the LEDs on the Communication Board CAN CBC10  

LED Color State Description, cause  Remedy 
– Off Electronic power supply is missing or outside permissible 

tolerance range. 
Communication Board either defective or not inserted. 

– 

LED ON OPERATIONAL – 
LED 
Blinking 

PREOPERATIONAL 
No PDO communication possible 

– 
Green 

LED 
Single 
flash 

STOPPED 
Only NMT communication possible 

– 

LED ON BUS OFF Check baud rate 
Check cabling 

LED 
Single 
flash 

ERROR PASSIVE MODE 
The error counter for "error passive" has reached the value 
127. After the SINAMICS drive system was booted no 
further active CAN component was on the bus. 

Check baud rate 
Check cabling 

OPT  
on the 
Control 
Unit 

Red 

LED 
Double 
flash 

Error Control Event, a Guard Event has occurred Check connection to 
CANopen master 



 Diagnostics 
 3.1 Diagnostics via LEDs 

Commissioning Manual 
Commissioning Manual, (IH1), 01/2013, 6SL3097-4AF00-0BP3 265 

3.1.3.6 Communication Board Ethernet CBE20 

Meaning of the LEDs on the CBE20 Communication Board Ethernet  

Table 3- 38 Meaning of the LEDs at ports 1 to 4 of the X1400 interface 

LED Color State Description 
– Off Electronics power supply is missing or outside permissible tolerance range (link 

missing or defective). 
Link port 

Green Continuous 
light 

A different device is connected to port x and a physical connection exists. 

– Off Electronics power supply is missing or outside permissible tolerance range (no 
activity). 

Activity 
port 

Yellow Flashing light Data is being received or sent at port x. 
 

Table 3- 39 Meaning of the Sync and Fault LEDs on the CBE20  

LED Color State Description 
– Off If the link port LED is green: 

The CBE20 is operating normally, data is being exchanged with the configured IO 
Controller. 

Flashing • The response monitoring interval has elapsed. 
• Communications is interrupted. 
• The IP address is incorrect. 
• Incorrect or no configuration. 
• Incorrect parameter settings. 
• Incorrect or missing device name. 
• IO Controller not connected/switched off, although an Ethernet connection has 

been established. 
• Other CBE20 errors 

Fault 

Red 

Continuous 
light 

CBE20 bus error 
• No physical connection to a subnet/switch. 
• Incorrect transmission rate 
• Full duplex transmission is not activated. 

– Off If the link port LED is green: 
Control Unit task system is not synchronized with the IRT clock. An internal 
substitute clock is generated. 

Flashing light Control Unit task system has synchronized with the IRT clock and data is being 
exchanged. 

Sync 

Green 

Continuous 
light 

Task system and MC-PLL have synchronized with the IRT clock. 
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Table 3- 40 Meaning of the OPT LED on the Control Unit  

LED Color State Description, cause Remedy 
– OFF Electronic power supply is missing or outside permissible 

tolerance range. 
Communication Board either defective or not inserted. 

– 

Continuous 
light 

Communication Board is ready and cyclic communication is 
taking place. 

– Green 

Flashing light 
0.5 Hz 

The Communication Board is ready, but cyclic 
communications is not running. 
Possible causes: 
• At least one fault is present. 
• Communication is being established. 

– 

Continuous 
light 

Cyclic communication via PROFINET has not yet been 
established. However, non-cyclic communications are 
possible. SINAMICS waits for a parameterizing/configuring 
telegram 

– 

Flashing light 
0.5 Hz 

The firmware update into the CBE20 has been completed 
with an error. 
Possible causes: 
• The CBE20 is defective. 
• The memory card for the Control Unit is defective. 
In this state CBE20 cannot be used. 

– 

Red 

Flashing light 
2 Hz 

There is a communications error between the Control Unit 
and the CBE20. 
Possible causes: 
• Board was withdrawn after booting. 
• The board is defective 

Correctly insert 
the board, if 
required, replace. 

OPT 

Orange Flashing light 
0.5 Hz 

Firmware is being updated. – 
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3.1.3.7 Voltage Sensing Module VSM10 

Table 3- 41 Meanings of the LEDs on the Voltage Sensing Module VSM10  

LED Color State Description, cause Remedy 
– Off Electronic power supply is missing or outside permissible 

tolerance range. 
– 

Green Continuous 
light 

The component is ready for operation and cyclic DRIVE-
CLiQ communication is taking place. 

– 

Orange Continuous 
light 

DRIVE-CLiQ communication is being established. – 

Red Continuous 
light 

This component has at least one fault. 
Note: 
LED is controlled irrespective of the corresponding messages 
being reconfigured. 

Remedy and 
acknowledge fault 

Flashing light 
0.5 Hz 

Firmware is being downloaded. – Green/red 

Flashing light 
2 Hz 

Firmware download is complete. Wait for POWER ON Carry out a 
POWER ON 

READY 

Green/ 
orange or 
Red/ 
orange 

Flashing light Component recognition via LED is activated (p0144). 
Note: 
Both options depend on the LED status when module 
recognition is activated via p0144 = 1. 

– 

3.1.3.8 DRIVE-CLiQ Hub Module DMC20 

Table 3- 42 Description of the LEDs on the DRIVE-CLiQ Hub Module DMC20  

LED Color State Description, cause Remedy 
– Off Electronic power supply is missing or outside permissible 

tolerance range. 
– 

Green Continuous 
light 

The component is ready for operation and cyclic DRIVE-
CLiQ communication is taking place. 

– 

Orange Continuous 
light 

DRIVE-CLiQ communication is being established. – 

Red Continuous 
light 

This component has at least one fault. 
Note: 
LED is controlled irrespective of the corresponding messages 
being reconfigured. 

Remedy and 
acknowledge fault 

Flashing light 
0.5 Hz 

Firmware is being downloaded. – 

READY 

Green/red 

Flashing light 
2 Hz 

Firmware download is complete. Wait for POWER ON Carry out a 
POWER ON 
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LED Color State Description, cause Remedy 
Green/ 
orange 
or 
Red/ 
orange 

Flashing light Component recognition via LED is activated (p0154). 
Note: 
Both options depend on the LED status when module 
recognition is activated via p0154 = 1. 

– 

3.1.4 Terminal Module 

3.1.4.1 Terminal Module TM15 

Table 3- 43 Meanings of the LEDs on the Terminal Module TM15  

LED Color Status Description, cause Remedy 
- Off Electronics power supply is missing or outside permissible 

tolerance range. 
– 

Green Continuous 
light 

The component is ready for operation and cyclic DRIVE-
CLiQ communication is taking place. 

– 

Orange Continuous 
light 

DRIVE-CLiQ communication is being established. – 

Red Continuous 
light 

At least one fault is present in this component. 
Note: 
The LED is activated regardless of whether the 
corresponding messages have been reconfigured. 

Remedy and 
acknowledge fault 

Flashing light 
0.5 Hz 

Firmware is being downloaded. – Green/red 

Flashing light 
2 Hz 

Firmware download is complete. Wait for POWER ON Carry out a 
POWER ON 

READY 

Green/ 
orange 
or 
Red/ 
orange 

Flashing light Component recognition via LED is activated (p0154). 
Note: 
Both options depend on the LED status when component 
recognition is activated via p0154 = 1. 

– 



 Diagnostics 
 3.1 Diagnostics via LEDs 

Commissioning Manual 
Commissioning Manual, (IH1), 01/2013, 6SL3097-4AF00-0BP3 269 

3.1.4.2 Terminal Module TM31 

Table 3- 44 Meanings of the LEDs on the Terminal Module TM31    

LED Color Status Description, cause Remedy 
- OFF Electronics power supply is missing or outside the 

permissible tolerance range. 
– 

Green Continuous light The component is ready for operation and cyclic DRIVE-
CLiQ communication is taking place. 

– 

Orange Continuous light DRIVE-CLiQ communication is being established. – 
Red Continuous light At least one fault is present in this component. 

Note: 
The LED is activated regardless of whether the 
corresponding messages have been reconfigured. 

Remedy and 
acknowledge fault 

0.5 Hz flashing 
light 

Firmware is being downloaded. – Green/red 

2 Hz flashing 
light 

Firmware download is complete. Wait for POWER ON Carry out a 
POWER ON 

READY 

Green/ 
orange or 
Red/ 
orange 

Flashing light Component recognition via LED is activated (p0154). 
Note: 
Both options depend on the LED status when component 
recognition is activated via p0154 = 1. 

– 

3.1.4.3 Terminal Module TM120 

Table 3- 45 Meaning of the LEDs on the Terminal Module TM120  

LED Color Status Description, cause  Remedy 
- Off Electronics power supply is missing or outside permissible 

tolerance range. 
Check power supply 

Green Continuous 
light 

The component is ready for operation and cyclic DRIVE-CLiQ 
communication is taking place. 

- 

Orange Continuous 
light 

DRIVE-CLiQ communication is being established. - 

 
Red 

 
Continuous 
light 

At least one fault is present in this component. Note: 
The LED is activated regardless of whether the corresponding 
messages have been reconfigured. 

Remedy and 
acknowledge fault 

Flashing 
light 
0.5 Hz 

Firmware is being downloaded. - Green/ 
Red 

Flashing 
light 
2 Hz 

Firmware download is complete. Wait for POWER ON Carry out a POWER 
ON 

 
 
 
 
 
READY 

Green/ 
orange or 
red/ 
orange 

 
Flashing 
light 
2 Hz 

Detection of the components via LED is activated (p0154). 
Note: 
Both options depend on the LED status when module 
recognition is activated via p0154 = 1. 

- 
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3.1.4.4 Terminal Module TM150 

Table 3- 46 Meaning of the LEDs at the Terminal Module TM150  

LED Color State Description, cause  Remedy 
– Off Electronic power supply is missing or outside 

permissible tolerance range. 
Check power supply 

Green Continuous light The component is ready for operation and cyclic DRIVE-
CLiQ communication is taking place. 

– 

Orange Continuous light DRIVE-CLiQ communication is being established. – 
 
Red 

 
Continuous light 

This component has at least one fault.  
Note: 
LED is controlled irrespective of the corresponding 
messages being reconfigured. 

Remedy and 
acknowledge fault 

Flashing light 
0.5 Hz 

Firmware is being downloaded. – Green/ 
Red 

Flashing light 
2 Hz 

Firmware has been downloaded. 
Wait for POWER ON. 

Carry out a POWER 
ON 

 
 
 
 
 
READY 

Green/ 
orange 
or 
red/ 
orange 

 
Flashing light 
2 Hz 

Component recognition via LED is activated (p0154). 
Note: 
Both options depend on the LED status when module 
recognition is activated via p0154 = 1. 

– 

3.1.4.5 Terminal Module TM41 

Table 3- 47 Meaning of the LEDs on the Terminal Module TM41    

LED Color Status Description, cause Remedy 
- Off Electronics power supply is missing or outside the 

permissible tolerance range. 
– 

Green Continuous 
light 

The component is ready for operation and cyclic 
DRIVE-CLiQ communication is taking place. 

– 

Orange Continuous 
light 

DRIVE-CLiQ communication is being established. – 

Red Continuous 
light 

At least one fault is present in this component. 
Note: 
The LED is activated regardless of whether the 
corresponding messages have been reconfigured. 

Remedy and 
acknowledge fault 

0.5 Hz flashing 
light 

Firmware is being downloaded. – Green/red 

2 Hz flashing 
light 

Firmware download is complete. Wait for POWER ON.  Carry out a POWER 
ON 

READY 

Green/ 
orange 
or 
Red/ 
orange 

Flashing light Component recognition via LED is activated (p0154). 
Note: 
Both options depend on the LED status when 
component recognition is activated via p0154 = 1. 

– 
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LED Color Status Description, cause Remedy 
– Off Zero mark found; wait for zero marker output; OR 

component switched off. 
– 

Red Continuous 
light 

Zero mark not enabled or zero mark search. – 

Continuous 
light 

Stopped at zero mark. – 

Z pulses 

Green 

Flashing light Zero mark is output at each virtual revolution. – 

3.1.4.6 Terminal Module TM54F 

Table 3- 48 Meaning of the LEDs on the Terminal Module TM54F    

LED Color Status Description, cause Remedy 
- Off Electronics power supply is missing or outside the 

permissible tolerance range. 
– 

Green Continuous 
light 

The component is ready for operation and cyclic DRIVE-
CLiQ communication is taking place. 

– 

Orange Continuous 
light 

DRIVE-CLiQ communication is being established. – 

Red Continuous 
light 

At least one fault is present in this component. 
Note: 
The LED is activated irrespective of whether the 
corresponding messages have been reconfigured. 

Remedy and 
acknowledge 
fault 

0.5 Hz flashing 
light 

Firmware is being downloaded. – Green/red 

2 Hz flashing 
light 

Firmware download is complete. Wait for POWER ON Carry out a 
POWER ON 

READY 

Green/orange 
or 
Red/orange 

Flashing light Component recognition via LED is activated (p0154). 
Note: 
Both options depend on the LED status when 
component recognition is activated via p0154 = 1. 

– 

– ON The controllable sensor power supply is functioning 
fault-free. 

– L1+, L2+,  

Red Continuous 
light 

There is a fault in the controllable sensor power supply. – 

– ON Sensor power supply is functioning fault-free.  L3+ 
Red Continuous 

light 
There is a fault in the sensor power supply.  

Fail-safe inputs / double inputs 
LED  LED    – 
x x+1  NC contact / NC contact 1): (z = 0..9, x = 0, 2, ..18)  
– Red Continuous 

light 
Different signal states at input x and x+1   

– – – No signal at input x and no signal at input x+1  

F_DI z 
(input x, 
(x+1)+, 
(x+1)-) 
 

 NC contact / NO contact1): (z = 0..9, x = 0, 2, ..18)  
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LED Color Status Description, cause Remedy 
– Red Continuous 

light 
Same signal states at input x and x+1  

– – – No signal at input x and no signal at input x+1  
LED LED    
x x+1  NC contact / NC contact1): (z = 0..9, x = 0, 2, ..18)  
Green Green Continuous 

light 
One signal at input x and one signal at input x+1  

 NC contact / NO contact1): (z = 0..9, x = 0, 2, ..18)  
Green Green  Continuous 

light 
One signal at input x and no signal at input x+1 – 

1) Inputs x+1 (DI 1+, 3+, .. 19+) can be set individually via parameter p10040 (TM54F). 
 p10040 (TM54F) = 0: Input x+1 is an NC contact. 
 p10040 (TM54F) = 1: Input x+1 is NO contact. 
 Factory setting: p10040 (TM54F) = 0 for all inputs x+1. 
Single digital inputs, not fail-safe 

– Off No signal at digital input x (x = 20..23) – DI x 
 Green Continuous 

light 
Signal at digital input x – 

Fail-safe digital outputs with associated readback channel 
F_DO y 
(0+..3+, 
0-..3-) 

Green Continuous 
light 

Output y (y=0 .. 3) carries a signal – 

Readback input DI 2y for output F_DO y (y = 0..3) at test stop. 
The status of the LEDs also depends on the type of external circuit. 
DI 2y – Off One of the two output lines y+ or y- or both lines of 

output y carry a signal 
– 

 Green Continuous 
light 

Both output lines y+ and y- carry no signal – 
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3.2 Diagnostics via STARTER 
The diagnostic functions support commissioning and service personnel during 
commissioning, troubleshooting, diagnostics and service activities.  

Precondition 
● Online operation of the STARTER commissioning tool. 

Diagnostic functions 
The following diagnostic functions are available in the STARTER commissioning tool: 

● Specifying signals with the ramp-function generator 

● Signal recording with the trace function  

● Analyzing the control response with the measuring function 

● Outputting voltage signals for external measuring devices via test sockets 

3.2.1 Function generator 
The function generator is part of the STARTER commissioning tool. 

The ramp-function generator can be used, for example, for the following tasks:  

● To measure and optimize control loops. 

● To compare the dynamic response of coupled drives. 

● To specify a simple traversing profile without a traversing program. 

The ramp-function generator can be used to generate different signal shapes.  

In the "Connector output" operating mode (r4818), the output signal can be injected into the 
control loop via the BICO interconnection. 

For vector control, corresponding to the selected operating mode, this setpoint can also be 
fed into the control structure as, for example, a current setpoint, disturbing torque, or current 
setpoint. The impact of superimposed control loops is automatically suppressed. 
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Properties 
● Operating modes of the ramp-function generator for SERVO and VECTOR drive types: 

– Connector output 

● Operating modes of the function generator for a SERVO drive: 

– Speed setpoint downstream of filter (speed setpoint filter) 

– Speed setpoint upstream of filter (speed setpoint filter) 

– Disturbing torque (downstream of current setpoint filter) 

– Current setpoint downstream of filter (current setpoint filter) 

– Current setpoint upstream of filter (current setpoint filter) 

● Connecting to each drive of the topology is possible.  

● The following parameterizable signal shapes can be set: 

– Square-wave 

– Staircase 

– Triangular 

– Sinusoidal 

– PRBS (pseudo random binary signal, white noise) 

● An offset is possible for each signal. The ramp-up to the offset is parameterizable. Signal 
generation begins after the ramp-up to the offset. 

● Restriction of the output signal to the minimum and maximum value settable. 

Injection points of the function generator 

 
Figure 3-1 Injection points of the ramp-function generator 
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Further signal shapes 
Additional signal waveforms can be generated. 

Example: 

The "triangular" signal form can be parameterized with "upper limitation" to produce a 
triangle with no peak. 

 
Figure 3-2 "Triangular" signal without peak 

Parameterizing and operating the ramp-function generator  
You operate and parameterize the function generator using the STARTER commissioning 
tool. 

 
Figure 3-3 Function generator 

 

 Note 

Please refer to the online help for more information about parameterizing and operation.  
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Starting/stopping the ramp-function generator 
 

WARNING  
Danger due to hazardous axis movement 

With the corresponding ramp-function generator parameter settings (e.g. offset), the motor 
can "drift" and travel to its end stop.  

The movement of the drive is not monitored while the ramp-function generator is active.  
 

Start function generator: 

1. Load the function generator. 

– Click on the symbol . 

or 

– In the project navigator, double-click on "Drives" > "Drive_xy" > "Commissioning" > 
"Function generator". 

2. Select "Function generator as a commissioning tool". 

3. Select an operating mode e.g. "Speed setpoint after filter". 

4. Select a drive, for instance "SERVO_02". 

5. Set a signal shape, for example, "Squarewave". 

6. Click the "Assume control priority!" button. 

7. For "Sign of life monitoring" click on the "Accept" button. 
(the control priority button then changes to yellow). 

8. Click on the symbol  "Drive on". 

9. Start the function generator by clicking on the triangle next to the red zero ( "Start 
FctGen" button). 

10. Carefully read the "Caution" note and confirm with "Yes". 

The drive starts and executes the selected trace function. 

Trace recordings are now possible. 

Stopping the function generator: 

1. Click on the "Stop FctGen" button. 

Or 

2. Click on the symbol  "Drive off" in order to stop the drive. 

Parameterization 

The "Function generator" parameter screen is selected with the  symbol in the toolbar of 
the STARTER commissioning tool. 
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3.2.2 Trace function 

3.2.2.1 Single trace 
You can use the trace function to record measured values over a defined period, depending 
on trigger conditions. Alternatively, the measured values can also be recorded using 
immediate recording. 

In the STARTER commissioning tool you can parameterize the trace function by using the 
"Trace" parameterizing screen form. 

Calling the "Trace" parameterizing screen form 
1. In the STARTER commissioning tool, click on the symbol  (device trace-function 

generator). 

The "Trace" parameterizing screen form is then displayed. Example: 

 
Figure 3-4 Trace function 
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Parameterizing and using the trace function  
 

 Note 

Detailed information on how to parameterize and operate the trace function is available in 
the STARTER online help in Chapter "Trace, measuring functions and automatic controller 
setting".  

 

 
Figure 3-5 Trace function 

The unit cycle time display flashes 3 times at around 1 Hz when the time slice is changed 
from < 4 ms to ≥ 4 ms (see description under "Properties"). The display also flashes in the 
inverse direction from ≥ 4 ms to < 4 ms. 
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Properties  
● Two independent traces per Control Unit 

● Up to 8 recording channels for each trace 
When more than 4 channels per single trace are used, the trace's device clock cycle is 
switched automatically from 0.125 ms (0.250 ms for vector control) to 4 ms. As a 
consequence, the performance of the SINAMICS S120 is not influenced too strongly by 
the trace function. 

● Single trace:  
Device clock cycles of the SINAMICS S120 trace 
Up to 4 channels: 0.125 ms (servo control)/0.250 ms (vector control) 
≥ 5 channels: 4 ms (servo control/vector control) 
The specified trace cycles can be increased. 

● Endless trace: 
The parameter data are written to the memory until it is full. Additional parameter data are 
then lost. 
A ring buffer can be selected in order to avoid this. When the ring buffer is activated, then 
the STARTER commissioning tool automatically starts again from the beginning to write 
to the trace memory after the last trace parameter was saved. 
Device cycle of the SINAMICS S120 trace for an endless trace: 

– Up to 4 channels: 2 ms (servo control/vector control) 

– ≥ 5 channels: 4 ms (servo control/vector control) 
The specified trace cycles can be increased. 
If the 4 ms time slice is not available, then the next higher time slice is selected. 

● Triggering 

– Without triggering (recording immediately after start) 

– Triggering on signal with edge or on level 

● STARTER commissioning tool 

– Automatic or adjustable scaling of display axes 

– Signal measurement via cursor 

● Adjustable trace cycle: Integer multiples of the basic sampling time 
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3.2.2.2 Multiple trace 
A multiple trace consists of individual, completed consecutive traces. Using multiple tracing 
on a card, it is possible to cyclically record (a specific number) traces with the same trace 
configuration (number of channels, sample depth, recording cycle,..), and to save these 
traces persistently on the drive memory card. 

The functions "endless trace", "individual trace" and "multiple-trace" cannot be used at the 
same time. With a correspondingly incorrect configuration, alarm "A02097" is output. 
However, a multiple trace with a cycle of 1 is nothing more than a single trace with saved 
measurement results. 

 

NOTICE  
Shorter service life of memory cards as a result of multiple traces 

The service life of the cards can be shortened by the multiple traces because the memory 
media is subject to wear as a result of the write access operations from a technical point of 
view. 

 

 Note 

The performance of the complete system can be negatively influenced by a continuous 
multiple trace. 

 

Precondition 
A multiple trace is only possible if the memory card is plugged in and not blocked. In this 
case, alarm "A02098 MTrace: cannot be saved" is output with alarm value "1".  

Performing a multiple trace 

Activating a multiple trace 
 

 Note 

The multiple trace can be activated or set separately for each trace recorder.  
 

The multiple trace and the number of cycles is defined by means of parameter p4840. The 
multiple trace is deactivated with the setting p4840 = 0.  

The multiple trace is activated using the parameter setting p4840 ≥ 1. 
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Sequence of multiple trace 
1. A multiple trace is started just like a conventional single trace using parameter p4700. 

2. The multiple trace component saves the measurement result after the trigger condition 
has occurred and the trace data have been completely recorded. 

3. The single trace that has actually been completed is now automatically restarted from the 
multiple trace component. In this case, the same trace configuration (trigger condition, 
recording cycle, etc. ) is used as before. The trace buffer of the previous single trace is 
emptied in the process. 

4. All additional cycles are automatically executed in the same way. The currently running 
cycle is displayed in parameter r4841 – including its subsequent deadtime (starting  
with 1). 

Trace status 

The status of the particular single trace can be read via parameter r4705. You cannot stop a 
multiple trace and then continue it. A multiple trace can only be canceled and restarted.  

Time assignment 

An individual trace can be assigned with respect to time using two parameters. The two 
parameters show the time at which the trigger condition was fulfilled:  

● r4797 shows the trigger instant for trace recorder 0 

● r4798 shows the trigger instant for trace recorder 1 

3.2.2.3 Startup trace 
A start up trace basically consists of a conventional single trace with all of its configuration 
options (number of channels, sampling depth, recording cycle, etc. ). With the appropriate 
configuration, a startup trace is automatically active after a drive restarts.  

Configure startup trace 
1. Set the required trace configuration (e.g.: p4710, p4711, …). 

2. Activate the startup trace using the parameter setting p4703[bit 0] = 1. 

After the drive restarts, a new trace is immediately started (without any additional user 
action). 
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3.2.2.4 Overview of important alarms and parameters 

Overview of important alarms and faults (see SINAMICS S120/S150 List Manual) 
 
• A02097 MTrace: multiple trace cannot be activated 

• A02098 MTrace: cannot be saved 

 

Overview of important parameters (see SINAMICS S120/S150 List Manual) 
 
Startup trace 
• p4703 Trace options 

Multiple trace 
• r4797 Trace 0 trigger instant 

• r4798 Trace 1 trigger instant 

• p4840 MTrace, setting the number of cycles 

• r4841 MTrace, actual cycle display 
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3.2.3 Measuring function 
The measuring function is used for optimizing the drive controller. By parameterizing the 
measuring function, the impact of superimposed control loops can be suppressed selectively 
and the dynamic response of the individual drives analyzed. The ramp-function generator 
and trace function are linked for this purpose. The control loop is supplied with the ramp-
function generator signal at a given point (e.g. speed setpoint) and recorded by the trace 
function at another (e.g. speed actual value). The trace function is parameterized 
automatically when the measuring function is parameterized. Specific predefined operating 
modes for the trace function are used for this purpose.  

Parameterizing and using the measuring function 
The measuring function is parameterized and operated via the STARTER commissioning 
tool. 

 
Figure 3-6 "Measuring function" initial screen 

 

 Note 

Please refer to the online help for more information about parameterizing and operation.  
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Measuring functions 
● Speed controller reference frequency response (downstream of the speed setpoint filter) 

● Speed controller path (excitation downstream of current setpoint filter) 

● Speed controller interference frequency response (fault downstream of the current 
setpoint filter) 

● Speed controller reference frequency response (upstream of the speed setpoint filter) 

● Speed controller setpoint change (downstream of the speed setpoint filter) 

● Speed controller disturbance step change (fault downstream of the current setpoint filter) 

● Current controller reference frequency response (downstream of the current setpoint 
filter) 

● Current controller setpoint change (downstream of the current setpoint filter) 

Starting/stopping the measuring function 
 

WARNING  
Danger due to hazardous axis movement 

With the corresponding measuring function parameter settings (e.g. offset), the motor can 
"drift" and travel to its end stop.  

The movement of the drive is not monitored while the measuring function is active.  
 

To start the measuring function: 

1. Set the preconditions for starting the measuring function. 

2. Select the drive in the project tree. 

3. In the project tree, double-click on "Drive" > "Commissioning" > "Measuring function". 

4. Set the required measuring function. 

5. Then download the settings to the target device by clicking on the symbol  "Download 
parameterization". 

6. Start the function generator ("Start measuring function" button). 

To stop the measuring function: 

The measuring function runs for a limited time and then automatically stops. 

1. If you wish to immediately stop, click on the button "Stop measuring function". 

Parameterization 

The "Measurement function" parameterizing screen form is selected via the following symbol 

 in the toolbar of the STARTER commissioning tool. 
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3.2.4 Measuring sockets 
The three measuring sockets are used to output analog signals. Any interconnectable analog 
signal can be output at each measuring socket on the Control Unit.  

 

NOTICE  
Incorrect use of measuring sockets 

The measuring sockets should be used for commissioning and servicing purposes only.  

The measurements may only be carried out by properly trained specialist personnel.  
 

 
Front view View from below 

Figure 3-7 CU310-2 DP/PN measuring sockets, CU320-2 DP/PN measuring sockets  
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Parameterizing and using the measuring sockets 
The measuring sockets are parameterized and operated via the STARTER commissioning 
tool. You can access the operating window for the measuring sockets in the project window 
under "Control Unit" > "Inputs/outputs". In the inputs/outputs window, click on the "Test 
sockets" tab. 

 
Figure 3-8 "Measuring sockets" initial screen 

 

 Note 

You can find additional information on parameterizing and operating in the online help.  
 



 Diagnostics 
 3.2 Diagnostics via STARTER 

Commissioning Manual 
Commissioning Manual, (IH1), 01/2013, 6SL3097-4AF00-0BP3 287 

Properties 
● Resolution: 8-bit 

● Voltage range: 0 V to +4.98 V 

● Measuring cycle: Depends on the measuring signal 
(e.g. actual speed value in speed controller cycle 125 μs) 

● Short-circuit-proof 

● Parameterizable scaling 

● Adjustable offset 

● Adjustable limitation 

Signal chart for measuring sockets 
The signal characteristic for measuring sockets is shown in function diagram 8134 (see 
SINAMICS S120/S150 List Manual).  

Which signal can be output via measuring sockets?  
The signal to be output via a measuring socket is specified by parameterizing the connector 
input p0771[0...2]. 

Important measuring signals (examples): 

 
r0060 CO: Speed setpoint before speed setpoint filter 
r0063 CO: Actual speed value 
r0069[0...2] CO: Phase currents actual value 
r0075 CO: Field-generating current setpoint 
r0076 CO: Field-generating actual current 
r0077 CO: Torque-generating current setpoint 
r0078 CO: Torque-generating actual current 

Scaling 
Scaling specifies how the measuring signal is processed. A straight line with 2 points must 
be defined for this purpose. 

Example: 

x1 / y1 = 0.0% / 2.49 V x2 / y2 = 100.0% / 4.98 V (default setting) 

– 0.0% is mapped onto 2.49 V 

– 100.0% is mapped onto 4.98 V 

– 100.0% is mapped onto 0.00 V 
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Offset 
The offset is applied additively to the signal to be output. The signal to be output can thus be 
displayed within the measuring range. 

Limitation 
● Limitation On 

If signals are output outside the permissible measuring range, the signal is limited to 4.98 
V or to 0V. 

● Limitation off 

The output of signals outside the permissible measuring range causes a signal overflow. 
In the event of an overflow, the signal jumps from 0 V to 4.98 V or from 4.98 to 0 V. 

Example of measured value output via a measuring socket 
The actual speed (r0063) is to be output for a drive via measuring socket T1. 

The following settings should be made: 

1. Connect and set the measuring device. 

2. Interconnect the signal (e.g. STARTER). 

Interconnect the connector input (CI) belonging to the measuring socket with the desired 
connector output (CO): 

CI: p0771[1] = CO: r0063 

3. Parameterize the signal characteristic (scaling, offset, limitation). 
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Function diagrams (see SINAMICS S120/S150 List Manual)  
 
• 8134 Diagnostics - measuring sockets 

Overview of important parameters (see SINAMICS S120/S150 List Manual) 
 
Adjustable parameters 
• p0771[0...2] CI: Measuring sockets signal source 

• p0777[0...2] Measuring sockets characteristic value x1 

• p0778[0...2] Measuring sockets characteristic value y1 

• p0779[0...2] Measuring sockets characteristic value x2 

• p0780[0...2] Measuring sockets characteristic value y2 

• p0783[0...2] Measuring sockets offset 

• p0784[0...2] Measuring sockets limit on/off 

Display parameters 
• r0772[0...2] Measuring sockets signal to be output 

• r0774[0...2] Measuring sockets output voltage 

• r0786[0...2] Measuring sockets normalization per volt 
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3.3 Diagnostic buffer 
A diagnostic buffer mechanism has already been implemented in the SIMATIC S7 
environment. It can record important operational events in the automation system as a kind 
of log book (restriction: The availability of the diagnostics buffer mechanism is also 
dependent on the hardware release of the Control Unit).  

The diagnostic buffer is in the non-volatile memory, so data written to it can be read out for 
subsequent analysis of a malfunction (including pre-history). 

The essential events recorded in the buffer are: 

● Faults 

● Important changes to the boot status (end status) and partial booting of DOs 

● Commissioning procedures 

● State change of PROFIBUS/PROFINET communication 

● Exceptions 

The entries in the diagnostic buffer can be called up via the drive unit properties (symbol in 
project navigator --> right mouse-click) under the menu option "Target device" > "Device 
diagnostics". 

 

 Note 
STEP 7 full version 

Device diagnostics in the STARTER commissioning tool is only displayed when you have 
installed the full version of STEP7. 

 

Events recorded by the diagnostic buffer 
The following list shows the entries defined for SINAMICS drive units. Additional information 
is marked with <>. 

Faults 

An entry is defined for each possible DO number. The fault code and fault value are entered 
in the additional information.  

Example:  
Fault DO 5: Fault code 1005 fault value 0x30012 
Alarms are not saved in the diagnostic buffer. Propagated faults (faults which are signaled to 
all DOs) are only stored in the diagnostic buffer once. 
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Booting procedures and booting status changes 

In principle, only start and completion are recorded for booting procedures. Booting status 
(see r3988) are only recorded when an end status arises that can only be exited by user 
action (r3988 = 1, 10, 200, 250, 325, 370, 800). Booting statuses and booting status 
changes are: 

● POWER ON 

● Error in booting (r3988 = 1) 

● Fatal error in booting (r3988 = 10) 

● Waiting for first commissioning (r3988 = 200) 

● Topology error in booting (r3988 = 250) 

● Waiting for entry of drive type (r3988 = 325) 

● Waiting until p0009 = 0 is set (r3988 = 370) 

● Boot status r3988 = <state at which 670 or 680> reached 

● Booting finished, cyclic operation 

● Reason for new boot < 0 = Internal reason; 1 = Warm start; 2 = Booting from saved data; 
3 = Booting after download> 

● Drive reset via p0972 = <Mode> 

● Partial booting DO started <DO number> 

● Partial booting DO <DO number> finished 

Commissioning procedures 

● Device commissioning: New status p0009 = <new value p0009> 

● Commissioning DO <DO number>: New status p0010 = <new value p0010> 

● Ram2Rom DO <0 for all DOs> started 

● Ram2Rom DO <0 for all DOs> completed 

● Project download started 

● DO <DO_Number> deactivated 

● DO <DO_Number> reactivated 

● Component <Component number> deactivated 

● Component <Component number> reactivated 

● Power Off/ Power On required after firmware update (DO <DO number> 
Component < Component number >) 

● DO <DO-No> deactivated and not available 

● Component <component number> deactivated and not available 
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Communication (PROFIBUS, PROFINET, ...) 

● PZD <IF1 or IF2> cyclic data exchange started 

● PZD <IF1 or IF2> cyclic data exchange completed 

● Changeover to UTC time for operating hours count status <Days> <Milliseconds> 

● Time correction (correct) by <correction value> seconds 

Exceptions 

Exceptions can be taken from the crash diagnostics already available in the new boot run. 
The exceptions are always entered into the diagnostic buffer first, even before the entry 
"POWER ON". 

● Data Abort Exception Address: <Content Program Counter> 

● Floating Point Exception Address: <Content Program Counter> 

● Prefetch Abort Exception Address: <Content Program Counter> 

● Exception type <Type coding> Info: <Info depends on type> 

Treatment of the time stamp  
After successful time synchronization (in cyclic operation), the UTC time is used as a time 
stamp. Up until this time (POWER ON and switching to UTC time) the operating hours 
counter is used for all entries. The UTC time is entered for following entries. 
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3.4 Diagnostics of uncommissioned axes 
To be able to identify uncommissioned drive objects of the classes "Infeeds", "Motor 
Module", "SERVO" and "VECTOR", there is an operating display in parameter r0002.  

● r0002 "Infeed operating display" = 35: Carry out the first start-up 

● r0002 "Drive operating display" = 35: Carry out the first start-up 

The parameter r0002 "drive operating display" = 35 is then displayed if p3998[D]=0 is in any 
data set. Parameter p3998 specifies whether the first commissioning of the drive is still to be 
carried out (0 = yes, 2 = no). 

Parameter p3998 is set to the value 2 when the calculation of the motor and control 
parameters for all data sets has been completed without errors (see r3925 bit0 = 1) and the 
encoder selection p0400 is not at 10100 (encoder identification). 

The limitation that all drive data sets (DDS) must be commissioned in order to exit 
commissioning is ensured by checking the parameters involved (see also F07080 in the 
SINAMICS S120/S150 List Manual). 

Infeed module 
An infeed (Active Line Modules, Basic Line Modules or Smart Line Modules with DRIVE-
CLiQ) is considered commissioned when the line voltage and line frequency have been 
parameterized with appropriate values. A basic setting of 50 Hz or 60 Hz is expected for the 
line frequency. 

The line voltage p0210 may need to be adjusted to the existing power supply. 

To exit the state r0002 "Infeed operating display" = 35, set parameter p3900 "completion of 
quick commissioning" to the value 3, after any necessary adjustment to the line voltage. 

For a 400 V unit, for example, the voltage p0210 is always initialized with 400 V. Although it 
is possible to switch on when connected to all line supplies from 380 V - 480V, operation is 
not always optimal and/or alarm messages are displayed (see SINAMICS S120/S150 List 
Manual). 
If the unit is not connected to a 400V line supply, then the rated voltage p0210 should be 
adjusted. This can also be done after the first time the unit is switched on, by setting  
p0010 = 1. 
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Motor Module 
A drive is considered to have been commissioned when in every drive data set (DDS) the 
motor and encoder data sets have been assigned valid data:  

● Motor data sets (MDS): 
p0131, p0300, p0301 etc. (see SINAMICS S120/S150 List Manual)  

● Encoder data sets (EDS): 
p0141, p0142, p0400 etc. (see SINAMICS S120/S150 List Manual)  

After parameterizing the motor and encoder data via quick commissioning 
(p0010 = 1 ->0) use p3900 "completion of quick commissioning" > 0 to exit. 

If commissioning should not be run using quick commissioning, the motor data should be 
entered via p0010 = 3 (p0340[0...n] "Automatic calculation of motor/control parameters" =1) 
after entering the rating plate data, and after that the encoder data entered via p0010 = 4. 

If the above conditions are not met, in r0002 of the drive concerned the value r0002 = 35: 
"Carry out first commissioning" is shown. 

It is not taken into account whether at switch on (pulse enable) required BICO sources are 
already parameterized, or are still at the value 0. Example: 

● p0840 "BI: ON/OFF1" or 

● p0864 "BI: Infeed operation" 

If, after commissioning all DDSs, parameter p0010 is set once more to a value greater than 
0, in r0002 the value r0002 = 46: "Switching on inhibited - exit the commissioning mode 
(p0009, p0010)" will be displayed. 

The drive has been commissioned, however the pulses cannot be enabled. 

Note on p0010 = 1 (quick commissioning): 
Quick commissioning with p3900 > 0 (when p0010 = 1) works for all DDSs, where motor and 
encoder data have been entered. 

This means that if quick commissioning is carried out a second or third time (or more), 
previously calculated and possibly user-adjusted data will be overwritten or recalculated. 

For this reason we recommend carrying out any subsequent commissioning of a certain 
DDS (e.g. changing the motor), specifically using p0010 = 3 and p0010 = 4 instead of  
p0010 = 1. 
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Example 
The image below shows a diagram of the diagnostic performance of uncommissioned 
infeeds and drives. A configuration with one power unit (DO2) and respectively two DDSs, 
MDSs and EDSs has been assumed. DO1 represents the CU. 

The unit has already been commissioned. 

The number of data sets and the components assigned to the DO2 have already been 
entered and the data set allocated. 

 
Figure 3-9 Diagnostics of uncommissioned axes 
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3.5 Fault and alarm messages 

3.5.1 General information about faults and alarms 
The errors and states detected by the individual components of the drive system are 
indicated by messages.  

The messages are categorized into faults and alarms. 
 

 Note 

The individual faults and alarms are described in Chapter "Faults and alarms" in the 
SINAMICS S120/S150 List Manual. Function diagrams for the fault buffer, alarm buffer, fault 
trigger and fault configuration are also contained in the Section "Function diagrams" - "Faults 
and alarms". 

 

Properties of faults and alarms 
● Faults (code F01234)  

– Are identified by Fxxxxx. 

– Can lead to a fault reaction. 

– Must be acknowledged once the cause has been remedied. 

– Status via Control Unit and LED RDY. 

– Status via PROFIBUS status signal ZSW1.3 (fault active). 

– Entry in the fault buffer. 

● Alarms (code A56789)  

– Are identified by Axxxxx. 

– Have no further effect on the drive. 

– The alarms are automatically reset once the cause has been remedied. No 
acknowledgement is required. 

– Status via PROFIBUS status signal ZSW1.7 (alarm active). 

– Entry in the alarm buffer. 

● General properties of faults and alarms 

– Can be configured (e.g. change fault to alarm, fault reaction). 

– Triggering on selected messages possible. 

– Initiation of messages possible via an external signal. 

– Contains the component number for identifying the SINAMICS component involved 

– Contains diagnostic information on the message involved 
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Acknowledging faults 
The list of faults and alarms specifies how each fault is acknowledged after the cause has 
been remedied.  

● Acknowledgement of faults by "POWER ON" 

– Switch the drive on/off (POWER ON) 

– Press the RESET button on the Control Unit 

● Acknowledgement of faults by "IMMEDIATE" 

– Via PROFIBUS control signal 

STW1.7 (reset fault memory): 0/1 edge 

Set STW1.0 (ON/OFF1) = "0" and "1" 

– Via external input signal 

Binector input and interconnection with digital input 

p2103 = "Requested signal source" 

p2104 = "Requested signal source" 

p2105 = "Requested signal source" 

Across all of the drive objects (DO) of a Control Unit 

p2102 = "Requested signal source" 

● Acknowledge faults with "PULSE INHIBIT" 

– The fault can only be acknowledged with a pulse inhibit (r0899.11 = 0). 

– The same possibilities are available for acknowledging as described under 
acknowledge IMMEDIATELY. 

 

 Note 

The drive can only resume operation after all active faults have been acknowledged.  
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3.5.2 Buffer for faults and alarms 
 

 Note 

A fault and alarm buffer is provided for each drive. The drive and device-specific messages 
are entered in these buffers.  

The contents of the fault buffer are saved to non-volatile memory when the Control Unit is 
powered down, i.e. the fault buffer history is still available when the unit is powered up again. 

 

 Note 

The entry in the fault/alarm buffer is made after a delay. For this reason, the fault/alarm 
buffer should not be read until a change in the buffer is also recognized (r0944, r2121) after 
"Fault active"/"Alarm active" is output.  
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Fault buffer 
Faults which occur are entered in the fault buffer as follows:  

r0949[63] [I32]
r2133[63] [ Float]

r0945[0]

r0945[1]

r0945[7]

r0945[56]

r0945[57]

r0945[63]

r0945[8]

r0945[9]

r0945[15]

r0949[0] [I32]
r2133[0] [Float]

r0949[1] [I32]
r2133[1] [Float]

r0949[7] [I32]
r2133[7] [Float]

r0949[56] [I32]
r2133[56] [ Float]

r0949[57] [I32]
r2133[57] [ Float]

r0949[8] [I32]
r2133[8] [Float]

r0949[9] [I32]
r2133[9] [Float]

r0949[15] [I32]
r2133[15] [ Float]

r0948[0] [ms]
r2130[0] [ d]

r0948[1] [ms]
r2130[1] [ d]

r0948[7] [ms]
r2130[7] [ d]

r0948[56] [ms]
r2130[56] [d]

r0948[57] [ms]
r2130[57] [d]

r0948[63] [ms]
r2130[63] [d]

r0948[8] [ms]
r2130[8] [ d]

r0948[9] [ms]
r2130[9] [ d]

r0948[15] [ms]
r2130[15] [d]

r2109[0] [ ms]
r2136[0] [d]

r2109[1] [ ms]
r2136[1] [d]

r2109[7] [ ms]
r2136[7] [d]

r2109[56] [ms]
r2136[56] [d]

r2109[57] [ms]
r2136[57] [d]

r2109[63] [ms]
r2136[63] [d]

r2109[8] [ ms]
r2136[8] [d]

r2109[9] [ ms]
r2136[9] [d]

r2109[15] [ms]
r2136[15] [d]

r3115[63]

r3115[57]

r3115[56]

r3115[15]

r3115[9]

r3115[8]

r3115[7] <1>

r3115[7]

r3115[0]

<1>

r3122[0]

<1>

r3122[7]

r3122[7]

r3122[8]

r3122[9]

r3122[15]

r3122[56]

r3122[57]

r3122[63]

r3120[0]

r3120[7]

r3120[7]

r3120[8]

r3120[9]

r3120[15]

r3120[56]

r3120[57]

r3120[63]

 
Figure 3-10 Structure of the fault buffer 
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Properties of the fault buffer: 

● A new fault incident encompasses one or more faults and is entered in "Current fault 
incident". 

● The entries are arranged in the buffer according to the time at which they occurred. 

● If a new fault incident occurs, the fault buffer is reorganized. The history is recorded in 
"Acknowledged fault incident" 1 to 7. 

● If the cause of at least one fault in "Current fault incident" is remedied and acknowledged, 
the fault buffer is reorganized. Faults that have not been remedied remain in "Current 
fault incident". 

● If "Current fault incident" contains eight faults and a new fault occurs, the fault in the 
parameters in index 7 is overwritten by the new fault. 

● r0944 is incremented each time the fault buffer changes. 

● A fault value (r0949) can be output for a fault. The fault value is used to diagnose the fault 
more accurately; please refer to the fault description for details of the meaning. 

Clear fault buffer 

● Delete fault buffer for all drive objects: 
p2147 = 1 --> p2147 = 0 is automatically set after execution. 

● Delete fault buffer for a specific drive object: 
p0952 = 0 --> The parameter belongs to the specified drive object. 

The fault buffer contents are automatically deleted for the following events: 

● Restore factory setting (p0009 = 30 and p0976 = 1). 

● Download with modified structure (e.g. number of drive objects changed). 

● Power-up after other parameter values have been loaded (e.g. p0976 = 10). 

● Upgrade firmware to later version. 
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Alarm buffer, alarm history 
An alarm in the alarm buffer comprises the alarm code, the alarm value and the alarm time 
(received, resolved). The alarm history occupies the last indices ([8...63]) of the parameter.  

 
Figure 3-11 Structure of alarm buffer 

Alarms that occur are entered in the alarm buffer as follows: 

A maximum of 64 alarms are displayed in the alarm buffer: 

● Index 0 ... 6: The first 7 alarms are displayed. 

● Index 7: The most recent alarm is displayed. 

A maximum of 56 alarms are displayed in the alarm history: 

● Index 8: The most recent alarm is displayed. 

● Index 9 .. 63: The first 55 alarms are displayed. 
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Properties of the alarm buffer/alarm history: 

● The arrangement in the alarm buffer is made after the time that they occurred from 7 to 0. 
In the alarm history, this is from 8 to 63. 

● If 8 alarms have been entered into the alarm buffer, and a new alarm is received, then the 
alarms that have been resolved are transferred into the alarm history. 

● r2121 is incremented each time the alarm buffer changes. 

● An alarm value (r2124) can be output for an alarm. The alarm value is used to diagnose 
the alarm more accurately; please refer to the alarm description for details of the 
meaning. 

Deleting the alarm buffer, index [0...7]: 

● The alarm buffer index [0...7] is reset as follows: p2111 = 0 

3.5.3 Configuring messages 
The properties of the faults and alarms in the drive system are permanently defined.  

For several messages, in a specific scope defined by the drive system, the properties can be 
changed as follows: 

 
Change message type (example) 
Select message Set message type 
p2118[5] = 1001 p2119[5] = 1: Fault (F) 
  = 2: Alarm (A) 
  = 3: No message (N) 
Change fault reaction (example) 
Select message Set fault response 
p2100[3] = 1002 p2101[3] = 0: None 
  = 1: OFF1 
  = 2: OFF2 
  = 3: OFF3 
  = 4: STOP1 (available soon) 
  = 5: STOP2 
  = 6: IASC/DC brake 

Internal armature short-circuit braking or 
DC brake 

  = 7: ENCODER (p0491) 
Change acknowledgement (example) 
Select message Set acknowledgement 
p2126[4] = 1003 p2127[4] = 1: POWER ON 
  = 2: IMMEDIATELY 
  = 3: PULSE INHIBIT 
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19 message types per drive object can be changed. 
 

 Note 

If BICO interconnections exist between drive objects, all interconnected objects must be 
configured.  

Example: 

The TM31 has BICO interconnections with drive 1 and 2 and F35207 is to be reconfigured 
as an alarm. 
• p2118[n] = 35207 and p2119[n] = 2 
• These settings are required for for TM31, drive 1 and drive 2. 

 

 Note 

Only those messages which are listed in the indexed parameters can be changed as 
desired. All other message settings retain their factory settings or are reset to the factory 
settings.  

Examples:  
• In the case of messages listed via p2128[0...19], the message type can be changed. The 

factory setting is set for all other messages. 
• The fault response of fault F12345 has been changed via p2100[n]. The factory settings 

should be restored (p2100[n] = 0). 
 

Triggering on messages (example)  
 
Select message Trigger signal 
p2128[0] = 1001 BO: r2129.0 
or 
p2128[1] = 1002 BO: r2129.1 

 

 

 Note 

The value from CO: r2129 can be used as group trigger. 

CO: r2129 = 0 No selected message has been output. 

CO: r2129 > 0 Group trigger. 
At least one selected message has been output. 
The individual binector outputs BO: r2129 should be investigated. 
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External triggering messages 
If the appropriate binector input is interconnected with an input signal, fault 1, 2 or 3 or alarm 
1, 2 or 3 can be triggered via an external input signal.  

Once an external fault (1 to 3) has been triggered on the Control Unit drive object, this fault 
is also present on all associated drive objects. If one of these external faults is triggered on a 
different drive object, it is only present on that particular drive object. 

 
BI: p2106 ––> External fault 1 ––> F07860(A) 
BI: p2107 ––> External fault 2 ––> F07861(A) 
BI: p2108 ––> External fault 3 ––> F07862(A) 
BI: p2112 ––> External alarm 1 ––> A07850(F) 
BI: p2116 ––> External alarm 2 ––> A07851(F) 
BI: p2117 ––> External alarm 3 ––> A07852(F) 

 

 

 Note 

An external fault or alarm is triggered by a 1/0 signal.  

An external fault and alarm do not usually mean that an internal drive message has been 
generated. The cause of an external fault and warning should, therefore, be remedied 
outside the drive.  
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3.5.4 Overview of important function diagrams and parameters 

Overview of important function diagrams (see SINAMICS S120/S150 List Manual)  
 
• 1750 Overviews – monitoring functions, faults, alarms 

• 8060 Diagnostics - fault buffer 

• 8065 Diagnostics - alarm buffer 

• 8070 Diagnostics - fault/alarm trigger word (r2129) 

• 8075 Diagnostics - fault/alarm configuration 

• 8134 Diagnostics - measuring sockets 

Overview of important parameters (see SINAMICS S120/S150 List Manual) 
 
• r0944 CO: Counter for fault buffer changes 

• p0952 Fault cases, counter 

• p2100[0...19] Setting the fault number for fault response 

• r2139.0...12 CO/BO: Status word, faults/alarms 1 

• r3120[0...63] Component number fault 

• r3121[0...63] Component number alarm 

• r3122[0...63] Diagnostic attribute fault 

• r3123[0...63] Diagnostic attribute alarm 
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3.5.5 Propagation of faults 

Forwarding faults to the Control Unit  
When faults are triggered on the "Control Unit" drive object, it is always assumed that central 
functions of the drive are affected. For this reason, these faults are also forwarded to all 
other drive objects (propagation). The fault responses act on the Control Unit drive object 
and all other drive objects. This behavior also applies to the faults that are set in a DCC chart 
on the Control Unit with the aid of the DCC block.  

A fault propagated from the Control Unit must be acknowledged at all drive objects to which 
this fault was transferred. In this way, this fault on the Control Unit is automatically 
acknowledged. Alternatively, the faults of the drive objects can also be acknowledged on the 
Control Unit.  

Alarms are not propagated from the Control Unit, i.e. transferred to other drive objects. 

Example 
Drive object faults are only transferred to the drives; i.e. a fault on a TB30 stops the drive. 
However, a drive fault does not stop the TB30. 

Forwarding of faults due to BICO interconnections  
If two or more drive objects are connected via BICO interconnections, faults of drive objects 
of type Control Unit, TB30, DMC20, DME20, all Terminal Modules or ENCODER DO are 
transferred to drive objects with closed-loop control functions, e.g. infeed units or Motor 
Modules. There is no forwarding of faults within these two groups of drive object types. 

This behavior also applies to the faults set in a DCC chart on the above drive object types 
with the aid of DCC STM. 
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3.5.6 Alarm classes 

Fault and alarm classes  
There are differentiated alarm messages in the cyclic telegrams between the former alarm 
classes "Alarm" and "Fault". 

The alarm classes have been extended to give 3 additional levels of alarm between the 
"pure" alarm and the fault. 

The function permits higher-level control (SIMATIC, SIMOTION, SINUMERIK, etc.) to have 
different control reactions to alarm messages from the drive. 

The new statuses act as alarms for the drive, therefore there is NO immediate reaction from 
the drive (like for the former level "alarm"). 

Information on alarm classes are described in status word ZSW2 at bit positions bit 5 - 6 (for 
SINAMICS) or bit 11-12 (SIMODRIVE 611) (see also "ZSW2" in Chapter "Cyclic 
communication" for PROFIdrive communication in the SINAMICS S120 Function Manual 
Drive Functions). 

ZSW2: Valid for SINAMICS Interface Mode p2038=0 (function diagram 2454) 

Bit 5 - 6 Alarm classes alarms 

= 0: Alarm (former alarm level) 

= 1: Alarm class A alarms 

= 2: Alarm class B alarms 

= 3: Alarm class C alarms 

ZSW2: Valid for SIMODRIVE 611 Interface Mode p2038=1 (function diagram 2453) 

Bit 11 - 12 Alarm classes alarms 

= 0: Alarm (former alarm level) 

= 1: Alarm class A alarms 

= 2: Alarm class B alarms 

= 3: Alarm class C alarms 

These attributes for differentiating the alarms are implicitly assigned to the appropriate alarm 
numbers. The reaction to the existing alarm classes in the alarm is defined by the user 
program in the higher-level control. 
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Explanations of the alarm classes 

● Alarm class A: Drive operation currently not limited 

– e.g. alarm when measurement systems inactive 

– no limitation on current movement 

– Prevent possible switching to the defective measuring system 

● Alarm class B: Time-limited operation 

– e.g. prewarning temperature: without further action the drive may need to be switched 
off 

– After a timer stage -> additional fault 

– after exceeding a switch-off threshold -> additional fault 

● Alarm class C: Functionally limited operation 

– e.g. reduced voltage/current/torque/speed limits (i2t) 

– e.g. continue with reduced accuracy / resolution 

– e.g. continue without encoder 
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3.6 Troubleshooting for encoders 
If an encoder fault is present, it can be acknowledged separately according to encoder 
channels in a PROFIdrive telegram via the encoder interface (Gn_STW.15) or the drive 
interface of the appropriate drive object.  

Configuration example: 2-encoder system 
● Encoder G1 motor measurement system 

● Encoder G2 direct measurement system 

Case considered: All encoders signal encoder faults. 

● The errors are entered in the encoder interface - and from there into the encoder channel 
n of the PROFIDRIVE telegram. Bit15 of the encoder status word (Gn_ZSW.15 = 1). 

● The faults are transferred to the drive object. 

● Motor measuring system faults set the drive object to fault (ZSW1 bit3), the faults are 
additionally signaled via the drive interface. An entry is made in fault buffer p0945. The 
parameterized fault reaction is initiated internally. 

● Direct measuring system faults are converted by the assigned drive object into the 
"Alarm" message type and signaled via the drive interface (ZSW1 bit7). An entry is made 
in alarm buffer r2122. 
No drive reactions are initiated. 
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Figure 3-12 Encoder fault handling 

Alarm A:  
The alarm is canceled immediately, if the encoder fault was able to be acknowledged. 
Faults F:  
The fault remains active at the drive object until it is acknowledged via the cyclic interface. 
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Cyclic acknowledgment 

Acknowledgment using the encoder interface (Gn_STW.15)   

The following responses are possible: 

● The encoder is set to fault-free if a fault is no longer active. The fault bit in the encoder 
interface is acknowledged. The evaluation modules indicate RDY LED = green after 
acknowledgment.  
This behavior is valid for all encoders connected to the encoder interface, irrespective of 
the measurement system type (motor or direct). 

● If the fault is still present, or if other faults are present, the acknowledgment is not 
successful – and the highest priority fault (can be the same or another fault entry) is 
transferred via the encoder interface.  
The RDY LED on the evaluation modules is continuously red. 
This behavior is valid for all encoders connected via the encoder interface, irrespective of 
the measuring system type (motor or direct). 

● The drive object is not detected via the encoder interface. Faults set in the drive object 
remain, the drive does not even start with the encoder which in the meantime is fault-free. 
The drive object must also be acknowledged via the drive interface (fault memory 
RESET). 

Acknowledgment using the drive interface (STW1.7 (cyclic) or p3981(acyclic))  

The following responses are possible: 

● If no more errors are present, the encoder is set to fault free and the fault bit in the drive 
interface is acknowledged. The evaluation modules indicate RDY LED = green.  
Acknowledgment takes place on all encoders that are logically assigned to the drive. 

● If the fault is still present, or other faults are present, then the acknowledgment is not 
successful; the next, highest priority fault is transferred via the drive interface and also via 
the encoder interface involved. 

● The RDY LED on the evaluation modules is continuously red. 

● The encoder interfaces of the assigned encoders are NOT reset by acknowledgement at 
the drive interface; the set faults remain. 

● The encoder interfaces must also be acknowledged via the corresponding encoder 
control word Gn_STW.15. 
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Appendix A
A.1 Availability of hardware components 

Table A- 1 Hardware components available as of 03.2006 

No. HW component Order number Version Revisions 
1 AC Drive (CU320, PM340) refer to the Catalog  new 
2 SMC30 6SL3055-0AA00-5CA1  with SSI support 
3 DMC20 6SL3055-0AA00-6AAx  new 
4 TM41 6SL3055-0AA00-3PAx  new 
5 SME120 

SME125 
6SL3055-0AA00-5JAx 
6SL3055-0AA00-5KAx 

 new 

6 BOP20 6SL3055-0AA00-4BAx  new 
7 CUA31 6SL3040-0PA00-0AAx  new 

 

Table A- 2 Hardware components available as of 08.2007 

No. HW component Order number Version Revisions 
1 TM54F 6SL3055-0AA00-3BAx  new 
2 Active Interface Module 

(booksize) 
6SL3100-0BExx-xABx  new 

3 Basic Line Module (booksize) 6SL3130-1TExx-0AAx  new 
4 DRIVE-CLiQ encoder 6FX2001-5xDxx-0AAx  new 
5 CUA31 

Suitable for Safety Extended 
Functions via PROFIsafe and 
TM54 

6SL3040-0PA00-0AA1  new 

6 CUA32 6SL3040-0PA01-0AAx  new 
7 SMC30 (30 mm wide) 6SL3055-0AA00-5CA2  new 
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Table A- 3 Hardware components available as of 10.2008 

No. HW component Order number Version Revisions 
1 TM31 6SL3055-0AA00-3AA1  new 
2 TM41 6SL3055-0AA00-3PA1  new 
3 DME20 6SL3055-0AA00-6ABx  new 
4 SMC20 (30 mm wide) 6SL3055-0AA00-5BA2  new 
5 Active Interface Module 

booksize 16 kW 
6SL3100-0BE21-6ABx  new 

6 Active Interface Module 
booksize 36 kW 

6SL3100-0BE23-6ABx  new 

7 Smart Line Modules booksize 
compact 

6SL3430-6TE21-6AAx  new 

8 Motor Modules booksize 
compact 

6SL3420-1TE13-0AAx 
6SL3420-1TE15-0AAx 
6SL3420-1TE21-0AAx 
6SL3420-1TE21-8AAx 
6SL3420-2TE11-0AAx 
6SL3420-2TE13-0AAx 
6SL3420-2TE15-0AAx 

 new 

9 Power Modules blocksize liquid 
cooled 

6SL3215-1SE23-0AAx 
6SL3215-1SE26-0AAx 
6SL3215-1SE27-5UAx 
6SL3215-1SE31-0UAx 
6SL3215-1SE31-1UAx 
6SL3215-1SE31-8UAx 

 new 

10 Reinforced DC link busbars for 
50 mm components 

6SL3162-2DB00-0AAx  new 

11 Reinforced DC link busbars for 
100 mm components 

6SL3162-2DD00-0AAx  new 

 

Table A- 4 Hardware components available as of 11.2009 

No. HW component Order number Version Revisions 
1 Control Unit 320-2DP 6SL3040-1MA00-0AA1 4.3 new 
2 TM120 6SL3055-0AA00-3KA0 4.3 new 
3 SMC10 (30 mm wide) 6SL3055-0AA00-5AA3 4.3 new 
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Table A- 5 Hardware components available as of 01.2011 

No. HW component Order number Version Revisions 
1 Control Unit 320-2PN 6SL3040-1MA01-0AA1 4.4 new 
2 Braking Module Booksize 

Compact 
6SL3100-1AE23-5AA0 4.4 new 

3 SLM 55kW Booksize 6TE25-5AAx 4.4 new 
4 TM120 evaluation of up to four 

motor temperature sensors 
6SL3055-0AA00-3KAx 4.4 new 

 

Table A- 6 Hardware components available as of 04.2011 

No. HW component Order number Version Revisions 
1 S120 Combi 3 axes 

 Power Module 
6SL3111-3VE21-6FA0 
6SL3111-3VE21-6EA0 
6SL3111-3VE22-0HA0 

4.4 new 

2 S120 Combi 4 axes 
 Power Module 

6SL3111-4VE21-6FA0 
6SL3111-4VE21-6EA0 
6SL3111-4VE22-0HA0 

4.4 new 

3 S120 Combi  
Single Motor Module 

6SL3420-1TE13-0AA0 
6SL3420-1TE15-0AA0 
6SL3420-1TE21-0AA0 
6SL3420-1TE21-8AA0 

4.4 new 

4 S120 Combi  
Double Motor Module 

6SL3420-2TE11-7AA0 
6SL3420-2TE13-0AA0 
6SL3420-2TE15-0AA0 

4.4 new 

5 Braking Module Booksize 6SL3100-1AE31-0AB0 4.4 new 

 

Table A- 7 Hardware components available from 01.2012 

No. HW component Order number Version Revisions 
1 TM150 evaluation of up to 12 

temperature sensors 
6SL3055- 0AA0-3LA0 4.5 new 

2 CU310-2 PN 6SL3040-1LA00-0AA0 4.5 new 
3 CU310-2 DP 6SL3040-1LA01-0AA0 4.5 new 
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Table A- 8 Hardware components available as of the 4th quarter 2012 

No. HW component Order number Version Revisions 
1 Adapter Module 600 6SL3555-2BC10-0AA0 4.5 new 
2 SINAMICS S120M 6SL3532-6DF71-0Rxx 

6SL3540-6DF71-0Rxx 
6SL3542-6DF71-0Rxx 
6SL3562-6DF71-0Rxx 
6SL3563-6DF71-0Rxx 

4.5 new 

 

Table A- 9 Hardware components available as of 01.2013 

No. HW component Order number Version Revisions 
1 300% overload, Booksize up to 

18 A 
6SL312x-xxxxx-xxx4 
for Motor Modules with 50 mm and:  
3 A, 5 A, 9 A, 18 A, 2x3 A, 2x5 A, 
2x9 A 

4.6 new 
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A.2 Availability of SW functions 

Table A- 10 New functions, firmware 4.3 

No. SW function SERVO VECTOR HW component 
1 The 1FN6 motor series is supported x - - 
-2 DRIVE-CLiQ motors with star-delta changeover are supported x - - 
3 Referencing with several zero marks per revolution via the encoder 

interface 
x - - 

4 Permanent-magnet synchronous motors can be controlled down to 
zero speed without having to use an encoder 

- x - 

5 "SINAMICS Link" : Direct communication between several SINAMICS 
S120 

x x - 

6 Safety Integrated: 
• Control of the Basic Functions via PROFIsafe 
• SLS without encoder for induction motors 
• SBR without encoder for induction motors 
• Own threshold value parameters for SBR: 

Up until now, SSM used parameter p9546 

x x - 

7 Drive object encoder: 
An encoder can now be directly read in via the encoder drive object 
and can then be evaluated by SIMOTION using the TO external 
encoder. 

- x - 

8 Support of new components 
• CU320-2 
• TM120 

x x - 

9 GSDML file expanded for Profisafe x x - 
10 USS protocol at interface X140 x x - 
11 U/f diagnostics (p1317) permitted as regular operating mode x - - 
12 Setpoint-based utilization display, instead of the previous actual value-

based utilization display 
x x - 

13 A performance license is now required from the 4th axis (for 
servo/vector) or from the 7th U/f axis, instead of from a utilization of 
50 % and higher - which was the case up until now. 

x x - 

14 Tolerant encoder monitoring, 2nd part: 
• Monitoring, tolerance band, pulse number 
• Switchable edge evaluation for squarewave encoders 
• Setting the zero speed measuring time for pulse encoder signal 

evaluation 
• Changeover measuring technique, actual value sensing for 

squarewave encoder 
• "LED check" encoder monitoring 

x x - 
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Table A- 11 New functions, firmware 4.4 

No. SW function SERVO VECTOR HW component 
1 Safety Integrated functions  

• SDI (Safe Direction) for induction motors (with and without 
encoder), for synchronous motors with encoder 

• Supplementary condition for Safety without encoder (for induction 
motors): Only possible with devices in booksize and blocksize 
format. Not for devices in chassis format 

x x - 

2 Communication 
• PROFINET address can be written via parameter (e.g. when 

completely generating the project offline) 
• Shared device for SINAMICS S PROFINET modules: 

CU320-2 PN, CU310-2 PN 

x x - 

3 Emergency retraction (ESR = Extended Stop and Retract) x x - 
4 TM41: Rounding for pulse encoder emulation (gear ratio; also resolver 

as encoder) 
x x - 

5 Further pulse frequencies for servo control and isochronous operation 
(3.2 / 5.33 / 6.4 kHz) 

x - - 

6 Chassis format: Current controller in 125 µs for servo control for 
higher speeds (up to approx. 700 Hz output frequency) 

x - - 

7 Propagation of faults x x - 

 

Table A- 12 New functions, firmware 4.5 

No. SW function SERVO VECTOR HW component 
1 Support of new components CU310-2 x x Refer to Appendix 

A1 
2 Support of new components, TM150 x x - 
3 Support of new components S120M x - - 
4 Support for high-frequency spindles with pulse frequencies up to 32 

kHz (a current controller cycle of 31.25 µs) 
x - - 

5 PROFINET: Support of the PROFIenergy profile x x - 
6 PROFINET: Improved usability for Shared Device x x - 
7 PROFINET: Smallest selectable send cycle 250 µs x x - 
8 PROFINET: Bumpless media redundancy with CU310-2 PN, 

CU320-2 PN and CU320-2 with CBE20 
x x - 

9 Ethernet/IP communication extension via CBE20 x x - 
10 SINAMICS Link: Smallest adjustable send clock 0.5 ms x x - 
11 Parameterization of SINAMICS Link connections without POWER ON x x - 
12 Write protection x x - 
13 Know-how protection x x - 
14 PEM encoderless up to n = 0 rpm x x - 
15 Decoupling of the pulse frequency from the current controller cycle  

only valid for power units in the chassis format 
- x - 
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No. SW function SERVO VECTOR HW component 
16 Expansion of the number of process data words for infeeds up to 10 

words for the send and receive directions 
x x - 

Safety Integrated functions 
17 CU310-2 safety functionality via terminals and PROFIsafe x x - 
18 Permanent activation of the speed limit and the safe direction of 

rotation without PROFIsafe or TM54F 
x x - 

19 Safely Limited Position (SLP) x x - 
20 Transfer of the safely limited position via PROFIsafe x x - 
21 Variably adjustable SLS limit x x - 
22 New PROFIsafe telegrams 31, 901, 902 x x - 

Table A- 13 New functions, firmware 4.6 

No. SW function SERVO VECTOR HW component 
1 Integrated web server for SINAMICS 

Project and firmware download via Ethernet on the memory card 
Protection against power failure while updating via the Web server 

x x - 

2 Replacing a part with know-how protection Encrypted loading into the 
file system 

x x - 

3 Parameterizable bandstop filters for Active Infeed control, chassis 
format 

x x - 

4 Current setpoint filter x - - 
5 Shortened rotating measurement - x - 
6 Redundant data backup on the memory card x x - 
7 Multiple trace x x - 
8 Brake control adaptation x x - 
9 Fast flying restart - x - 

10 Diagnostic alarms for PROFIBUS x x - 
11 DCC SINAMICS: 

Support of DCB libraries generated from the SINAMICS DCB Studio 
x x - 

12 SMC40 (EnDat 2.2) x x - 
13 CANopen expansions x x - 

Safety Integrated functions 
14 Safety Integrated Extended Functions with 2 TTL/HTL encoders x x - 
15 Safety: Safe Brake Test x x - 
16 Safety Info Channel x x - 
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Alarms, 296 
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DDS 

Drive data set, 294 
Detail view, 60 
Diagnostic buffer, 290 
Diagnostic function, 273 
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Braking Module Booksize, 254 
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Trace function, 277, 281 
Drive interface, 309 
DRIVE-CLiQ 

Check connections, 25 
Diagnostics, 25 
Wiring rules, 25 

DRIVE-CLiQ encoder, 147 

E 
EDS 

Encoder data set, 294 
Encoder 

Configuration, 142 
Linear, 146 
Rotary, 145 
Troubleshooting, 309 
User-defined, 144 

Encoder evaluation, 208 
Encoder interface, 309 
Encoder selection, 140 
Encoder types, 208 
EPOS 

Absolute encoder adjustment, 212 

F 
Fault buffer, 299 
Fault value, 299 
Faults, 296 

Acknowledge, 297 
Configure, 302 
Fault buffer, 299 

Faults and alarms 
Alarm classes, 307 
BICO interconnections, 306 
Forwarding, 306 
Propagation, 306 

First commissioning, 89, 99, 109, 122, 127 
Five safety rules, 9 
Function generator, 275 

Properties, 274 

G 
Generator for signals, 273 

I 
Initialization 

Initializing the interface, 72 

K 
KTY 84, 157 

L 
Learning devices, 138 
LEDs 

Active Line Modules, 249, 257 
Basic Line Modules, 250, 258 
Braking Module Booksize, 254 
Communication Board CBC10, 264 
Communication Board CBE20, 265 
Control Unit CU310-2 DP, 244 
Control Unit CU320-2 DP, 240 
Control Unit CU320-2 PN, 242 
DRIVE-CLiQ Hub Module DMC20, 267 
Motor Module booksize compact, 256 
Motor Modules, 253, 260 
On the Control Supply Module, 262 
On the Sensor Module Cabinet 10, 262 
On the Sensor Module Cabinet 20, 262 
Power Modules, 261 
Sensor Module Cabinet SMC30, 263 
Sensor Module Cabinet SMC40, 264 
Smart Line Module Booksize Compact, 255 
Smart Line Modules, 259 
Smart Line Modules 16 kW and higher, 252 
Smart Line Modules 5 kW and 10 kW, 251 
Terminal Module TM120, 269 
Terminal Module TM15, 268 
Terminal Module TM150, 270 
Terminal Module TM31, 269 
Terminal Module TM41, 270 
Terminal Module TM54F, 271 
Voltage Sensing Module VSM10, 267 

Line protection, 21 
Power unit, 21 

Linear motor, 149, 156, 157 

M 
MDS 

Motor data set, 294 
Measuring sockets, 285 
Messages, 296 

Configure, 302 
External triggering, 304 
Trigger on, 303 
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Motor Modules 
Parallel connection, commissioning, 134 

Motor temperature monitoring 
CU310-2, 216 
CUA31/32, 217 
Faults/alarms, 222 
Motor temperature, 21 
SMC10/20, 215 
SMC30, 215 
SME120/125, 220 
SME20, 220 
TM120, 218 
TM150, 219 
TM31, 218 

N 
Number of controllable drives 

Notes, 35 

O 
Online operation with STARTER, 74 

P 
Parameterizing 

Internal LAN interface, 74 
With STARTER, 59 

Parameterizing the internal LAN interface 
Internal LAN interface, 74 

Parameterizing with BOP, 224 
Position tracking 

2-pole resolver, 212 
Power units 

Parallel connection, commissioning, 135 
PROFIBUS 

Components, 23 
Project navigator, 60 
Propagation, 306 

R 
Ramp-up with partial topology, 42 
Resolver 

2-pole, 212 

S 
Safety instructions 

General safety instructions, 9 
Setting the IP address, 69 
Signal recording with the trace function, 273 
SINAMICS Support Package, 138 
Singleturn absolute encoder, 212 
Sockets for measurement, 285 
SSI encoder, 208 
SSP, 138 
STARTER, 59 

Important functions, 61 
Online operation via PROFINET, 74 

Status display 
Uncommissioned drive objects, 293 

Switching off, 52 
Switching on, 52 
System sampling times 

CU31/CU32, 39 
DCC, 38 
EPOS, 38 
Mixed operation, 37 
Servo control, 35 
U/f control, 37 
Vector control, 36 

T 
T0, T1, T2, 285 
Temperature monitoring 

Temperature monitoring circuit, 21 
Temperature sensors 

SINAMICS components, 213 
Temp-F, 157 
Thermal motor protection 

Safe electrical separation, 160 
SME12x, 157 
TM120, 160 

Time stamp, 292 
Tools 

STARTER, 59 
Trace function 

Call trace function, 277, 280, 281 
Multiple trace, 280 
Operation of the trace function, 278 
Parameter, 282 
Properties of the trace function, 279 
Signal recording, 273 
Single trace, 277 
Startup trace, 281 
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U 
User interface, 60 

W 
Wiring rules 

DRIVE-CLiQ, 25 
Working area, 60 
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